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Caution
NO LIABILITY IS ASSUMED FOR ANY DAMAGE CAUSED BY IMPROPER INSTALLATION.

Notice on Software
SOFTWARE USED WITH THIS PRINTER MUST SUPPORT THE PRINTER'S EMULATION MODE. The printer is factory-set to 
emulate the PCL. The emulation mode can be changed by following the procedures described in Chapter 1.

Notice
The information in this manual is subject to change without notification. Additional pages may be inserted in future editions. The user 
is asked to excuse any technical inaccuracies or typographical errors in the present edition.

No responsibility is assumed if accidents occur while the user is following the instructions in this manual. No responsibility is assumed 
for defects in the printer's firmware (contents of its read-only memory).

This manual, any copyrightable subject matter sold or provided with or in connection with the sale of the page printer, are protected by 
copyright. All rights are reserved. Copying or other reproduction of all or part of this manual, any copyrightable subject matter without 
the prior written consent of Kyocera Corporation is prohibited. Any copies made of all or part of this manual, any copyrightable subject 
must contain the same copyright notice as the material from which the copying is done.

This User's Manual is applicable to the FS-1800/FS-3800 and the FS-1800N/FS-3800N, which is equipped with a network card as 
standard. Explanations are given using the FS-1800/FS-3800 throughout this manual and remarks are given accordingly where details 
are different for the FS-1800N/FS-3800N.

For details concerning the network when using the FS-1800N/FS-3800N, refer to the supplied Network Manual.

Regarding Tradenames
PRESCRIBE is a registered trademark of Kyocera Corporation. KPDL and KIR (Kyocera Image Refinement) are trademarks of Kyo-
cera Corporation.

Diablo 630 is a product of  Xerox Corporation. IBM Proprinter X24E is a product of International Business Machines Corporation. 
Epson LQ-850 is a product of Seiko Epson Corporation.

Hewlett-Packard, PCL, and PJL are registered trademarks of Hewlett-Packard Company. Centronics is a trade name of Centronics 
Data Computer Inc. PostScript is a registered trademark of Adobe Systems Incorporated. Macintosh is a registered trademark of Apple 
computer, Inc. Microsoft, Windows, and Windows NT are registered trademarks of Microsoft Corporation. PowerPC and Microdrive 
are trademarks of International Business Machines Corporation. CompactFlash is a trademark of SanDisk Corporation. ENERGY 
STAR is a U.S. registered mark. All other brand and product names are registered trademarks or trademarks of their respective 
companies.

This Kyocera Mita page printer uses PeerlessPrintXL to provide the HP LaserJet compatible PCL6 language emulation. Peer-
lessPrintXL is a trademark of The Peerless Group, Redondo Beach, CA 90278, U.S.A.

This product was developed using the Tornado™ Real Time Operating System and Tools from Wind River Systems.

 This product contains UFST™ and MicroType® from Agfa Corporation.

Fine 1200 mode uses iRET image enhancement technology.

 iRET is a trademark of Oak Technology, Inc.
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IBM PROGRAM LICENSE AGREEMENT
THE DEVICE YOU HAVE PURCHASED CONTAINS ONE OR MORE SOFTWARE PROGRAMS ("PROGRAMS") WHICH BELONG 
TO INTERNATIONAL BUSINESS MACHINES CORPORATION ("IBM"). THIS DOCUMENT DEFINES THE TERMS AND CON-
DITIONS UNDER WHICH THE SOFTWARE IS BEING LICENSED TO YOU BY IBM. IF YOU DO NOT AGREE WITH THE TERMS 
AND CONDITIONS OF THIS LICENSE, THEN WITHIN 14 DAYS AFTER YOUR ACQUISITION OF THE DEVICE YOU MAY 
RETURN THE DEVICE FOR A FULL REFUND. IF YOU DO NOT SO RETURN THE DEVICE WITHIN THE 14 DAYS, THEN YOU 
WILL BE ASSUMED TO HAVE AGREED TO THESE TERMS AND CONDITIONS.

The Programs are licensed not sold. IBM, or the applicable IBM country organization, grants you a license for the Programs only in the 
country where you acquired the Programs. You obtain no rights other than those granted you under this license.

The term "Programs" means the original and all whole or partial copies of it, including modified copies or portions merged into other 
programs. IBM retains title to the Programs. IBM owns, or has licensed from the owner, copyrights in the Programs.

1. License
Under this license, you may use the Programs only with the device on which they are installed and transfer possession of the Programs 
and the device to another party.

If you transfer the Programs, you must transfer a copy of this license and any other documentation to the other party. Your license is 
then terminated. The other party agrees to these terms and conditions by its first use of the Program.

You may not:

1) use, copy, modify, merge, or transfer copies of the Program except as provided in this license;
2) reverse assemble or reverse compile the Program; or
3) sublicense, rent, lease, or assign the Program.

2. Limited Warranty
The Programs are provided "AS IS."

THERE ARE NO OTHER WARRANTIES COVERING THE PROGRAMS (OR CONDITIONS), EXPRESS OR IMPLIED, INCLUD-
ING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PUR-
POSE.

Some jurisdictions do not allow the exclusion of implied warranties, so the above exclusion may not apply to you.

3. Limitation of Remedies
IBM's entire liability under this license is the following;

1) For any claim (including fundamental breach), in any form, related in any way to this license, IBM's liability will be for actual 
damages only and will be limited to the greater of:

a) the equivalent of U.S.$25,000 in your local currency; or
b) IBM's then generally available license fee for the Program

This limitation will not apply to claims for bodily injury or damages to real or tangible personal property for which IBM is legally liable.

IBM will not be liable for any lost profits, lost savings, or any incidental damages or other economic consequential damages, even if 
IBM, or its authorized supplier, has been advised of the possibility of such damages. IBM will not be liable for any damages claimed by 
you based on any third party claim. This limitation of remedies also applies to any developer of Programs supplied to IBM. IBM's and 
the developer's limitations of remedies are not cumulative. Such developer is an intended beneficiary of this Section. Some jurisdictions 
do not allow these limitations or exclusions, so they may not apply to you.

4. General
You may terminate your license at any time. IBM may terminate your license if you fail to comply with the terms and conditions of this 
license. In either event, you must destroy all your copies of the Program. You are responsible for payment of any taxes, including 
personal property taxes, resulting from this license. Neither party may bring an action, regardless of form, more than two years after 
the cause of action arose. If you acquired the Program in the United States, this license is governed by the laws of the State of New York. 
If you acquired the Program in Canada, this license is governed by the laws of the Province of Ontario. Otherwise, this license is 
governed by the laws of the country in which you acquired the Program.
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Typeface Trademark Acknowledgement
All resident fonts in this printer are licensed from Agfa Corporation.

Helvetica, Palatino and Times are registered trademarks of Linotype-Hell AG.

ITC Avant Garde Gothic, ITC Bookman, ITC ZapfChancery and ITC Zapf Dingbats are registered trademarks of International Type-
face Corporation.

Agfa Japan License Agreement
1. �Software� shall mean the digitally encoded, machine readable, scalable outline data as encoded in a special format as well as the 

UFST Software.
2. You agree to accept a non-exclusive license to use the Software to reproduce and display weights, styles and versions of letters, 

numerals, characters and symbols (�Typefaces�) solely for your own customary business or personal purposes at the address stated 
on the registration card you return to Agfa Japan.  Under the terms of this License Agreement, you have the right to use the Fonts 
on up to three printers.  If you need to have access to the fonts on more than three printers, you need to acquire a multi-user license 
agreement which can be obtained from Agfa Japan.  Agfa Japan retains all rights, title and interest to the Software and Typefaces 
and no rights are granted to you other than a License to use the Software on the terms expressly set forth in this Agreement.

3. To protect proprietary rights of Agfa Japan, you agree to maintain the Software and other proprietary information concerning the 
Typefaces in strict confidence and to establish reasonable procedures regulating access to and use of the Software and Typefaces.

4. You agree not to duplicate or copy the Software or Typefaces, except that you may make one backup copy.  You agree that any such 
copy shall contain the same proprietary notices as those appearing on the original.

5. This License shall continue until the last use of the Software and Typefaces, unless sooner terminated.  This License may be 
terminated by Agfa Japan if you fail to comply with the terms of this License and such failure is not remedied within thirty (30) 
days after notice from Agfa Japan.  When this License expires or is terminated, you shall either return to Agfa Japan or destroy all 
copies of the Software and Typefaces and documentation as requested.

6. You agree that you will not modify, alter, disassemble, decrypt, reverse engineer or decompile the Software.
7. Agfa Japan warrants that for ninety (90) days after delivery, the Software will perform in accordance with Agfa Japan-published 

specifications, and the diskette will be free from defects in material and workmanship.  Agfa Japan does not warrant that the 
Software is free from all bugs, errors and omissions.
THE PARTIES AGREE THAT ALL OTHER WARRANTIES, EXPRESSED OR IMPLIED, INCLUDING WARRANTIES OF FIT-
NESS FOR A PARTICULAR PURPOSE AND MERCHANTABILITY, ARE EXCLUDED.

8. Your exclusive remedy and the sole liability of Agfa Japan in connection with the Software and Typefaces is repair or replacement 
of defective parts, upon their return to Agfa Japan.
IN NO EVENT WILL AGFA JAPAN BE LIABLE FOR LOST PROFITS, LOST DATA, OR ANY OTHER INCIDENTAL OR CON-
SEQUENTIAL DAMAGES, OR ANY DAMAGES CAUSED BY ABUSE OR MISAPPLICATION OF THE SOFTWARE AND TYPE-
FACES.

9. New York, U.S.A. law governs this Agreement.
10. You shall not sublicense, sell, lease, or otherwise transfer the Software and/or Typefaces without the prior written consent of Agfa 

Japan.
11. Use, duplication or disclosure by the Government is subject to restrictions as set forth in the Rights in Technical Data and Computer 

Software clause at FAR 252-227-7013, subdivision (b)(3)(ii) or subparagraph (c)(1)(ii), as appropriate.  Further use, duplication or 
disclosure is subject to restrictions applicable to restricted rights software as set forth in FAR 52.227-19 (c)(2).

12. YOU ACKNOWLEDGE THAT YOU HAVE READ THIS AGREEMENT, UNDERSTAND IT, AND AGREE TO BE BOUND BY ITS 
TERMS AND CONDITIONS.  NEITHER PARTY SHALL BE BOUND BY ANY STATEMENT OR REPRESENTATION NOT 
CONTAINED IN THIS AGREEMENT.  NO CHANGE IN THIS AGREEMENT IS EFFECTIVE UNLESS WRITTEN AND 
SIGNED BY PROPERLY AUTHORIZED REPRESENTATIVES OF EACH PARTY.  BY OPENING THIS DISKETTE PACKAGE, 
YOU AGREE TO ACCEPT THE TERMS AND CONDITIONS OF THIS AGREEMENT.
iii
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Introduction
The Kyocera Mita page printer has many extremely desirable features. It was designed to 
make a contribution to a cleaner environment as well as to represent the latest generation of 
page printer technology.

This section explains the following topics:

� Features
� For More Information...
� Guide to the User's Manual
vii



Features

Ultra long life modules

The drum, developer, and fuser have been designed for ultra long life.

Amorphous silicon drum

The drum has been developed using Kyocera's unique ceramic technology 
using amorphous silicon.

KIR (Kyocera Image Refinement)

This is Kyocera Mita's original smoothing function. It uses software to 
enhance the printer's resolution and produce high-quality printing. The 
default setting is Off.

Superb print quality

Using 1200 dpi resolution in Fast 1200 mode or Fine 1200 mode, the 
printout is close to typeset quality. Also, with Kyocera Image Refinement 
(KIR) technology, high quality printing can be achieved even at 300 dpi and 
600 dpi.

High speed

A4 sizes typically print at the rate of 24 (16 for the FS-1800/FS-1800N) 
pages per minute. (Actual time varies according to page complexity.)

Large paper capacity

Approximately 500 sheets can be loaded into the paper cassette, and about 
100 sheets can be loaded into the MP tray.

Wide variety of print media

As well as standard paper, the printer will print on transparency, labels 
and other types of special purpose media.

Sleep Mode

Conserves energy during the printer's idle periods.

Ecoprint

Extends the toner yield by reducing the amount of toner used on the page.

Standard Bi-directional Parallel Interface

Supports high-speed data exchange with the computer.
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Network Support (Models FS-1800N and FS-3800N)

The N models come standard with a 10/100 Base-TX network interface card 
for connecting to an Ethernet network.

Wide Variety of Available Fonts

The printer comes with 80 PCL/PS compatible fonts and a line printer 
bitmap font installed.

PRESCRIBE Command Language

PRESCRIBE provides features including advanced graphics capabilities 
that allow you to print any conceivable outline shape or solid form. Also 
provided are a variety of special effects, such as patterned fills, gray-scale 
shading, a user-accessible print image model, and multiple page 
orientations and print directions within the same page.

Job Retention

Allows you to save print jobs onto the Microdrive installed in the printer. It 
print them out later at the operator panel. The following four types of job 
retention are available: quick copy, proof and hold, private printing, and 
stored jobs.

Display of printer messages in any of five languages

English, French, German, Italian, or Dutch. As an option it is also possible 
to download the messages in other languages. Please contact your Kyocera 
Mita dealer.

Microdrive (hard disk unit) slot for various functions such as job 
retention, VMB, and more

By saving print jobs onto the Microdrive, they can be printed out at the 
operator panel when desired. The electronic sort function can be used for 
much faster printing.

CompactFlash card slot for option fonts, macros, forms, etc.

Data in the CompactFlash card can be selectively read from the printer's 
operator panel. 

PDF417 Two-dimensional Bar Code

The printer includes a capability that allows the user to implement two-
dimensional stacked bar code symbology PDF417 (Portable Data File 417).

Simple Network Management Protocol (SNMP) Compliance

The printer supports SNMP and can be used as a network printer.
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Kyocera Mita PrintMonitor Utility

Provides network wide management of the printers. Refer to the readme 
file located in the Kyocera Mita Digital Library CD-ROM (supplied with 
the printer) for details.
x



For More Information...

The following symbols are used to attract your attention in this manual. 
The symbols and their meanings are as follows:

Indicates tips or advice useful for operation.

Indicates situations that are potentially hazardous to the human body or 
devices.

Indicates situations that are potentially extremely hazardous to the 
human body or devices.

Indicates operations that can be performed or are effective only when the 
required option unit is installed.

Item Description

Installation Manual 
(paper manual)

Describes procedures from printer setup to 
printing a test page.

User's Manual 
(this manual)

Guides you through topics concerning the 
operations and maintenance of the printer.

Printer Driver Guide Describes how to install and set the printer driver. 
This manual is contained in the CD-ROM supplied 
with the printer.

PRESCRIBE 2e 
Programming Manual

Describes how to use the PRESCRIBE 2e 
commands and their parameters in detail for 
experienced users. This manual is contained in the 
CD-ROM supplied with the printer.

PDF417 Two-Dimensional 
Bar Code Implementation 
Manual

Includes a PDF417 overview and explains 
PRESCRIBE 2e commands for use with 
two-dimensional barcodes. This manual is 
contained in the CD-ROM supplied with the 
printer.

Note

Caution

Warning

Option
xi



Guide to the User's Manual

This User's Manual has the following chapters:

Chapter 1 Operator Panel

This chapter explains the message display, indicators and keys on the 
operator panel, and how to make various settings from the operator panel.

Chapter 2 Maintenance

This chapter explains how to replace the toner container, waste toner 
bottle, and how to care for your printer.

Chapter 3 Troubleshooting

This chapter explains how to handle printer problems that may occur, such 
as paper jams.

Chapter 4 Paper Selection

This chapter explains the types of paper that can be used with the printer.

Appendix A Fonts

This appendix explains about fonts and lists the printer's internal fonts.

Appendix B Expansion Memory

This appendix explains how to expand the printer's memory.

Appendix C Host Computer Interface

This appendix explains the pin assignment and specifications for the 
printer's parallel interface and serial interface.

Appendix D Option Units

This appendix explains how to install each option unit.
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Appendix E Specifications

This appendix lists the printer's specifications.

Glossary

This glossary explains the terminology used in this manual.
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Chapter 1 Using the Operator 
Panel
1

This chapter explains the following topics:

� Understanding the Operator Panel
� Using the Operator Panel
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Understanding the Operator Panel
1.1 Understanding the Operator Panel

The operator panel has a LCD message display, indicators, and eight keys.

Message Display

The message display gives information in the form of short messages. The 
eight messages listed below are displayed during normal warm-up and 
printing.

Other messages that may appear when the printer needs the operator's 
attention are explained in Chapter 4.

Interface Indicator

The interface indicator shows the interface that is currently used. It uses 
the following abbreviations:

PAR Standard bi-directional parallel interface
SER Serial interface (RS-232C)
OPT Option network interface card
--- No interface is active.

Each interface has a timeout time of 30 seconds during which the other 
interface should wait to receive a print job. Even a print job has been 
complete on the interface, you should wait for this period until the other 
interface begins printing the job.

Message Meaning

Self test The printer is self-testing after power-up.

Please wait The printer is warming up and is not ready. When 
the printer is switched on for the first time after the 
toner container is installed, (Adding toner) 
also appears.

Ready The printer is ready to print.

Processing The printer is receiving data, generating graphics, 
reading a CompactFlash card/Microdrive, or 
printing.

Sleeping The printer is in Sleep mode. The printer wakes 
from Sleep mode whenever a key on the operator 
panel is pressed, the cover is opened or closed, or 
data is received. The printer then warms up and 
goes online. The time that the printer takes to enter 
Sleep mode depends on the Sleep Timer setting.

Cancelling data Jobs inside the printer are being canceled. To cancel 
a job, see the table on page 1-5.

Waiting The printer is waiting for the end-of-job command 
before printing the last page. Pressing the GO key 
allows you to obtain the last page immediately.

FormFeed Time Out The printer is printing the last page after a waiting 
period.

INTERFACE

Note
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Understanding the Operator Panel

SIZE
Paper Size Indicator

This indicator indicates the paper size of the current paper cassette. The 
following abbreviations are used to indicate the paper sizes.

* With only the MP tray feeding.

While the printer is Processing data, the SIZE indicator indicates the 
paper size selected by the application software.

Paper Type Indicator

This shows the paper type defined for the current paper casette. Automatic 
cassette switching is available according to the paper type. 

The paper type can be specified at the operator panel. See Customizing 
Paper Type on page 1-107.

The following abbreviations are used to indicate the paper type. 

* With only the MP tray feeding.

Message 
Display

Paper Size Message 
Display

Paper Size

A4 ISO A4 (21  × 29.7 cm) DL ISO DL (11 × 22 cm)*

A5 ISO A5 (14.8  × 21 cm) C5 ISO C5 (16.2 × 22.9 cm)*

A6 ISO A6 (10.5  × 14.8 
cm)*

b5 ISO B5 (17.6 × 25 cm)*

B5 JIS B5 (18.2  × 25.6 cm) EX Executive (7-1/4 × 10-1/2 inches)*

B6 JIS B6 (12.8  × 18.2 cm)* #6 Commercial 6-3/4 
(3-5/8 × 6-1/2 inches)*

LT Letter (8-1/2 × 11 inches) #9 Commercial 9 (3-7/8 × 8-7/8 inches)*

LG Legal (8-1/2 × 14 inches) HA Japanese Postcard (10 × 14.8 cm)*

MO Monarch 
(3-7/8 × 7-1/2 inches)*

OH Return Postcard (20 × 14.8 cm)*

BU Business (4-1/8 inches)* CU Custom Size 
(14.8 × 21 cm to 21.6 × 35.6 cm)

Note

Message Display Paper Type Message Display Paper Type

None Auto ROUGH Rough

PLAIN Plain LETTERHEA Letterhead

TRNSPRNCY Transparency* COLOR Color

PREPRINTE Preprinted PREPUNCH Prepunched

LABELS Labels* ENVELOPE Envelope*

BOND Bond CARDSTOCK Cardstock*

RECYCLED Recycled CUSTOM1 (to 8) Custom 1 (to 8)

VELLUM Vellum*

TYPE
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Understanding the Operator Panel
Other Indicators

The following indicators light during 
normal operation and when the 
printer needs attention.

Indicator Description

Flashing: Indicates when an error occurs that you can clear 
by yourself.
Lit: Indicates that the printer is on-line. 
The printer prints received data.
Off: Indicates that the printer is off-line. Data can be received 
but will not be printed. Also indicates when printing is 
automatically stopped due to occurrence of an error.

Flashing: Indicates data transfer is taking place.
Lit: Indicates either that data is being processed, or that data 
is being written to the memory card.

Flashing: Indicates when the printer needs maintenance 
attention or the printer is warming up (Please wait). 
Lit: Indicates when a problem or an error occurs that you can 
clear by yourself. 
(For example, paper jam occurs.)

READY

ATTENTION
INTERFACE SIZE TYPE

DATA

READY

DATA

ATTENTION
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Understanding the Operator Panel
Keys

The operator panel keys are used to 
configure the printer. Note the 
certain keys have the secondary 
function.

Settings made with these keys effect only the interface currently in use.

GO

CANCEL MENU ENTER

?

Note

Key Function

� Switches the printer on-line and off-line.
� Prints and feed out one page.

� Cancels a printing job. 
To cancel, proceed as follows:
1 Check if Processing is displayed in the message display.
2 Press the CANCEL key.
3 Print Cancel? appears in the message display and then interface to be canceled.
Parallel
Serial
Option (appears only when an option network interface card is installed)
Press the CANCEL key again if you wish to stop the cancellation of printing.

4 Select the interface to cancel using the  or  key and then press the ENTER key.  
Printing from the selected interface will stop. Cancelling data appears in the message 
display and printing stops after the current page is printed.

� Resets numeric values, or cancels a setting procedure.
� Used to stop the sounding of the alarm buzzer an error occurs.

� When pressed during mode selection, terminates the setting and the printer returns to the 
Ready condition.

� Used to select the emulation, font, character code set; to read an CompactFlash card, and 
more.

Used to access a desired item or enter numeric values. In some of the control procedures, the < 
and > keys are used to enter or exit a sub item.

Used to access a desired item or enter of numeric values. In some of the control procedures, the 
< and > keys are used to enter or exit a sub item.

Used as the < key in the mode selection function.

� Used as the > key in the mode selection function.
� Displays online help messages on the message display when paper jam errors occur. When 

pressed in the Ready condition, displays explanations of online help messages. When pressed 
while the online help is displayed, cancels the online help.

Finalizes numeric values and other selections.

GO

CANCEL

MENU

?

ENTER
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Using the Operator Panel
1.2 Using the Operator Panel

This section explains how to use the menu selection system. The MENU key 
on the operator panel allows you to use the menu to set or change the 
printer environment such as the number of copies to make, emulation, etc., 
to your specific needs. Settings can be made when Ready is indicated on 
the printer message display.

The printer obeys the most recently received printer settings sent from 
the application software, or from the printer driver, which take priority 
over operator panel settings.

1.2.1 Menu Selection System 

The following is the hierarchy diagram of the menu selection system of the 
printer. 

The vertical transition is made with the  and  keys and horizontal 
transition is made with the > and < keys. To change or finalize 
configuration on an item, use the ENTER key. 

Note

Ready
PAR A4 PLAIN

These items will not appear unless the printer 
is installed with the applicable option unit.

 Print
 Status Page

 >List of VMB

 
 >Quick Copy

 
  >Private/Stored 

 
  >Print VMB Data

 Print
 Menu Map

 >List of
 Code JOB
 >e-MPS         >
 Configuration

 >>Quick Copy

 >>Temp.Code JOB
 Size
 >>Perm.Code JOB
 Size
 >>VMB Size

 

Continued on next page

 e-MPS          >

MENU
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Using the Operator Panel
 

Continued on next page

 

Continued from previous page

 

 

 >NetWare       >
  On

 >Parallel I/F
 High Speed

 >Parallel I/F
 Normal

 >Parallel I/F
 Auto Interface      >

 Option

 Interface      >
 Serial

 >Parallel I/F
 Nibble (high)

 Interface      >
 Parallel

 >Data Bits
  8

 >Stop Bits
  1

 >Protocol
  DTR (pos.)&XON

 >NetWare
  Off

 >NetWare       >
  On

 >TCP/IP
  Off

 >Ether Talk
  Off

  >OPT. StatusPage
  Off

  >>NetWare Frame
  Auto

  >>DHCP
  OFF

 >>IP Address

 >>Subnet Mask

 >>Gateway

 >Parity
  None

 >Baud Rate
  9600

 Emulation
 Line Printer

 >Print KPDL errs
 On

 >Print KPDL errs
 On

 Emulation      >
 PCL 6

 >Print KPDL errs
 Off

 Emulation      >
 KPDL

 Emulation      >
 KPDL (AUTO)

 >Print KPDL errs
 Off

 Emulation      >
 DIABLO 630

 Emulation      >
 EPSON LQ-850

 >Code Set
 LQ US

 Emulation      >
 IBM Proprinter

 >Code Set
 DIABLO US

 >Code Set
 IBM US

 >Alt. Emulation
 PCL 6

 >Code set
 ISO-6 ASCII

 >Barcode Mode
  Off
1-7



Using the Operator Panel
 

Continued on next page

 

Continued from previous page

 >LF Action
  Ignore LF

 >LF Action
  CR and LF

 >Page Protect
  On

 >Orientation
 Landscape

 >Courier
 Regular

 Font           >
 Option

 Font           >
 Internal

 > I000

 >Courier
 Dark

 >Letter Gothic
 Dark

 >Letter Gothic
 Regular

 >Size
 012.00 point(s)
 >Pitch
       10.00 cpi
 >List of Fonts

 Page Set       >  >Copies
            001
 >Orientation
 Portrait

 >Page Protect
  Auto

 >LF Action
  LF only

 >CR Action
  Ignore CR

 >CR Action
  CR and LF

 >CR Action
  CR only

 >Wide A4
  On

 >Wide A4
  Off
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Continued on next page

 

Continued from previous page

Hard Disk      > >Read Data
>Write Data
>Delete Data
>List of 
 Partition

 RAM Disk Mode
 On

 RAM Disk Mode
 Off  >RAM Disk Size

 >Read Data
 >Write Data
 >Delete Data
 >List of 
 Partition

 >Read Fonts Memory Card    >
 >Read Data >Write Data

 >Delete Data
 >Format
 >List of 
 Partition

 >Resolution
  600 dpi

 >Resolution
  300 dpi

 Print Quality  >
 >KIR mode
  Off

 >KIR Mode
  On

 >Ecoprint Mode
  On

 >Ecoprint Mode
  Off

 >Resolution
  Fine 1200 mode

 >Resolution
  Fast 1200 mode

 >Print Density
  03
 >Read Data Opt. ROM       >
 >List of 
 Partitions
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 >>Duplex path
  Disable

 >>Paper weight
  Light (Thin)

 

Continued on next page

 

Continued from Previous page

 >MP Tray Mode
  First

 Paper Handling >

 >MP Tray Size
  A4 or Letter

 >MP Tray Type
  Plain

 
  >EF Size
  DL or Business

 
  >EF Type
  Envelope

 
  >BulkFeeder Size

 
  >BulkFeeder Type
  Plain

 >Cassette Size >
 >>Unit
  inch

 >>Unit
  mm

 >>X Dimension

 >>Y Dimension

 >Cassette Type
  Plain

 
  >Duplex Mode
  None

 >Override A4/LT
  On

 >Override A4/LT
  Off

 >Type Adjust   >
  Custom 1  >>Paper weight

  Heavy (Thick)

 >>Paper weight
  Normal

 >>Duplex Path
  Enable

 >Reset Type
Adjust

 >Feed Select
  Cassette

 
  >Opt.StackerMode
  Sorter

 Life Counters  >  >Total Print

 >New Toner
 Installed

 >Stack Select
  Face-down tray
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Continued from previous page

 >Resource prot.
  Perm / Temp

 Others         >

 >Form Feed
Time Out 030sec. 
 >Sleep timer   >
        015 min.
 >Print HEX-DUMP

 >Printer Reset

 >Resource prot.
  Permanent

 >Resource prot.
  Off

 >Buzzer
  Off

 >Buzzer
  On

 >Service       >  >>Print
 Status Page

 >Auto Continue
 Mode Off

 >Auto Continue
 Mode On

 >>Auto Continue
 Timer 000sec.

 >>Sleep Mode
  Off

 >>Sleep Mode
  On

 >>Toner ID

 >>Developer

 >>Drum

 >MSG language
  English
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1.2.2 Using the Menu Selection System

This section explains the procedure for using the menu selection system. 
The menu selection system is activated by the MENU key while the printer 
is Ready.

Printing the Menu Map

The printer prints a full list of menu selection system. Note that menus 
indicated on the list may vary depending on which option units are 
installed on the printer.

1 Press the MENU key.

2 Press the  or  key repeatedly until Print Menu Map appears. 

3 Press the ENTER key. A question mark (?) appears.

If you want to abandon the printing of the menu map, press the 
CANCEL key.

4 Press the ENTER key again. The printer prints a menu map.

Print
 Menu Map

MENU

Print
 Menu Map

ENTER Print
 Menu Map ?

ENTER
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MENU MAP
FS-1800  Page Printer

Sample MENU MAP
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Printing Status Page

If you want to check the printer's current status, including memory 
available and option settings, you can find the information you need on the 
status page.

1 Press the MENU key.

2 Press the  or  key repeatedly until Print Status Page 
appears.

3 Press the ENTER key. A question mark (?) appears.

If you want to abandon the printing of a status page, press the 
CANCEL key.

4 Press the ENTER key again. The printer prints a status page.

For a full description of the status page, see the following pages.

Print
 Status Page

MENU

Print
 Status Page

ENTER Print
 Status Page ?

ENTER
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The following is a sample status page. The numbers below refer to the 
contents explained on the following pages.

Items and values on the status page may vary depending on the printer's 
firmware version.

 KIR  Test pattern  ON

Memory

Installed Options 

Network Status Emulation

Toner Gauge

0 100 

Interfaces

Hardware Information 

Page Information

Error Log

STATUS PAGE
 FS-1800  Page Printer

Firmware Version:                                    Released:     1

4

3

5

7

2

6

8

9

10

11

Note
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1 � Software Version

This information shows the firmware version and date of issue of the 
printer.

2 � Hardware Information

This information shows various printer settings, such as the size and type 
of the paper in the paper cassettes.

3 � Memory

This shows the amount of total memory installed in the printer, the 
amount of currently available memory, and the current status of the RAM 
disk. See Setting the RAM Disk on page 1-86.

4 � Page Information

This shows the print resolution, number of copies, and the total page count.

5 � Installation Options

This shows the option(s) installed in the printer.

6 � Network Status

This shows the IP address, Subnet Mask address, and Default Gateway 
address for the network interface card installed in the printer.

7 � Emulation

This shows all available emulations of the printer. The printer is shipped 
from the factory with PCL 6 emulation selected as the default.

8 � Error Log

This shows the last three instances of the following four types of errors, 
listing them in the order of their occurrence: KPDL Error Press GO; 
Memory overflow Press GO; Print overrun Press GO; File not 
found Press GO. The most recent error is displayed on the top line of the 
Error Log. For error remedies, see section 3.3.3 Error Messages on page 
3-10. Error information is cleared when the printer's power is turned off.

9 � Toner Gauge

This shows the approximate level of remaining toner. When the value is 
100, the toner container is full.
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10 � Interface Information

This information shows the default font and the default emulation for all 
interfaces installed in the printer.

11 � KIR Test Pattern

KIR is the Kyocera Mita's original smoothing function. This test pattern 
shows the effect of the KIR (Kyocera Image Refinement) system.
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e-MPS Printing

To use the e-MPS system, an option Microdrive must be installed in the 
printer.

What is e-MPS?

�e-MPS� is an abbreviation for �enhanced-Multiple Printing System,� which 
is a post-processing function that combines electronic sorting, job 
retention, virtual mailboxing, and a barcode printing system for job 
retrieval.

When printing multiple copies of a document, the data is transferred from 
the computer to the printer only for the first copy; the data is then stored 
on the printerís hard disk. Copies of the document are printed using the 
stored data.

Printing is performed faster with less computer spooling time and less 
network traffic. 

Furthermore, printed data that is stored on the Microdrive can be called up 
using job retention functions, such as Quick Copy etc., allowing you to 
quickly print additional copies of a document from the printer at any time, 
without needing to re-spool the document or start up the computer system.

Job Retention

Job Retention is part of the e-MPS system, allowing you to save print jobs 
to the option Microdrive and retrieve them out as desired in one of four 
different modes.

When printing, select a Job Retention mode using the printer driver. The 
following four modes are available:

� Quick Copy

� Proof and Hold

� Private Print

� Job Storage 

For details, refer to the Printer Driver Guide.

Option

e-MPS          >
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Four Job Retention modes have the following benefits:

� Quick Copy: When you need another copy of a finished print job, 
you can print it out at the printer operator panel. There is no need 
to print from the computer again.

� Proof and Hold: When printing multiple copies, this mode first 
prints only one copy for proofing, allowing you to decide whether to 
continue printing the remaining copies or cancel printing at the 
operator panel. In this way, you can reduce the waste of paper.

� Private Print: Confidential print jobs can be printed out when 
you are at the printer. This mode saves print jobs in the printer 
without printing until you instruct the printer to do so at the 
operator panel. Printing using this mode requires the 4-digit PIN 
number you set using the printer driver.

� Stored Job: This mode allows you to store print jobs that are 
frequently needed, such as fax cover pages, checklists, and order 
forms, for printing later. Using the operator panel, you can then 
print them out as required at anytime and at any number of copies.
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Virtual Mail Box

Virtual mailbox is the ability to store print jobs in the virtual mailboxes on 
the Microdrive, enabling you to retrieve and print it later from the printer's 
operator panel or the option barcode reader (BC-1).

You can later print out only the jobs you desire using the operator panel on 
the printer.

Code Job

This function allows you to print jobs stored on the Microdrive using the 
option barcode reader.

When printing, select a type of code job at the printer driver. The following 
two types of code jobs are available:

� Permanent Code Job

� Temporary Code Job

For details, refer to the Printer Driver Guide.

You can print out frequently needed print jobs, such as fax cover pages, 
checklists, and order forms, using the option barcode reader.

If you store a print job and print it out with a barcode ID attached, you can 
print that job any time later by simply reading the barcode ID. You can 
print a list of code jobs at the operator panel. When the storage memory 
becomes insufficient, temporary code jobs will be automatically deleted in 
order from the oldest. Permanent code jobs will not be deleted.
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Quick Copy

This mode enables you to print additional copies of a finished print job.

If you print a Quick Copy using the printer driver, it is printed and stored 
on the Microdrive. If additional copies are required, you can reprint the 
required number of copies from the printer operator panel.

The default number of print jobs that can be stored on the Microdrive is 32. 
This can be changed to up to 50 from the e-MPS Configuration menu. 
When the number of jobs reaches the limit, the oldest job will be 
overwritten by the new one. When the printer is turned off, all the stored 
jobs will be deleted.

Printing Additional Copies by Quick Copy

When printing, make the Quick Copy settings using the printer driver. For 
how to make the settings, refer to the Printer Driver Guide.

1 Press the MENU key.

2 Press the  or  key repeatedly until e-MPS > appears.

3 Press the > key. 

4 Press the  or  key repeatedly until >Quick Copy appears.
The name entered for User Name in the printer driver (user name, 
in this example) also appears.

>Quick Copy

MENU

e-MPS          >

?

>Quick Copy
 user name
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5 Press the ENTER key. A blinking question mark (?) appears before a 
user name.

6 Press the  or  key to display the desired user name.

7 Press the ENTER key. user name and the name entered for Custom 
Job Name in the printer driver (job title, in this example) appear 
with a question mark (?) shown blinking before that name.

8 Press the  or  key to display the desired job title.

If you want to cancel the selection, press the CANCEL key.

9 Press the ENTER key. The number of copies to be printed can be set. 
To increase the copycount, press the  key; to decrease the copy 
count, press the  key, as many times as desired.

If you want to abandon the selection, press the CANCEL key.

10 Press the ENTER key. The printer prints the specified number of 
copies for the print job.

ENTER

>Quick Copy
?user name

>Quick Copy
?user name

ENTER

>user name
?job title

ENTER

>job title
?copy       001

ENTER
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Deleting a Quick Copy Job

1 Follow the same steps as step1 through 8 in the above section.

2 With the title of the job to be deleted displayed, press the ENTER 
key. The cursor below the copy count starts to blink.

3 Press the  key repeatedly until Delete appears for the number of 
copies.

4 Press the ENTER key. The message display displays Processing 
and the print job is deleted.

ENTER

>job title
?copy       001

>job title
 Delete        

ENTER
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Proof and Hold

When printing multiple copies, this mode first prints one copy so that you 
can check it before continuing to print the remaining copies. Since you can 
check the printouts before printing the remaining copies, the waste of 
paper can be reduced.

Make the Proof and Hold settings using the printer driver and print. The 
printer prints one copy and, at the same time, saves the print job to the 
Microdrive. Use the operator panel to print the remaining copies.

You can also change the number of copies when resuming printing using 
the operator panel.

Printing Remaining Copies of a Proof and Hold

Use the same procedure as that for Quick Copy. See Quick Copy on page 
1-21.
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Printing a Private Job or Stored Job

To use this mode, an option Microdrive must be installed in the printer.

The printer holds the job mode secures confidentiality of the print job.

Private or Stored Job mode. The printer holds the jobs in Microdrive until 
you release it using the printer's operator panel. You can specify the 
document and the number of copies to print from the printer operator 
panel.

You need to enter the user ID from the printer operator panel to actually 
print a private or stored job.

When the printer is turned off, all the print jobs will be deleted but the 
stored jobs remain.

Printing a Private Job or Stored Job

1 Press the MENU key.

2 Press the  or  key repeatedly until e-MPS > appears. 

3 Press the > key. 

4 Press the  or  key repeatedly until >Private/Stored appears. 
The name entered for User Name in the printer driver (user name, 
in this example) also appears.

5 Press the ENTER key. A blinking question mark (?) before a user 
name appears.

Option

>Private/stored

MENU

e-MPS          >

?

>Private/Stored
 user name

ENTER

>Private/Stored
?user name1
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6 Press the  or  key to display the desired user name.

7 Press the ENTER key. user name and the name entered for Custom 
Job Name in the printer driver (job title, in this example) appear 
with a question mark (?) shown blinking before that name.

8 Pressing the  or  key to display the desired job title. 

If you want to abandon the selection, press the CANCEL key.

9 Press the ENTER key. If a user ID number was entered using the 
printer driver, the ID entry display appears. Enter the four-digit user 
ID entered in the printer driver and press the ENTER key.

To enter the ID, press the < or > key to move the cursor to the 
number to be changed and then enter the correct number by pressing 
the  or  key.

10 The number of copies to be printed can be set. To increase the copy 
count, press the  key; to decrease the copy count, press the  key 
as many times as desired. 

If you want to abandon the selection, press the CANCEL key.

11 Press the ENTER key. The message display indicates Processing, 
then Ready. The specified number of copies for the job is printed.

>Private/Stored
?user name

ENTER

>user name
?job title

ENTER

>job title
 ID         0000

>job title
?Copies     001

ENTER
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Deleting a Private Job or Stored Job

1 Follow the same steps as step1 through 8 in the above section.

2 With the title of the job to be printed displayed, press the ENTER 
key. If a user ID has been registered using the printer driver, enter 
the ID and press the ENTER key.

3 Press the  key repeatedly until Delete appears for the number of 
copies. 

4 Press the ENTER key. Processing appears and the print job is 
deleted.

ENTER

>job title
?Copies     001

>job title
 Delete        

ENTER
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Printing a List of Code Jobs (Permanent Jobs)

Barcode IDs of code job (permanent code job) that are stored on the 
Microdrive can be printed on the list of code jobs.

Since the Code Job function administers the print jobs by their barcode 
IDs, you can print the job you desire by reading its barcode ID with the 
option barcode reader.

1 Press the MENU key.

2 Press the  or  key repeatedly until e-MPS > appears. 

3 Press the > key. 

4 Press the  or  key repeatedly until >List of Code JOB 
appears.

5 Press the ENTER key. A question mark (?) appears.

If you want to abandon printing procedure, press the CANCEL key.

6 Press the ENTER key again. Processing appears. The printer 
prints a list of Code JOB.

MENU

e-MPS          >

?

>List of 
 Code JOB

ENTER >List of 
 Code JOB ?

ENTER
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Virtual Mail Box (VMB)

To use this mode, an option Microdrive must be installed in the printer.

The virtual mail box function can be used when Microdrive unit is installed 
on the printer. With a virtual mail box, data sent from the computer is 
stored in the Microdrive.

Up to 255 virtual mail boxes can be used. There is no limit as to the 
number of pages that can be sent to each tray, however, the total memory 
size for the mailboxes is limited to the size of the remaining memory space 
on the Microdrive. 

Once printed, the jobs stored in the mail box will be deleted and not stored 
any more. If there are more than one job stored in the mail box, the all jobs 
are deleted together when the last one is printed.

Printing to a VMB

Select a virtual mail box to post the job from the printer driver. It is 
possible to assign a name to a virtual mail box and post the jos to that 
name. (For how to make the settings, see 3.4.2 Virtual Mail Box 
Printing in Printer Driver Guide.)

Option

Print VMB Data >
Tray###:%%%%%%%%
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Printing the Job Stored in the Mail Box

1 Press the MENU key.

2 Press the  or  key repeatedly until e-MPS > appears.

3 Press the > key. 

4 Press the  or  key repeatedly until >Print VMB Data appears. 
The VMB number will appear in the location marked by #'s below, 
while the VMB name will appear in the location marked by %'s.

5 Press the ENTER key. A blinking question mark (?) appears before 
the VMB name.

6 Press the ENTER key. The printer prints the job stored in the virtual 
mail box. Once printed, the job in the virtual mail box is 
automatically deleted.

MENU

e-MPS          >

?

>Print VMB Data
Tray###:%%%%%%%%

ENTER

>Print VMB Data
Tray###?%%%%%%%%
1-30



Using the Operator Panel
Printing a List of VMB

This feature prints a list of jobs posted in all the virtual mail boxes.

1 Press the MENU key.

2 Press the  or  key repeatedly until e-MPS > appears.

3 Press the > key. 

4 Press the  or  key repeatedly until >List of VMB appears. 

5 Press the ENTER key. A question mark (?) appears.

If you want to abandon printing procedure, press the CANCEL key.

6 Press the ENTER key again. The printer prints a list of VMB data.

MENU

e-MPS          >

?

>List of VMB

ENTER >List of VMB ?

ENTER
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e-MPS Configuration

You can change the maximum number of jobs and the area in the 
Microdrive to hold them for the e-MPS system. You can change:

� Maximum Number of Quick Copy Jobs

� Maximum Area in Microdrive to hold Temporary Code Jobs

� Maximum Area in Microdrive to hold Permanent Code Jobs

� Maximum Area in Microdrive to hold Virtual Mail Boxes (VMB)

Number of Changing the Maximum Quick Copy Jobs

1 Press the MENU key.

2 Press the  or  key repeatedly until e-MPS > appears.

3 Press the > key. 

4 Press the  or  key repeatedly until >e-MPS Configuration > 
appears.

5 Press the > key. 

6 Press the  or  key repeatedly until >>Quick Copy appears.

Option

MENU

e-MPS          >

?

>e-MPS         >
 Configuration

?

>>Quick Copy
              32
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7 Press the ENTER key. A blinking cursor (   ) appears.

8 Press the  or  key to increace or decrease the value of the figure 
where the cursor is blinking. It can be set between 0 and 50. You can 
use the > and < keys to move the cursor right and left. 

If you want to abandon the setting procedure, press the CANCEL 
key.

9 Display the desired maximum number of jobs and press the ENTER 
key.

10 Press the MENU key. The message display returns to Ready.

ENTER >>Quick Copy
              32

ENTER

MENU
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Changing the Maximum Area in Microdrive for Temporary Code 
Jobs

1 Press the MENU key.

2 Press the  or  key repeatedly until e-MPS > appears.

3 Press the > key. 

4 Press the  or  key repeatedly until >e-MPS Configuration > 
appears.

5 Press the > key. 

6 Press the  or  key repeatedly until >>Temp. Code JOB Size 
appears. The default setting is 50 MB.

7 Press the ENTER key. A blinking cursor (   ) appears.

MENU

e-MPS          >

?

>e-MPS         >
 Configuration

?

>>Temp. Code JOB
 Size       50MB

ENTER >>Temp. Code JOB
 Size       50MB
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8 Press the  or  key to increace or decrease the value of the figure 
where the cursor is blinking. It can be set between 0 and 9999 (the 
actual maximum effective size is the size of free hard disk space). 
You can use the > and < keys to move the cursor right and left.
 
If you want to abandon the setting procedure, press the CANCEL 
key.

The area specified here is the maximum storage area that can be used by 
Temporary Code Jobs. Note that the total amount of storage areas 
specified must not exceed the total size of the Microdrive. Otherwise, in 
the particular storage area, you may only be able to accommodate print 
jobs of a smaller amount of print jobs than specified.

9 Display the desired area size and press the ENTER key.

10 Press the MENU key. The message display returns to Ready.

Note

ENTER

MENU
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Changing the Maximum Area in Microdrive to Hold Permanent 
Code Jobs

1 Press the MENU key.

2 Press the  or  key repeatedly until e-MPS > appears.

3 Press the > key. 

4 Press the  or  key repeatedly until >e-MPS Configuration > 
appears.

5 Press the > key. 

6 Press the  or  key repeatedly until >>Perm. Code JOB Size 
appears. The default setting is 50 MB.

7 Press the ENTER key. A blinking cursor (   ) appears.

MENU

e-MPS          >

?

>e-MPS         >
 Configuration

?

>>Perm. Code JOB 
 Size       50MB

ENTER >>Perm. Code JOB 
 Size       50MB
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8 Press the  or  key to increace or decrease the value of the figure 
where the cursor is blinking. It can be set between 0 and 9999 (the 
actual maximum effective size is the size of free hard disk space) MB. 
You can use the > and < keys to move the cursor right and left. 

If you want to abandon the setting procedure, press the CANCEL 
key.

The area specified here is the maximum storage area that can be used by 
Permanent Code Jobs. Note that the total amount of storage areas 
specified must not exceed the total size of the Microdrive. Otherwise, in 
the particular storage area, you may only be able to accommodate print 
jobs of a smaller amount of print jobs than specified.

9 Display the desired area size and press the ENTER key.

10 Press the MENU key. The message display returns to Ready.

Note

ENTER

MENU
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Changing the Maximum Area in Microdrive to Hold Virtual Mail 
Box (VMB)

1 Press the MENU key.

2 Press the  or  key repeatedly until e-MPS > appears.

3 Press the > key. 

4 Press the  or  key repeatedly until >e-MPS Configuration > 
appears.

5 Press the > key. 

6 Press the  or  key repeatedly until >>VMB Size appears.

7 Press the ENTER key. A blinking cursor (   ) appears.

MENU

e-MPS          >

?

>e-MPS         >
 Configuration

?

>>VMB Size 
          ####MB

ENTER >>VMB Size 
          ####MB
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8 Press the  or  key to increace or decrease the value of the figure 
where the cursor is blinking. It can be set between 0 and 9999 (the 
actual maximum effective size is the size of free hard disk space). 
You can use the  and  keys to move the cursor right and left. 

If you want to abandon the setting procedure, press the CANCEL 
key.

The area specified here is the maximum storage area that can be used by 
Virtual Mail Boxes. Note that the total amount of storage areas specified 
must not exceed the total size of the Microdrive. Otherwise, in the 
particular storage area, you may only be able to accommodate print jobs 
of a smaller amount of print jobs than specified.

9 Display the desired area size and press the ENTER key.

10 Press the MENU key. The message display returns to Ready.

Note

ENTER

MENU
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Changing the Interface Parameters

The printer is equipped with both a parallel and serial interface. In 
addition, the N version model has an Ethernet network interface. Various 
printing environment parameters such as the default emulation can be 
changed indepently on different interfaces by using the printer's menu 
selection system. Before select the interface to apply the changes in the 
procedure described below.

This interface selection described below does not select which interface 
data will be received from. The printer automatically selects an interface 
data is received.

Changing Parallel Interface Modes

The parallel interface mode of this printer supports a bi-directional/high-
speed mode. Normally, this interface is used under the default setting 
Nibble (high). For details, see Appendix C. After setting the interface, 
be sure to reset the printer or turn the power off at least once. The new 
setting will be enabled thereafter.

1 Press the MENU key.

2 Press the  or  key repeatedly until Interface > appears. One 
of the interface names shown below appears, indicating the current 
interface.

Parallel (default)
Serial
Option (with the FS-1800N/FS-3800N or when a network interface 
card is installed)

3 Press the ENTER key. A blinking question mark (?) appears.

If Parallel is not displayed, press the  or  key repeatedly until 
it is Parallel. 

If you want to abandon the interface selection procedure, press the 
CANCEL key. The interface remains unchanged.

4 Press the ENTER key again.

Interface      >
  Parallel

Note

MENU

ENTER Interface
? Parallel

ENTER
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5 Press the > key. The message display changes to the communication 
mode menu.

6 Press the ENTER key. A blinking question mark (?) appears.

7 Press the  or  key to display the desired mode. The display 
changes as shown below. Press the ENTER key.

Nibble (high) (default)
AUTO
Normal
High Speed

8 Press the MENU key. The message display returns to Ready.

?

ENTER >Parallel I/F
? Nibble (high)

MENU
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Changing Serial Interface Modes

You can set the baud rate, data bits, stop bits, parity, and protocol for the 
serial interface.

1 Press the MENU key.

2 Press the  or  key repeatedly until Interface > appears. One 
of the interface names shown below appears, indicating the current 
interface.

Parallel (default)
Serial
Option (with the FS-1800N/FS-3800N or when a network interface 
card is installed)

3 Press the ENTER key. A blinking question mark (?) appears.

If you want to abandon the interface selection procedure, press the 
CANCEL key. The interface remains unchanged.

4 Press the  or  key repeatedly until Serial appears.

5 Press the ENTER key again.

MENU

ENTER Interface
? Parallel

Interface
? Serial

ENTER
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6 Press the > key. Each time the  or  key is pressed, the setting 
item and current setting change as shown below.

7 Display the setting item to be changed and press the ENTER key. A 
question mark (?) appears. 
The following example explains how to change the baud rate. The 
settings for other items can be changed in a similar manner.

? >Baud Rate
   9600

>Data Bits
 8

>Stop Bits
 1

>Parity
 None

Definable baud rates: 1200, 2400, 
4800, 9600 (default), 19200, 38400, 
57600, 115200

Definable data bits: 7, 8 (default)

Definable stop bits: 1 (default), 2

Definable parity: None (default), Odd, 
Even, Ignore

>Protocol
 DTR(pos.)&XON

Definable protocol: DTR(pos.)&XON 
(default), DTP(positive), DTR 
(negative), XON/XOFF, ETX/ACK

>Barcode Mode
  Off

If set to On when the option barcode 
reader is installed, the mode of the 
serial interface will be the barcode 
mode.

ENTER

>Baud Rate
?  9600
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8 Press the  or  key to display the desired setting. The setting 
changes as shown below.

The baud rate can be selected from 1200, 2400, 4800, 9600 (default), 
19200, 38400, 57600, and 115200.

Some computers may not be compatible with a baud rate of 115200 bps. 
If you set the baud rate to 115200 and communication problems occur, 
lower the baud rate.

9 Display the desired baud rate and press the ENTER key.

10 Press the MENU key. The message display returns to Ready.

Note

ENTER

MENU
1-44



Using the Operator Panel
Changing Network Interface Parameters

This section applies to the printers having the option network card 
installed. The FS-1800N/FS-3800N come standard with a network 
interface card installed. For details concerning the network when using 
the FS-1800N/FS-3800N, refer to the supplied Network Manual.

To make your printer supports Netware, TCP/IP, and EtherTalk networks, 
you will need to install the option network interface card in the printer and 
make the proper settings as explained in this section.

You can also have a status page for the network interface card printed out 
each time the printer is turned on. 

1 Press the MENU key.

2 Press the  or  key repeatedly until Interface > appears. One 
of the interface names shown below appears, indicating the current 
interface.

Parallel (default)
Serial
Option

3 Press the ENTER key. A blinking question mark (?) appears.

4 Press the  or  key repeatedly until Option appears.

5 Press the ENTER key again.

Option

MENU

ENTER Interface
? Parallel

Interface
? Option

ENTER
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6 Press the > key. Each time the  or  key is pressed, the display 
changes as shown below.

7 The following example explains how to activate TCP/IP protocol to 
connect the printer in the network. You can select Netware or 
EtherTalk in a similar manner.

If TCP/IP is currently Off is displayed, select On using the  or  
key. Press the ENTER key again.

? >NetWare       >
  On

>TCP/IP        >
  On

>EtherTalk
  Off

>Opt. StatusPage
  On This is the network interface card 

status page print menu. See page 1-48.

ENTER

>TCP/IP        >
  On

>TCP/IP
? On

>TCP/IP        >
  On
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8 Press the > key. Each time the  or  key is pressed, the item 
changes as shown below.

9 Display the item to be set and press the ENTER key. 
For DHCP, a question mark (?) appears. For IP Address, Subnet 
Mask, and Gateway, the cursor (   ) blinks. 

10 For DHCP, select On or Off using the  or  key. For IP Address, 
Subnet Mask, and Gateway addresses, press  or  key to change 
the number (000 to 255) where the cursor is blinking. You can use 
the > and < key to move the cursor right and left. 

To obtain these addresses, consult your network administrator.

11 Press the ENTER key.

12 Press the MENU key. The message display returns to Ready.

? >>DHCP
  Off

>>IP Address
 000.000.000.000

>>Subnet Mask
 000.000.000.000

>>Gateway
 000.000.000.000

ENTER

ENTER

MENU
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Printing a Network Card Interface Status Page

To use this function, the network interface card must be installed on the 
printer. The FS-1800N/FS-3800N come standard with a network interface 
card installed.

You can have your printer print out a status page for the network interface 
card each time the printer is turned on. The network interface card status 
page shows the firmware version, the network addresses, and other 
information under various network protocols about the network interface 
card. The default setting is On (print).

Printing out a network interface card status page may not be possible 
with some network interface cards. For details, see the manual for the 
network interface card.

1 Press the MENU key.

2 Press the  or  key repeatedly until Interface > appears.

3 Press the ENTER key. A blinking question mark (?) appears.

If you want to abandon the interface selection procedure, press the 
CANCEL key. The interface remains unchanged.

4 Press the  or  key repeatedly until Option appears.

5 Press the ENTER key again. A > appears.

Option

Note

MENU

Interface
  Parallel

ENTER Interface
? Parallel

Interface
? Option

ENTER Interface      >
  Option
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6 Press the > key and then press the  or  key repeatedly until the 
message display indicates >Opt. StatusPage.

7 The default setting is On. If it is set to Off, change it as follows.
Press the ENTER key. A blinking question mark (?) appears.

8 Select On using the  or  key.

9 Press the ENTER key again.

10 Press the MENU key. The message display returns to Ready.

? >Opt. StatusPage

  On

ENTER

>Opt. StatusPage

? Off

>Opt. StatusPage

? On

ENTER >Opt. StatusPage

  On

MENU

NETWORK STATUS PAGE
 FS-1800  Page Printer
1-49



Using the Operator Panel
Changing the Emulation

The emulation mode for the current interface can be changed.

1 Press the MENU key.

2 Press the  or  key repeatedly until Emulation appears. One of 
the emulation names shown below appears, indicating the current 
emulation.

PCL 6 (default)
KPDL
KPDL (AUTO)
Line Printer
IBM Proprinter
DIABLO 630
EPSON LQ-850

3 Press the ENTER key. A blinking question mark (?) appears.

4 Press the  or  key repeatedly until the desired emulation mode  
appears.

If you want to abandon the selection, press the CANCEL key.

5 Press the ENTER key.  The > key allows access to sub item >Code 
set.

6 Press the MENU key. The message display returns to Ready.

After changing the emulation, you have the option to change the character 
code set. Available character code sets vary depending on the current 
emulation.

Emulation      >
  PCL 6

MENU

ENTER Emulation
?PCL 6

ENTER

MENU
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KPDL (AUTO) Emulation

KPDL is the Kyocera Mita's implementation of the PostScript language. 
The KPDL (AUTO) emulation enables the printer to automatically change 
the emulation mode according to the data received when printing. 
In addition to KPDL (AUTO) emulation, you can use the operator panel to 
set another emulation mode that is used very often. The default setting is 
PCL 6.

1 Press the MENU key.

2 Press the  or  key repeatedly until Emulation appears. 

3 Press the ENTER key. A blinking question mark (?) appears.

4 Press the  or  key repeatedly until the message display 
indicated KPDL (AUTO) appears.

If you want to abandon the setting procedure, press the CANCEL 
key.

5 Press the ENTER key.

6 Press the > key. When > Print KPDL Errs is displayed, press the 
 or  key. The names of alternative emulations appear.

PCL 6 (default)
Line Printer
IBM Proprinter
DIABLO 630
EPSN LQ-850

MENU

Emulation      >
 PCL 6

ENTER Emulation
?PCL 6

Emulation
?KPDL (AUTO)

ENTER

?
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7 Press the ENTER key. A blinking question mark (?) appears.

8 Press the  or  key repeatedly until the desired alternative 
emulation appears. 

If you want to abandon the setting procedure, press the CANCEL 
key.

9 Press the ENTER key.

10 Press the MENU key. The message display returns to Ready.

Auto Printing of KPDL Error

The printer can be set to print error data during KPDL emulation. If this is 
set to On, error data will be printed if only trouble occurs during printing. 
The factory default setting is Off.

1 Press the MENU key.

2 Press the  or  key repeatedly until Emulation > appears. 

3 Press the ENTER key. A blinking question mark (?) appears.

ENTER >Alt. Emulation
?PCL 6

ENTER

MENU

MENU

Emulation      >
 PCL 6

ENTER Emulation
?PCL 6
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4 Select KPDL or KPDL (AUTO) using the  or  key.

If you want to abandon the setting procedure, press the CANCEL 
key.

5 Press the ENTER key.

6 Press the > key. The message display changes to that shown below. If 
>Alt. Emulation is displayed when the KPDL (AUTO) emulation 
is selected, press the  or  key to change it.

7 Press the ENTER key. A blinking question mark (?) appears.

8 Select On using the  or  key. 

If you want to abandon the setting procedure, press the CANCEL 
key.

9 Press the ENTER key.

10 Press the MENU key. The message display returns to Ready.

Emulation
?KPDL

ENTER

?

>Print KPDL Errs
  Off

ENTER >Print KPDL Errs
? Off

>Print KPDL Errs
? On

ENTER

MENU
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Setting the Default Font

You can select the default font for the current interface. In addition to the 
internal fonts, all fonts that are downloaded to the printer memory, or fonts 
stored on a CompactFlash card, Microdrive, or option ROM, can be selected 
as the default font. 

In this menu, you can also set the type and pitch for Courier and Letter 
Gothic; as well as to print a font list.

Selecting the default font

1 Press the MENU key.

2 Press the  or  key repeatedly until Font > appears. 

3 To select an internal font, check that Internal is displayed and 
press the > key. The message display changes to that shown below. If 
Internal is not displayed, press the  or  key to display it.

To select an option font, press the ENTER key while Font > is 
displayed. Press  or  key repeatedly until the message display 
indicates Option and press the ENTER key. Pressing the > key after 
that displays the font selection shown above. This operation is 
possible only when option fonts are installed in the printer.

The letter before the number indicates the type of font as shown 
below:

Letter Description

I Internal font

S Soft (down load) font

M Fonts in an option CompactFlash card

H Fonts in a RAM disk or option Microdrive.

O Fonts in an option ROM

Font           >
  Internal

MENU

Font           >
  Internal

?

> I000
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4 Press the ENTER key. A blinking question mark (?) appears.

5 Press the  or  key repeatedly until the desired font number 
appears. For font numbers of the internal fonts, see  List of Fonts on 
page A-2.

If you want to abandon the selection, press the CANCEL key.

6 When the desired font is displayed, press the ENTER key.

7 Press the MENU key. The message display returns to Ready.

ENTER >?I000

ENTER

MENU
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Changing Type for Courier/Letter Gothic

Courier or Letter Gothic font type can be selected as Regular or Dark. For 
example, to change the type of Courier, proceed as follows:

1 Press the MENU key.

2 Press the  or  key repeatedly until Font > appears.

3 Check that Internal is displayed and press the > key.

4 Press the  or  key repeatedly until >Courier appears.

5 Press the ENTER key. A blinking question mark (?) appears.

6 Select Regular or Dark using the  or  key . 

If you want to abandon the setting procedure, press the CANCEL 
key.

7 Press the ENTER key.

8 Press the MENU key and the message display returns to Ready.

>Courier

MENU

Font           >
  Internal

?

>Courier
  Regular

ENTER >Courier
? Regular

ENTER

MENU
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Changing the Font Size

You can change the size of the default font. If the default font is a fixed font 
such as Courier or Letter Gothic, the character pitch can be changed 
instead of the font size.

1 Press the MENU key.

2 Press the  or  key repeatedly until Font > appears.

3 Check that Internal is displayed and press the > key.

4 Press the  or  key repeatedly until >Size appears.

5 Press the ENTER key. A blinking cursor ( _ ) appears.

6 Press the  or  key to increase or decrease the value of the figure 
where the cursor is blinking. The font size can be set between 4 and 
999.75 points, in 0.25-point increments. You can use the > or < key to 
move the cursor right and left.

If you want to abandon the setting procedure, press the CANCEL 
key.

7 When the desired size is displayed, press the ENTER key.

8 Press the MENU key. The message display returns to Ready.

>Size

MENU

Font           >
  Internal

?

>Size
 012.00 point(s)

ENTER >Size
 012.00 point(s)

ENTER

MENU
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Setting the Character Pitch for Courier/Letter Gothic

You can set the character pitch for fixed fonts when the default font is 
Courier or Letter Gothic.

1 Press the MENU key.

2 Press the  or  key repeatedly until Font > appears.

3 Check that Internal is displayed and press the > key.

4 Press the  or  key repeatedly until >Pitch appears.

5 Press the ENTER key. A blinking cursor ( _ ) appears.

6 Press the  or  key to increase or decrease the value of the figure 
where the cursor is blinking. The character pitch can be set between 
0.44 and 99.99 characters per inch, in 0.01 character-per-inch 
increments. You can use the > or < keys to move the cursor right and 
left. 

If you want to abandon the setting procedure, press the CANCEL 
key.

7 When the desired size is displayed, press the ENTER key.

8 Press the MENU key. The message display returns to Ready.

>Pitch

MENU

Font           >
  Internal

?

>Pitch
      10.00 cpi

ENTER >Pitch
      10.00 cpi

ENTER

MENU
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Printing a List of Fonts

To help in selecting fonts, you can print a list of the fonts including option 
fonts.

1 Press the MENU key.

2 Press the  or  key repeatedly until Font > appears.

3 To print a list of the internal fonts, check that Internal is displayed 
and press the > key. To print a list of option fonts, display Option 
and press the > key.

4 Press the  or  key repeatedly until >List of Fonts appears.

5 Press the ENTER key. A question mark (?) appears.

If you want to abandon printing procedure, press the CANCEL key.

6 Press the ENTER key again. Processing appears, then Ready. The 
printer prints a list of fonts with a short sample and font ID 
(number) for each font.

>List of Fonts

MENU

Font           >
  Internal

?

>List of Fonts

ENTER >List of Fonts ?
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List of Fonts 

Internal Scalable and Bitmapped Fonts List

Font Name Scalable/Bitmap Password Selection [FSET] Font ID

PRESCRIBE

Internal Scalable and Bitmapped Fonts List

Font Name Scalable/Bitmap Password Selection [FSET] Font ID

PRESCRIBE
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Using Page Set Menus

In Page Set menus, you can set the number of copies, the page 
orientation, and other settings regarding pagination.

Setting the Number of Copies

You can set the number of copies to be printed of each page for the current 
interface. The number of copies can be set between 1 and 999. The number 
of copies can be set whenever the message display indicates Ready.

1 Press the MENU key.

2 Press the  or  key repeatedly until Page set > appears.

3 Press the > key.

4 Press the  or  key repeatedly until >Copies appears.

5 Press the ENTER key. A blinking cursor ( _ ) appears.

Page Set       >

>Copies

MENU

Page Set       >

?

>Copies
             001

ENTER >Copies
             001
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6 Press the  or  key to increase or decrease the value of the figure 
where the cursor is blinking. It can be set between 1 and 999. You 
can use the > and < keys to move the right and left.

If you want to abandon the setting procedure, press the CANCEL 
key.

7 When the desired size is displayed, press the ENTER key.

8 Press the MENU key. The message display returns to Ready.

ENTER

MENU
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Selecting the Printing Orientation

You can select the portrait (upright) or landscape (sideways) page 
orientation. The page orientation can be set whenever the message display 
indicates Ready.

1 Press the MENU key.

2 Press the  or  key repeatedly until Page Set > appears.

3 Press the > key.

4 Press the  or  key repeatedly until >Orientation appears.

5 Press the ENTER key. A blinking question mark (?) appears.

>Orientation

Portrait

A A
Landscape

Paper feed direction

MENU

Page Set       >

?

>Orientation
  Portrait

ENTER >Orientation
? Portrait
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6 Select Portrait or Landscape using the  or  key.  

If you want to abandon the setting procedure, press the CANCEL 
key.

7 Press the ENTER key.

8 Press the MENU key. The message display returns to Ready.

ENTER

MENU
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Page Protect Mode

Although Auto is the default setting and this menu does not usually 
appear, Page Protect will be forcibly set to On if a Print overrun 
Press GO error occurs due to insufficient printer memory. Be sure to 
return this setting to Auto in order to maintain high printer memory 
efficiency. This can be done as follows.

1 Press the MENU key.

2 Press the  or  key repeatedly until Page set > appears.

3 Press the > key.

4 Press the  or  key repeatedly until >Page Protect appears.

5 Press the ENTER key. A blinking question mark (?) appears.

>Page Protect

MENU

Page set       >

?

>Page Protect
  On

ENTER >Page Protect
? On
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6 Press the  or  key repeatedly until Auto appears.

If you want to abandon the setting procedure, press the CANCEL 
key.

7 Press the ENTER key.

8 Press the MENU key. The message display returns to Ready.

>Page Protect
? Auto

ENTER

MENU
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Linefeed (LF) Action

This procedure instructs the printer what to do when it receives a linefeed 
code (character code 0AH).

1 Press the MENU key.

2 Press the  or  key repeatedly until Page set > appears.

3 Press the > key.

4 Press the  or  key repeatedly until >LF Action appears.

5 Press the ENTER key. A blinking question mark (?) appears.

6 Press the  or  key repeatedly until desired linefeed action 
appears.

LF only A linefeed is performed. (default)

CR and LF A linefeed and carriage return are performed.

Ignore LF The linefeed is ignored.

If you want to abandon the setting procedure, press the CANCEL 
key.

7 When the  desired action is displayed, press the ENTER key.

8 Press the MENU key. The message display returns to Ready.

>LF Action

MENU

Page set       >

?

>LF Action
  LF only

ENTER >LF Action
? LF only

ENTER

MENU
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Carriage-Return (CR) Action

This procedure instructs the printer what to do when it receives a carriage-
return code (character code 0DH)

1 Press the MENU key.

2 Press the  or  key repeatedly until Page set > appears.

3 Press the > key.

4 Press the  or  key repeatedly until >CR Action appears.

5 Press the ENTER key. A blinking question mark (?) appears.

6 Press the  or  key repeatedly until desired carriage-return 
action appears.

CR only A carriage-return is performed. (Default)

CR and LF A carriage-return and linefeed are performed.

Ignore CR The carriage-return code is ignored.

If you want to abandon the setting procedure, press the CANCEL 
key.

7 When the  desired action is displayed, press the ENTER key.

8 Press the MENU key. The message display returns to Ready.

>CR Action

MENU

Page set       >

?

>CR Action
  CR only

ENTER >CR Action
? CR only

ENTER

MENU
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Wide A4

Turn this to On to increase the maximum number of characters that can be 
printed in a line for A4 page (78 characters at 10 pitch) and Letter size 
page (80 characters at 10 pitch). This setting is effective in only PCL 6 
emulation.

1 Press the MENU key.

2 Press the  or  key repeatedly until Page set > appears.

3 Press the > key.

4 Press the  or  key repeatedly until >Wide A4 appears.

5 Press the ENTER key. A blinking question mark (?) appears.

6 Select On or Off using the  or  key. 

If you want to abandon the setting procedure, press the CANCEL 
key.

7 Press the ENTER key.

8 Press the MENU key. The message display returns to Ready.

>Wide A4

MENU

Page set       >

?

>Wide A4
  Off

ENTER >Wide A4
? Off

ENTER

MENU
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Setting the Print Quality

You can make the following settings to enhance the print quality: Kyocera 
Image Refinement (KIR), a software algorithm for increasing printout 
quality; Ecoprint, a printing mode that reduces toner consumption during 
printing; printing resolution; and Adjustment of the Print Density.

KIR (Kyocera Image Refinement)

This printer incorporates the KIR (Kyocera Image Refinement) smoothing 
function. At resolutions of Fast 1200 mode, 600 dpi, and 300 dpi, this 
function provides high print quality by providing software enhancement of 
print resolution. The function does not operate at Fine 1200 mode because 
that is the maximum resolution attainable by the print engine. 

Set the print density to 3 when setting the KIR mode. For details on print 
density, see page 1-75.

You can look at the check line, the last line on a status page, to make the 
optimum KIR mode setting.

1 Press the MENU key.

Print Quality  >

>KIR Mode

With KIR Off With KIR On (default)

Q

Note

 KIR  Test pattern  ON

Memory

Installed Options 

Network Status Emulation

Toner Gauge

0 100 

Interfaces

Hardware Information 

Page Information

Error Log

STATUS PAGE
 FS-1800  Page Printer

Firmware Version:                                    Released:     

Status Page

KIR Checking 
Lines

Optimized stripes

The current KIR setting is optimal.

Dark vertical stripes

Set the KIR mode to Off. Try printing the status 
page again. If you still get dark vertical stripes, 
adjust the print density control to a lighter setting.

White vertical stripes

Set the KIR mode to On. Try printing the status 
page again. If you still get white vertical stripes, 
adjust the print density control to a darker setting.

MENU
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2 Press the  or  key repeatedly until Print Quality > appears.

3 Press the > key.

4 Press the  or  key repeatedly until >KIR Mode appears.

5 Press the ENTER key. A blinking question mark (?) appears.

6 Select On or Off using the  or  key. 

If you want to abandon the setting procedure, press the CANCEL 
key.

7 Press the ENTER key.

8 Press the MENU key. The message display returns to Ready. 

Print Quality  >

?

>KIR Mode
  On

ENTER >KIR Mode
? On

ENTER

MENU
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Ecoprint

The Ecoprint enables you to reduce the amount of toner consumed on the 
page so as to save your printing costs. You can set to Ecoprint mode on, as 
follows. (The factory default setting is Off. )

The Ecoprint mode setting is On when the printing image becomes lighter, 
yet very readable. 

The Ecoprint setting has no effect on the print speed.

1 Press the MENU key.

2 Press the  or  key repeatedly until Print Quality > appears.

3 Press the > key.

4 Press the  or  key repeatedly until >Ecoprint Mode appears.

>Ecoprint Mode

Ecoprint setting is Off 
(default).

Ecoprint setting is On

Note

MENU

Print Quality  >

?

>Ecoprint Mode
  Off
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5 Press the ENTER key. A blinking question mark (?) appears.

6 Select On or Off using the  or  key. 

If you want to abandon the setting procedure, press the CANCEL 
key.

7 Press the ENTER key.

8 Press the MENU key. The message display returns to Ready. 

ENTER >Ecoprint Mode
? Off

ENTER

MENU
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Resolution

You can set the default print resolution in four ways � 300 dpi, 600 dpi, 
Fast 1200 mode, and Fine 1200 mode. The clarity of printed characters 
and graphics becomes sharper in this order. Fine 1200 mode renders 
optimum print quality but requires more printer memory and increase the 
time it takes up to print a job.

1 Press the MENU key.

2 Press the  or  key repeatedly until Print Quality > appears.

3 Press the > key.

4 Press the  or  key repeatedly until >Resolution appears.

5 Press the ENTER key. A blinking question mark (?) appears.

6 Select Fast 1200 mode, Fine 1200 mode, 300 dpi or 600 dpi 
using the  or  key.
 
If you want to abandon the setting procedure, press the CANCEL 
key.

7 Press the ENTER key.

8 Press the MENU key. The message display returns to Ready. 

>Resolution

MENU

Print Quality  >

?

>Resolution
  Fast 1200 mode

ENTER >Resolution
? Fast 1200 mode

ENTER

MENU
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Adjusting the Print Density

The print density can be adjusted in five steps: from 01 (light) to 05 (dark). 
The factory setting is 03.

1 Press the MENU key.

2 Press the  or  key repeatedly until Print Quality > appears.

3 Press the > key.

4 Press the  or  key repeatedly until >Print Density appears.

5 Press the ENTER key. A blinking question mark (?) appears.

6 Select the print density from five steps from 01 (light) to 05 (dark) 
using the  or  key.
 
If you want to abandon the setting procedure, press the CANCEL 
key.

7 Press the ENTER key.

8 Press the MENU key. The message display returns to Ready. 

>Print Density

MENU

Print Quality  >

?

>Print Density
  03

ENTER >Print Density
? 03

ENTER

MENU
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Operating a CompactFlash (Memory) Card 

The printer is equipped with a slot for a CompactFlash card. By inserting a 
CompactFlash card into the printer, the following operations become 
available. For details about the handling of the CompactFlash card, see 
Appendix D.

� Reading font

� Reading data

� Writing data

� Deleting data

� Formatting a CompactFlash card

� Print a list of data names

Reading Fonts

If a CompactFlash card is already inserted into the slot when the printer is 
turned on, the fonts are automatically read into the printer. 

To re-read fonts into the printer from a CompactFlash card, proceed as 
follows.

1 Press the MENU key.

2 Press the  or  key repeatedly until Memory Card > appears.

3 Press the > key.

4 Press the  or  key repeatedly until >Read fonts appears.

5 Press the ENTER key. A question mark (?) appears.

Memory Card    >

MENU

Memory Card    >

?

>Read fonts

ENTER >Read fonts ?
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6 Press the ENTER key. Processing appears and the reading of fonts 
from the CompactFlash card starts.

If you want to abandon the reading of fonts, press the CANCEL key.

7 When the reading of fonts ends, the message display returns to 
>Read fonts.

8 Press the MENU key. The message display returns to Ready.

Reading Data

Data stored on a CompactFlash card can be read.

To read data on a CompactFlash card, proceed as follows.

1 Press the MENU key.

2 Press the  or  key repeatedly until Memory Card > appears.

3 Press the > key.

4 Press the  or  key repeatedly until >Read Data appears. The 
data name also appears.

5 Press the ENTER key. A blinking question mark (?) appears before 
the data name.

ENTER

MENU

MENU

Memory Card    >

?

>Read Data
 data name

ENTER

>Read Data
?data name
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6 Press the  or  key to display the desired data name.

If you want to abandon the reading of data, press the CANCEL key.

7 Press the ENTER key. Processing appears and the reading of data 
from the CompactFlash card starts.

Writing Data

Data can be written to a CompactFlash card until no space is left for 
storing. When writing to a CompactFlash card, a name is assigned to the 
file automatically. You can use the procedure explained later in this section 
to print a list of data names for confirmation.

To write data to a CompactFlash card, proceed as follows. 

First check that the CompactFlash card is properly formatted. Otherwise, 
the >Write Data message to be explained below will not be shown on the 
message display.

If the card inserted in the CompactFlash card slot is not formatted, the 
>Format option will automatically appear on the display. See Formatting 
on page 1-82 and format the memory card.

1 Press the MENU key.

2 Press the  or  key repeatedly until Memory Card > appears.

3 Press the > key.

4 Press the  or  key repeatedly until >Write Data appears.

ENTER

Note

MENU

Memory Card    >

?

>Write Data
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5 Press the ENTER key. A question mark (?) appears.

6 Press the ENTER key. Processing appears, then Waiting. If you 
want to abandon writing, press the CANCEL key.

7 In this state, send the file from the computer to the printer as in the 
example below.

Example:

To send the file (data) TEST.TXT on drive C, enter the following at 
the DOS prompt (C:\):

 COPY TEST.TXT PRN
The file is written onto the memory card given a destination name 
(also referred to as a partition name) which the printer automatically 
assigns one after another as follows:

DataS001 (first data), DataS002 (second data), 
DataS003 (third data)...

In the example above, if the file TEST.TXT is the first data to be 
written onto the memory card, the destination name will be 
DataS001.

As the printer receives data, the message display changes to 
Processing, then when the end of the data is received, the message 
display changes to Waiting.

ENTER >Write Data ?

ENTER
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8 Check that the message display has changed to Waiting, then press 
the GO key. This writes the file to the memory card and instructs the 
printer to automatically print out a CompactFlash card write 
information page as shown below.

Partition Type. Type of data written (currently only type 2 is supported).
Partition Name. The destination name of data written to the card.
Write Partition Length. The size of the written data on the CompactFlash 
card.
Others. Error information.

When the CompactFlash card write information page is printed, the 
message display returns to Ready.

If the writing was not completed successfully, an error code appears 
on the message display. For details, see section 3.3.3 Error 
Messages on page 3-10. If this happens, press the GO key. The 
message display returns to Ready.

9 Repeat above steps until you have transferred all data (files) that 
you want to write to the CompactFlash card. Each time you finish 
writing data, a CompactFlash card write information page is printed 
from the printer showing the information explained in step 4 above, 
but pertaining only to the data just written. To see all data contained 
in the CompactFlash card at once, print a list of data names as 
explained on page 1-83,  Printing a List of Data Names.

Deleting Data

It is possible to use the printer to delete data from a CompactFlash card 
one by one.

To delete data from a CompactFlash card, proceed as follows.

Check that the CompactFlash card contains data.

Otherwise, the >Delete Data menu will not that appear on the message 
display.

1 Press the MENU key.

GO

 FS-1800  Page Printer

WRITE INFORMATION

MENU
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2 Press the  or  key repeatedly until Memory Card > appears.

3 Press the > key.

4 Press the  or  key repeatedly until > Delete Data appears. 
The data name also appears.

5 Press the ENTER key. A blinking question mark (?) appears before 
the data name.

6 Press the  or  key to display the desired data name.

If you want to abandon the deleting of data, press the CANCEL key.

7 Press the ENTER key. Processing appears and the data is deleted 
from the CompactFlash card.

Memory Card    >

?

>Delete Data
 data name

ENTER

>Delete Data
?data name

ENTER
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Formatting

Formatting allows data to be written to the card. A new CompactFlash 
card must be formatted before it can be used in the printer.

Formatting destroys any existing data on the CompactFlash card.

To format a CompactFlash card, proceed as follows.

1 Press the MENU key.

2 Press the  or  key repeatedly until Memory Card > appears.

3 Press the > key.

4 Press the  or  key repeatedly until >Format appears.

5 Press the ENTER key. A question mark (?) appears.

6 Press the ENTER key. Processing appears and formatting of the 
CompactFlash card starts.

If you want to abandon formatting, press the CANCEL key.

Note

MENU

Memory Card    >

?

>Format

ENTER >Format ?

ENTER
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When the formatting is successfully completed, the printer automatically 
prints out a format information page as shown below. 

Capacity. The total size of the CompactFlash card memory.
Used Space. The size the printer uses for its system.
Free Space. The size remaining in the CompactFlash card for storing data.

When the CompactFlash card format information is printed, the message 
display returns to Ready.

Printing a List of Data Names

The printer prints a list of all data names (referred to as partitions) stored 
in a memory card for reference. (Printing a list is also available for a font 
card.)

To print a list of data names for the CompactFlash card, proceed as follows.

1 Press the MENU key.

2 Press the  or  key repeatedly until Memory Card > appears.

3 Press the > key.

4 Press the  or  key repeatedly until >List of Partitions 
appears.

FORMAT INFORMATION
 FS-1800  Page Printer

Memory Card    >

>List of

 Partitions
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5 Press the ENTER key. A question mark (?) appears.

If you want to abandon the printing of the list, press the CANCEL 
key.

6 Press the ENTER key. Processing appears and the printing of the 
list starts.

The printout (example above) includes the following information.

Device Name/Number. CARD/A is indicated for the CompactFlash card.
Capacity. The total capacity of the memory card in bytes.
Used Space. The total size of the data stored in the CompactFlash card in bytes.
Free Space. The size of the capacity remaining in the CompactFlash card for 
storing further data, including the amount of memory that the printer uses for 
its system.
Partition Name. The name of the written data as assigned automatically by the 
printer.
Partition Size. The size of the written data in bytes.
Partition Type. The type of the written data i.e., whether it is host data (Data) 
or font data (Font).

When the list of file names (partition list) for the CompactFlash card is 
printed, the message display returns to Ready.

>List of

 Partitions ?

Partition Information

Device Information 

PARTITION LIST
 FS-1800  Page Printer
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Operating the Microdrive (Hard Disk)

By installing the option Microdrive into the printer, the e-MPS function can 
be used. The printer's menu selection system allows you to perform the 
following operations on the Microdrive. For details, see 3.4 e-MPS in 
Printer Driver Guide).

� Reading data

� Writing data

� Deleting data

� Printing of list of partitions

The procedures are the same as that for the Memory Card menu. See 
Operating a CompactFlash (Memory) Card on page 1-76.

Hard Disk      >
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Setting the RAM Disk

The RAM disk is a memory space shared within the printer memory that 
can temporarily store print jobs. The RAM disk can be used only for 
electronic sorting. The stored print job can then be used to print multiple 
copies of the job reducing the total amount of period required to print the 
whole job. It acts similar to the Microdrive except that the data is effective 
only during the printer is powered up.

To use RAM disk, the following two conditions apply:

� Total printer memory is 12 MB or more.

� The Microdrive is not physically installed.

The maximum size of RAM disk should be calculated as follows:

Maximum RAM size = Total printer memory - 9 MB

For example, if the total memory installed in your printer is 12 MB, you 
can set 3 MB RAM disk using the manner explained below. If you attempt 
to set a memory size beyond this restriction, the printer automatically 
round it down so that the size is always 9 MB less than the total printer 
memory. Once the RAM disk size is set, the printer must be reset.

To activate RAM disk in the printer's memory, first you must use the 
printer's menu selection system.

The printer's menu selection system allows you to perform the following 
operations on the Microdrive.

� Reading data

� Writing data

� Deleting data

� Printing a list of data names

The procedures are the same as that for the Memory Card menu. See 
Operating a CompactFlash (Memory) Card on page 1-76.

� The RAM disk is set from the printer's user memory. The printer's 
printing speed may therefore drop or insufficient memory errors 
result depending on the value of the RAM disk setting.

� RAM disk functions cannot be used if an option Microdrive is 
installed.

RAM Disk Mode  >

Note
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1 Press the MENU key.

2 Press the  or  key repeatedly until RAM Disk Mode > appears.

3 The default setting is Off. Press the ENTER key. A blinking question 
mark (?) appears. Select On using the  or  key, and then press 
the ENTER key.

4 Press the > key to display >RAM Disk Size.

5 Press the ENTER key again, and change the RAM disk size using the 
 or  key. It is not possible to make a setting that exceeds total 

printer memory. The default value for the RAM disk is the total 
printer memory minus 9 MB. This parameter may be set anywhere 
from 01 to 99 depending on the available printer memory.  

If you want to abandon the setting, press the CANCEL key.

6 When the desired RAM disk size is displayed, press the ENTER key.

7 Press the CANCEL key and restart the printer. The setting will be 
activated after restart.

MENU

RAM Disk Mode  >
  Off

ENTER

RAM Disk Mode  >
? Off

?
>RAM Disk Size
           Mbyte

ENTER

ENTER
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Paper Handling

You can change the MP tray mode, the paper size and type for each paper 
source, the sorter mode, the paper source, and paper destinations.

MP Tray Mode

The MP tray can be used in one of two modes: first mode or cassette mode. 
The MP tray can hold approximately 100 sheets of paper (A4 size, 0.11 mm 
thickness).

The maximum capacity for the MP tray of 100 sheets is based on A4 
paper. If you use Legal size paper on the MP tray, the number of paper 
you use should be considerably smaller than 100 sheets to avoid 
possible paper jam.

First Mode (Automatic Manual Feeding)

The printer automatically feeds any paper placed on the MP tray even if 
another paper source is selected. After all paper in the MP tray is printed, 
paper will be fed from the paper source originally selected. (This is the 
factory default setting.)

Cassette Mode

The cassette mode provides faster printing speed than the first mode. 
Approximately 100 sheets of paper can be continuously fed in this mode.

1 Press the MENU key.

2 Press the  or  key repeatedly until Paper Handling > 
appears.

3 Press the > key.

4 Press the  or  key repeatedly until >MP Tray Mode appears.

Paper Handling >

>MP Tray Mode

Note

MENU

Paper Handling >

?

>MP Tray Mode
  First
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5 Press the ENTER key. A blinking question mark (?) appears.

6 Select First or Cassette using the  or  key . 

If you want to abandon the setting procedure, press the CANCEL 
key.

7 Press the ENTER key.

8 Press the MENU key. The message display returns to Ready. 

ENTER >MP Tray Mode
? First

ENTER

MENU
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Setting the MP Tray Size

When using the MP tray in the cassette mode, you should set the MP tray 
size to the paper size that is used to format the job to print. If they do not 
match, printing will not be made on the correct size paper when automatic 
paper size selection is made by the application (printer driver). The factory 
default setting is A4 or Letter.

For more details about the paper sizes that can be fed from the MP tray, see 
Chapter 4.

1 Press the MENU key.

2 Press the  or  key repeatedly until Paper Handling > 
appears.

3 Press the > key.

4 Press the  or  key repeatedly until >MP Tray Size appears.

5 Press the ENTER key. A blinking question mark (?) appears.

>MP Tray Size
  A4

MENU

Paper Handling >

?

>MP Tray Size
  A4

ENTER >MP Tray Size
? A4
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6 Press the  or  key to display the desired MP tray size. The 
display changes as shown below.

A4
Executive
Letter
Legal
Custom
Hagaki
Oufukuhagaki
Monarch
Business
Comm. #9
Comm. #6 3/4
DL
C5
A6
B6
A5
B5
ISO B5

If you want to abandon the selection, press the CANCEL key.

7 Press the ENTER key.

8 Press the MENU key. The message display returns to Ready.

ENTER

MENU
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Setting the MP Tray Type

You can automatically select the paper cassette according to the selection 
made by the application (printer driver). The factory default setting is 
Plain.

For more details about the paper types that can be fed from the MP tray, 
see Chapter 4.

1 Press the MENU key.

2 Press the  or  key repeatedly until Paper Handling > 
appears.

3 Press the > key.

4 Press the  or  key repeatedly until >MP Tray Type appears.

5 Press the ENTER key. A blinking question mark (?) appears.

>MP Tray Type

MENU

Paper Handling >

?

> MP Tray Type
  Plain

ENTER > MP Tray Type
? Plain
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6 Press the  or  key to display the desired MP tray type. The 
display changes as shown below.

Plain
Transparency
Preprinted
Labels
Bond
Recycled
Vellum
Rough
Letterhead
Color
Prepunched
Envelope
Cardstock
Custom (1 to 8)

If you want to abandon the selection, press the CANCEL key.

7 When the desired MP tray type is displayed, press the ENTER key.

8 Press the MENU key and the message display returns to Ready.

ENTER

MENU
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Custom Paper Size Setting

In addition to the standard sizes A5, A4, B5, and Letter for the paper 
cassette, paper of other sizes can be fed as custom sizes. When placing 
paper of sizes other than A5, A4, B5, or Letter into the paper cassette, set 
the size of the paper to be used into the printer by following the procedure 
given below. If an option paper feeder (PF-60) is installed, custom sizes for 
its paper cassette can be set using the same procedure.

This menu appears when the paper size dial of the paper cassette is set to 
CUSTOM.

Properly set the paper into the paper cassette. For details about the 
adjustment of the paper guides and paper stopper inside the paper 
cassette, see the Installation Manual supplied with the printer.

1 Pull out the paper cassette from the printer and turn the paper size 
dial to CUSTOM. 

2 Adjust the paper guides and paper stopper inside the paper cassette 
to the size of the paper to be used and load the paper into the 
cassette.

Set the size of the paper loaded in the paper cassette into the printer from 
the printer operator panel.

3 Press the MENU key.

4 Press the  or  key repeatedly until Paper Handling > 
appears.

5 Press the > key.

>Cassette Size >

Paper 
Size Dial

CUSTOM

MENU

Paper Handling >

?
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6 Press the  or  key repeatedly until >Cassette Size > 
appears. 

If option paper feeders are added, Cassette 1 Size will appear for 
the standard paper cassette and Cassette 2 Size, Cassette 3 
Size, and Cassette 4 Size will appear for the option paper 
feeders.

7 Press the > key.

8 Press the  or  key repeatedly until >>Unit appears. The unit of 
measurement can be selected between millimeters and inches. The 
current unit of measurement is displayed (the default setting is mm).

9 Press the ENTER key. A blinking question mark (?) appears.

10 Select mm or inch using the  or  key.  

If you want to abandon the selection, press the CANCEL key.

11 Press the ENTER key. 

12 When the unit of measurement is set, press the  key. 
>>X Dimension appears as shown below (the paper width setting).

>Cassette Size >

?

>>Unit
  mm

ENTER >>Unit
? mm

ENTER

>>X Dimension 
          216 mm
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13 Press the ENTER key. A blinking cursor (   ) appears.

14 Press the  or  key to increase or decrease the value of the figure 
where the cursor is blinking and display the desired width. The 
width can be set between 148 and 216 mm (5.83 to 8.5 inches). You 
can use the > and < keys to move the cursor right and left.

If you want to abandon the setting procedure, press the CANCEL 
key.

15 Display the paper width and press the ENTER key.

16 When the width is set, press the  key. >>Y Dimension appears 
(the paper length setting). Set the desired length in the same way as 
the width. The length can be set between 210 and 356 mm (8.27 to 
14.02 inches).

17 Display the paper length, press the ENTER key.

18 Press the MENU key. The message display returns to Ready. 

To print using the custom size set above, define the same custom size 
on the printer driver. For details, see 3.1.1 Custom Size Setting in 
Printer Driver Guide.

ENTER >>X Dimension 
          216 mm

Enter the paper size for X Dimension and Y Dimension as shown in 
the figure. 

X Dimension

Y
 D

im
en

si
on

148 to 216 mm 
(5.83 to 8.5 inches)

21
0 

to
 3

56
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m
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to

 1
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02
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)

ENTER

ENTER

MENU
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Setting the Cassette Paper Type

Make this setting to match the paper type fed from the paper cassette of 
the printer. If the paper type is set correctly, you can perform printing 
using the media type selection function from the application (printer 
driver). The factory default setting is Plain.

For more details about the paper types that can be fed from the paper 
cassette, see Chapter 4.

1 Press the MENU key.

2 Press the  or  key repeatedly until Paper Handling > 
appears.

3 Press the > key.

4 Press the  or  key repeatedly until >Cassette Type appears.

5 Press the ENTER key. A blinking question mark (?) appears.

>Cassette Type

MENU

Paper Handling >

?

>Cassette Type
  Plain

ENTER >Cassette Type
? Plain
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6 Press the  or  key to display the desired cassette type. The 
display changes as shown below.

Plain
Preprinted
Bond
Recycled
Rough
Letterhead
Color
Prepunched
Custom(1 to 8)

If you want to abandon the selection, press the CANCEL key.

7 When the desired cassette type is displayed, press the ENTER key.

8 Press the MENU key. The message display returns to Ready.

ENTER

MENU
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Selecting the Paper Source

You can select from which paper source printing will be performed. If no 
option units are installed, the only selections are the paper cassette and 
MP tray of the printer. If option paper feeders are installed, they can also 
be selected.

1 Press the MENU key.

2 Press the  or  key repeatedly until Paper Handling > 
appears.

3 Press the > key.

4 Press the  or  key repeatedly until >Feed Select appears.

5 Press the ENTER key. A blinking question mark (?) appears.

>Feed Select   >

MENU

Paper Handling >

?

>Feed Select
  Cassette

ENTER >Feed Select
? Cassette
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6 Press the  or  key to display the desired paper source. The 
display changes as shown below according to the installed option 
units.

MP tray
Cassette
Cassette 1 (Printer's standard paper cassette when option paper 

feeders are installed)
Cassette 2 (Paper cassette of the top option paper feeder)
Cassette 3 (Paper cassette of the second option paper feeder)
Cassette 4 (Paper cassette of the third option paper feeder)

7 When the desired paper source displayed, press the ENTER key.

8 Press the MENU key. The message display returns to Ready.

ENTER

MENU
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Setting Duplex Printing

To use this function, the duplexer must be installed on the printer.

Using the option duplexer (DU-60), you can automatically print on both 
sides of the paper. The duplexer is mounted underneath the printer. For 
details about the installation procedure, see Appendix D and the User's 
Manual supplied with the duplexer.

Binding Setups

The term binding refers to the manner in which printed pages of paper are 
joined together when pages are joined together (by gluing, stitching, etc.) in 
book form. The two possible types of binding are long-edge binding, in 
which pages are joined together along their long edge; and short-edge 
binding, in which they are joined together along their short edge. In 
selecting a binding type, you must also consider the orientation of the 
printed page. You can use long-edge or short-edge binding with either 
landscape or portrait printing.

Depending on the binding type and print orientation, the duplexer provides 
four types of binding setups. These are: (1) portrait, long-edge, (2) portrait, 
short edge, (3) landscape, long-edge, and (4) landscape, short-edge. The 
figure below shows these binding setups. 

Binding Setups

To select duplex printing and binding setup from the operator panel, 
proceed as follows. This procedure can only be performed when the option 
duplexer (DU-60) is installed.

1 Press the MENU key.

Option

>Duplex Mode   >

(1)

(3)

(2)

(4)

Portrait, 
long-edge

Landscape, 
long-edge

Portrait, 
short-edge

Landscape, 
short-edge

MENU
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2 Press the  or  key repeatedly until Paper Handling > 
appears.

3 Press the > key.

4 Press the  or  key repeatedly until >Duplex Mode > appears.

5 Press the ENTER key. A blinking question mark (?) appears.

6 Press the  or  key to display the desired duplex mode. The 
display changes as shown below.

None (default)
Short edge bind
Long edge bind

7 When the desired duplex mode displayed, press the ENTER key.

8 Press the MENU key. The message display returns to Ready.

Duplex Printing from the MP tray

In first mode, be sure to set the MP tray to the same paper size and paper 
type as set for the current paper cassette. If the paper size or type differs, a 
paper jam may result. Also note that it is not possible to select the MP tray 
as the current paper cassette and perform duplex printing. We therefore 
recommend that duplex printing be performed from the paper cassette.

Paper Handling >

?

>Duplex Mode   >
  None

ENTER >Duplex Mode   >
? None

ENTER

MENU
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Selecting the Output Device

You can select whether printouts will be received by the face-down output 
tray or to the face-up output tray. If an option sorter is installed, it can also 
be selected.

1 Press the MENU key.

2 Press the  or  key repeatedly until Paper Handling > 
appears.

3 Press the > key.

4 Press the  or  key repeatedly until >Stack Select appears.

5 Press the ENTER key. A blinking question mark (?) appears.

6 Press the  or  key to display the desired destination. The output 
tray changes as shown below.

Face-down tray (Printer's face-down output tray) [Default]
Face-up tray (Printer's face-up output tray) [Option face-up 

tray required]
Option stacker (Displayed when option output device is 

installed such as SO-60)

7 When the desired paper source displayed, press the ENTER key.

8 Press the MENU key. The message display returns to Ready.

>Stack Select

MENU

Paper Handling >

?

>Stack Select
  Face-down tray

ENTER >Stack Select
? Face-down tray

ENTER

MENU
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Selecting the Sorter Mode

To use this function, the sorter must be installed on the printer.

If an option sorter (SO-60) is installed, you can have your printouts 
automatically sorted in three different ways when printing multiple copies 
of a document. 

The sorter mode sorts the output pages by copy. This mode is useful when 
you need several independent copies of a document. The collator mode 
sorts the output pages by page. When multiple copies of a file are printed, 
all copies of a single page are delivered together to a single tray. The mail 
box mode simply stacks the printed pages into the sorter tray you desire 
without sorting the pages.

1 Press the MENU key.

2 Press the  or  key repeatedly until Paper Handling > 
appears.

3 Press the > key.

4 Press the  or  key repeatedly until >Opt.StackerMode 
appears.

Option

>Opt.StackerMode

MENU

Paper Handling >

?

>Opt.StackerMode
  Sorter
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5 Press the ENTER key. A blinking question mark (?) appears.

6 Press the  or  key to display the desired sorter mode. The 
display changes as shown below.

Sorter (default)
Collater
Mail box

7 When the desired sorter mode displayed, press the ENTER key.

8 Press the MENU key. The message display returns to Ready.

ENTER >Opt.StackerMode
? Sorter

ENTER

MENU
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Overriding A4 and Letter Size Difference

This selects whether to enable or disable the difference between A4 size 
and Letter size. Under the default setting of Off, the paper size of the 
paper source is matched to the paper size formatting the jobs. If these 
differ, a corresponding error message is displayed. When this is set to On, 
printing is performed even if the actual paper size differs from the paper 
size formatting the jobs.

1 Press the MENU key.

2 Press the  or  key repeatedly until Paper Handling > 
appears.

3 Press the > key.

4 Press the  or  key repeatedly until >Override A4/LT appears.

5 Press the ENTER key. A blinking question mark (?) appears.

6 Select On or Off using the  or  key.

7 Press the ENTER key.

8 Press the MENU key. The message display returns to Ready.

>Override A4/LT

MENU

Paper Handling >

?

>Override A4/LT
  Off

ENTER >Override A4/LT
? Off

ENTER

MENU
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Customizing Paper Type

The following describes the procedure used to set a user-defined paper type 
for the printer. Eight custom user settings may be registered. After having 
been set, any of these may be called up when setting the paper type for a 
paper source.

The paper weight and duplex path can be set (see Setting the Paper 
Weight on page 1-109, and Setting the Duplex Path on page 1-110) after 
selecting the paper type to be customized as follows. For how to reset the 
customized settings, see Resetting the Type Adjust on page 1-111.

1 Press the MENU key.

2 Press the  or  key repeatedly until Paper Handling > 
appears.

3 Press the > key.

4 Press the  or  key repeatedly until >Type Adjust > appears.

5 Press the ENTER key. A blinking question mark (?) appears.

>Type Adjust   >

MENU

Paper Handling >

?

>Type Adjust   >
  Custom 1

ENTER >Type Adjust   >
? Custom 1
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6 Press the  or  key to display the desired paper type. The display 
changes as shown below.

Custom (1 to 8)
Plain
Transparency
Preprinted
Labels
Bond
Recycled
Vellum
Rough
Letterhead
Color
Prepunched
Envelope
Cardstock

7 When the paper type to be customized is displayed, press the ENTER 
key.

8 Press the > key and proceed to  Setting the Paper Weight on the 
following page.

ENTER

?
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Setting the Paper Weight

You can set the paper thickness for your custom paper type to be 
customized.

1 Display the custom paper type (see Customizing Paper Type on 
page 1-107) and press the > key.

2 Press the  or  key repeatedly until >>Paper Weight appears.

3 Press the ENTER key. A blinking question mark (?) appears.

4 Press the  or  key to display the desired paper thickness. The 
display changes as shown below. For details of the default setting for 
each paper type, see section 4.3 Paper Type on page 4-11.

Normal
Heavy (Thick)
Light (Thin)

If you want to abandon the setting procedure, press the CANCEL 
key.

5 When the desired paper thickness displayed, press the ENTER key.

6 Press the MENU key. The message display returns to Ready.

If the paper type is set to Custom and the option duplexer is installed 
on the printer, duplex printing can be enabled and disabled. See  
Setting the Duplex Path on the following page.

>>Paper Weight

?

>>Paper Weight
  Normal

ENTER >>Paper Weight
? Normal

ENTER

MENU
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Setting the Duplex Path 

To use this function, the duplexer must be installed on the printer.

If the paper type is set to Custom and the option duplexer is installed on 
the printer, you can set whether or not to enable duplex printing as follows. 
The default setting is Enable.

1 Display the custom paper type (see Customizing Paper Type on 
page 1-107) and press the > key.

2 Press the  or  key repeatedly until >>Duplex path appears.

3 Press the ENTER key. A blinking question mark (?) appears.

4 Select Enable or Disable using the  or  key. For details of the 
default setting for each paper type, see section 4.3 Paper Type on 
page 4-11. 

If you want to abandon the setting procedure, press the CANCEL 
key.

5 Press the ENTER key.

6 Press the MENU key. The message display returns to Ready.

Option

?

>>Duplex path
  Enable

ENTER >>Duplex path
? Enable

ENTER

MENU
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Resetting the Type Adjust

Resets the settings of Custom 1 to 8 that are set in Customizing Paper 
Type on page 1-107.

1 Press the MENU key.

2 Press the  or  key repeatedly until Paper handling > 
appears.

3 Press the > key.

4 Press the  or  key repeatedly until >Reset Type Adjust 
appears.

5 Press the ENTER key. A question mark (?) appears.

6 Press the ENTER key. All the customized paper weight and duplex 
path settings will be reset to the default.

7 Press the MENU key. The message display returns to Ready.

>Reset Type
Adjust

MENU

Paper Handling >

?

>Reset Type 
Adjust

ENTER >Reset Type 
Adjust ?

ENTER

MENU
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Verifying the Total Printed Pages and Resetting the Toner Counter

You can display the total number of pages printed by your printer for 
confirmation whenever necessary. The total number of printed pages can 
also be checked on the status page. Moreover, for proper maintenance 
scheduling, it will be necessary to reset the toner counter using this menu 
each time a new toner container is installed.

Verifying the Total Printed Pages

This procedure only displays the total number of printed pages. The 
number cannot be changed.

1 Press the MENU key.

2 Press the  or  key repeatedly until Life Counters > appears.

3 Press the > key.

4 Press the  or  key repeatedly until >Total Print appears.

5 Press the MENU key. The message display returns to Ready.

Life Counters  >

MENU

Life Counters  >

?

>Total Print
         1234567

MENU
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Resetting the Remaining Toner Counter

If the toner container was replaced when Replace toner Clean 
Printer was not displayed, reset the toner counter as follows so that an 
accurate toner gauge measurement is indicated on the status page. Note 
that if this operation is performed when the toner cartridge is not replaced, 
the toner gauge measurement will not be indicated correctly.

If the type of the toner kit (TK-60/TK-60E) was changed, the toner ID must 
also be changed. See Setting the Toner ID on page 1-132.

Also refer to the User's Manual supplied with the toner kit when 
replacing the toner container.

1 Press the MENU key.

2 Press the  or  key repeatedly until Life Counters > appears.

3 Press the > key.

4 Press the  or  key repeatedly until >New Toner Installed. 
appears

5 Press the ENTER key. A question mark (?) appears.

6 Press the ENTER key. The toner counter is reset.

7 Press the MENU key. The message display returns to Ready.

MENU

Life Counters  >

?

>New Toner 
 Installed

ENTER >New Toner 
 Installed ?

ENTER

MENU
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Other Modes

The modes described in the following pages can be accessed in the Others 
submenu. To enter the Others submenu, press the > key while Others > 
is displayed.

The following submenus can be displayed by pressing the > key and then 
the  or  key.

� Message Language Selecting

� Automatic Form Feed Timeout Setting

� Sleep Timer Setting

� Received Data Dumping

� Printer Resetting

� Resource Setting

� Alarm (Buzzer) Setting

� Auto Continue Setting

� Service Menu (for service personnel)

Others         >
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Message Language Selecting

You can select the language of the messages on the message display by 
following the procedure given below.

1 Press the MENU key.

2 Press the  or  key repeatedly until Others > appears.

3 Press the > key.

4 Press the  or  key repeatedly until >MSG Language appears. 
The default message language is English.

5 To change the language, press the ENTER key. A blinking question 
mark (?) appears.

>MSG Language

MENU

Others         >

?

>MSG Language
  English

ENTER

>MSG Language
? English
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6 Press the  key. The display cycles through the available selections 
in the following order (The  key cycles in the reverse order):

If you want to abandon the setting procedure, press the CANCEL 
key.

7 Press the ENTER key.

8 Press the MENU key. The message display returns to Ready.

>MSG Language
? English

>Berichttaal
? Nederlands

>Lingua
? Italiano

>Anzeigesprache
? Deutsch

>Langue
? Francais

ENTER

MENU
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Automatic Form Feed Timeout Setting

When the printer receives no data for a certain time, it time out and 
releases the current interface: it prints whatever data it has in its buffer 
and feeds out the page. You can adjust the time-out time as follows:

1 Press the MENU key.

2 Press the  or  key repeatedly until Others > appears.

3 Press the > key.

4 Press the  or  key repeatedly until >Form Feed Time appears. 
The default setting is 30 seconds.

5 Press the ENTER key. A blinking cursor (   ) appears.

6 Press the  or  key to increase or decrease the value of the figure 
where the cursor is blinking and set the desired time. The time can 
be set between 0 and 495 seconds, in 5-second increments. You can 
use the > and < keys to move the cursor right and left.

If you want to abandon the setting procedure, press the CANCEL 
key.

7 Display the desired time and press the ENTER key.

8 Press the MENU key. The message display returns to Ready.

>Form Feed
Time Out

MENU

Others         >

?

>Form Feed
Time Out 030sec.

ENTER >Form Feed Time.
Time Out 030sec.

ENTER

MENU
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Sleep Timer Setting

The printer has a sleep timer to conserve power when the printer is not 
printing, processing, or receiving data. You can adjust the timer value, the 
length of time the printer waits before entering sleeping mode in the 
absence of data.

1 Press the MENU key.

2 Press the  or  key repeatedly until Others > appears.

3 Press the > key.

4 Press the  or  key repeatedly until >Sleep Timer > appears. 
The default setting is 015 min.

5 Press the ENTER key. A blinking cursor ( _ ) appears.

6 Press the  or  key to increase or decrease the value of the figure 
where the cursor is blinking and set the desired time. The timer can 
be set between 5 and 240 min, in 5-minute increments. You can use 
the > and < keys to move the cursor right and left. 

If you want to abandon the setting procedure, press the CANCEL 
key.

7 Press the ENTER key.

8 Press the MENU key. The message display returns to Ready.

>Sleep Timer   >

MENU

Others         >

?

>Sleep Timer   >
        015 min.

ENTER >Sleep Timer
        015 min.

ENTER

MENU
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Turning Off the Sleep Timer

You can turn off the sleep timer function by following the procedure given 
below.

1 Press the MENU key.

2 Press the  or  key repeatedly until Others > appears.

3 Press the > key.

4 Press the  or  key repeatedly until >Sleep Timer > appears. 

5 Press the > key and display >>Sleep Mode.

6 Press the ENTER key. A blinking question mark (?) appears.

MENU

Others         >

?

>Sleep Timer   >
        015 min.

?
>>Sleep Mode
  On

ENTER >>Sleep Mode
? On
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7 Select Off using the  or  key.

If you want to abandon the setting procedure, press the CANCEL 
key.

8 Press the ENTER key.

9 Press the MENU key. The message display returns to Ready.

>>Sleep Mode
? Off

ENTER

MENU
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Received Data Dumping

It is possible to print data received by the printer as hexadecimal code for 
the purposes of debugging programs and files.

1 Press the MENU key.

2 Press the  or  key repeatedly until Others > appears.

3 Press the > key.

4 Press the  or  key repeatedly until > Print HEX-DUMP 
appears.

5 Press the ENTER key. A question mark (?) appears.

>Print HEX-DUMP

MENU

Others         >

?

>Print HEX-DUMP

ENTER >Print HEX-DUMP?
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6 Press the ENTER key again. Processing appears for a second, and 
then Waiting appears.

7 Send data to be dumped to the printer. The message Processing 
will be displayed during receiving the data. 

Once the dumped data you require has been output, it is possible to 
cancel the printing of any further dumped data by taking the printer 
offline by pressing the GO key and then pressing the CANCEL key.

8 Once all data has been received, the message Waiting will appear. 
Press the GO key to finish printing.

ENTER

>Processing

>Waiting

GO

GO
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Printer Resetting

The procedure described below resets the printer's temporary conditions, 
such as the current unit of measurement, page orientation, font, character 
code set, margins, etc., set by commands to their default values.

1 Press the MENU key.

2 Press the  or  key repeatedly until Others > appears.

3 Press the > key.

4 Press the  or  key repeatedly until >Printer Reset appears. 

5 Press the ENTER key. A question mark (?) appears.

If you want to abandon the printer resetting procedure, press the 
CANCEL key

6 Press the ENTER key again. Self test appears while the printer is 
resetting itself, then Please wait followed by Ready.

>Printer Reset

MENU

Others         >

?

>Printer Reset

ENTER >Printer Reset ?

ENTER

Self test

Please wait

>Ready
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Resource Protection

When you switch from the PCL 6 emulation to another, all downloaded 
fonts and macros are lost. Resource protection preserves these PCL 
resources in memory so that they are intact when you change the 
emulation back to PCL 6.

Resource protection requires extra memory to store the downloaded 
fonts and macros. The total size of the printer memory recommended for 
using the resource protection option is affected by several factors. See 
Appendix B.

1 Press the MENU key.

2 Press the  or  key repeatedly until Others > appears.

3 Press the > key.

4 Press the  or  key repeatedly until >Resouce Prot appears. 

5 Press the ENTER key. A blinking question mark (?) appears.

>Resouce Prot.

Note

MENU

Others         >

?

>Resouce Prot.
  Off

ENTER >Resouce Prot.
? Off
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6 Press the  or  key to display the desired mode. The display 
changes as shown below.

Off (default)
Permanent
Perm / Temp

7 When the desired mode is displayed, press the ENTER key.

8 Press the MENU key. The message display returns to Ready.

ENTER

MENU
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Alarm (Buzzer) Setting

In addition to the message displayed when the paper supply is exhausted, 
or when paper jamming occurs, an audio warning is made to sound. This is 
useful, for example, when the printer is in a location some distance from 
the user.

The audio alarm is set to On when leaving the factory. If the alarm is set to 
Off, it is made not to sound.

1 Press the MENU key.

2 Press the  or  key repeatedly until Others > appears.

3 Press the > key.

4 Press the  or  key repeatedly until Buzzer appears. 

5 Press the ENTER key. A blinking question mark (?) appears.

6 Select On or Off using the  or  key.

7 Press the ENTER key.

8 Press the MENU key. The message display returns to Ready.

>Buzzer

MENU

Others         >

?

>Buzzer
  On

ENTER >Buzzer
? On

ENTER

MENU
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Auto Continue Setting

If an error that still allows you to continue printing occurs (Memory 
overflow Press GO, Print overrun Press GO, KPDL error Press 
GO, and File not found Press GO), the next received data is 
automatically printed after a set period of time elapses. For example, if the 
printer is shared over a network as a network printer and one person 
causes one of the above errors, after the set period of time elapses, the data 
sent from the next person is printed.

1 Press the MENU key.

2 Press the  or  key repeatedly until Others > appears.

3 Press the > key.

4 Press the  or  key repeatedly until Auto Continue > appears. 

5 Press the ENTER key. A blinking question mark (?) appears.

6 Select On or Off using the  or  key.

7 Press the ENTER key.

8 Press the MENU key. The message display returns to Ready.

>Auto Continue >
Mode

MENU

Others         >

?

>Auto Continue >
 Mode   On

ENTER >Auto Continue >
 Mode ? On

ENTER

MENU
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Setting the Auto Continue Recovery Time

Follow the procedure given below to change the recovery time for Auto 
Continue.

1 Press the MENU key.

2 Press the  or  key repeatedly until Others > appears.

3 Press the > key.

4 Press the  or  key repeatedly until Auto Continue Mode > 
appears. 

5 Press the > key and display >>Auto Continue Timer.

6 Press the ENTER key. A blinking cursor (   ) appears.

MENU

Others         >

?

>Auto Continue >
 Mode   On

ENTER >>Auto Continue 
 Timer   000Sec.
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7 Press the  or  key to increase or decrease the value of the figure 
where the cursor is blinking and set the desired time. The time must 
be set between 000 and 495 seconds, in 5-second increments. If set to 
000, printing will be continued immediately without allowing any 
time interval. You can use the > and < keys to move the cursor right 
and left.

If you want to abandon the setting procedure, press the CANCEL 
key.

8 Display the desired time and press the ENTER key.

9 Press the MENU key. The message display returns to Ready.

ENTER

MENU
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Service Menu

The service menu contains maintenance operations to be performed by 
service personnel. The Print Status Page, Toner ID, Developer, and 
Drum menus appear; however, in general, you will only need to use the 
Print Status Page and Toner ID menus.

Printing the Service Status Page

The service status page contains printer settings information that is more 
detailed than the standard status page and is therefore for mostly service 
purposes. However, since there is a great deal of information available on 
the service status page that may be helpful to you, the procedure for 
printing it out is given below.

1 Press the MENU key.

2 Press the  or  key repeatedly until Others > appears.

3 Press the > key.

4 Press the  or  key repeatedly until >Service > appears. 

5 Press the > key.

6 Press the  or  key repeatedly until >>Print Status Page 
appears. 

>Service       >

MENU

Others         >

?

>Service       >

?

>>Print 
 Status Page
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7 Press the ENTER key. A question mark (?) appears.

8 Press the ENTER key. The message display indicates Processing 
and printing starts.

9 Press the MENU key. The message display returns to Ready.

ENTER >>Print 
 Status Page ?

ENTER

MENU
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Setting the Toner ID

If the type of the toner kit (TK-60 [20,000 pages] or TK-60E [10,000 pages]) 
was changed, set the toner ID as follows so that on accurate toner gauge 
measurement is indicated on the status page. The default setting is CA 
(TK-60).

Also refer to the User's Manual supplied with the toner kit when 
replacing the toner container.

1 Press the MENU key.

2 Press the  or  key repeatedly until Others > appears.

3 Press the > key. 

4 Press the  or  key repeatedly until >Service > appears. 

5 Press the > key. 

6 Press the  or  key repeatedly until >>Toner ID appears.

>>Toner ID

MENU

Others         >

?

>Service       >

?

>>Toner ID
  ##
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7 Press the ENTER key.

8 Press the  or  key and display CA for the TK-60 or BA for the TK-
60E in place of ##. The factory default setting is CA (TK-60). 

9 Press the ENTER key.

10 Press the MENU key. The message display returns to Ready.

ENTER

>>Toner ID
  ##

ENTER

MENU
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Chapter 2 Maintenance
2

This chapter explains how to replace the toner container and how to clean parts such as the 
registration roller and charger wire.

This chapter explains the following topics:

� Toner Container Replacement
� Waste Toner Bottle Replacement
� Cleaning
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Toner Container Replacement
2.1 Toner Container Replacement

The toner container in the printer should be replaced as soon as the 
message display shows Toner low TK-60 or soon after. If you continue to 
use the printer, eventually the toner supply will be exhausted at which 
point the printer will stop printing and the Replace toner Clean 
printer message will be shown instructing you to install a new toner kit.

2.1.1 Toner Container Replacement Interval

Assuming an average toner coverage of 5% and Ecoprint mode turned off, 
the toner container will need replacing approximately once every 20,000 
pages.*

* For a new printer with a toner kit installed for the first time, the 
number of copies that can be printed will be approximately 10,000.

Toner Kits to be Used
Name: TK-60 (20,000 pages)/TK-60E (10,000 pages)
Contents: Toner container

Waste toner bottle
Wiper cloth
Grid cleaner
2 plastic bags (for disposal of the old toner container and 
waste toner bottle)
User's manual

� Be sure to distance items such as floppy disks during toner container 
replacement.

� Be sure to clean the inside of the printer when replacing the toner 
container. For details, see section 2.3 Cleaning on page 2-9.

� Use of original Kyocera Mita toner kits is highly recommended to 
prevent printer trouble and ensure the long life of the printer.

Note
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Toner Container Replacement
2.1.2 Replenishing Toner

1 Open the printer top cover all the way.

2 Pull the lock lever (green colored) to the right and gently lift the old 
toner container.

Keep the toner container as level as possible while removing.

3 Put the old toner container in the plastic bag supplied with the toner 
kit and dispose of it.

The old toner container may be incinerated without the risk of generating 
harmful gas.

Top Cover

Lock Lever 

Note

Old Toner Container

Note
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4 Take the new toner container from the bag.

5 With the label side down, thoroughly shake the toner container (in 
the direction of the arrows) ten times or more. This ensures that the 
toner is evenly distributed inside. 

6 Carefully remove the protective seal (orange colored). 

7 Install the toner container into the printer.

New Toner Container

10 times or 
more

Protective Seal
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8 Push firmly on the top of the toner container at the positions marked 
PUSH HERE.

When the toner container fits into place, it will lock with a clicking 
sound.

9 Close the top cover.

It is necessary to clean the inside of the printer after replacing the toner 
container. If the toner container is replaced when Replace toner 
Clean printer is displayed, Clean printer Press GO will appear 
after replacement. After cleaning the inside of the printer (see section 2.3 
Cleaning on page 2-9), the message will disappear when the GO key is 
pressed, and the printer will be ready for printing.

Note
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Waste Toner Bottle Replacement
2.2 Waste Toner Bottle Replacement

2.2.1 Replacing the Waste Toner Bottle

When replacing the toner container, the used waste toner bottle in the 
printer should also be replaced with the new one from the new toner kit.

1 Open the side cover on the left side of the printer.

2 While holding the waste toner bottle, press the lock lever and then 
gently remove the waste toner bottle.

Remove the waste toner bottle as gently as possible so as not to scatter 
the toner inside. Do not let the opening of the waste toner bottle face 
downward.

Note

Side Cover
Old Waste 
Toner Bottle

Lock Lever

Note
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Waste Toner Bottle Replacement
3 Cap the waste toner bottle after removing from the printer.

4 To avoid toner spilling, place the capped waste toner bottle in the 
plastic bag supplied before proper disposal.

5 Open the cap of the new waste toner bottle.

Cap

Old Waste 
Toner Bottle

Plastic Bag

Cap

New Waste 
Toner Bottle
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Waste Toner Bottle Replacement
6 Insert the new waste toner bottle as shown in the figure below. The 
bottle will be locked when it fits into place.

7 Ensure that it is correctly inserted and close the side cover.

The printer parts must be cleaned when replacing the toner 
container. See section 2.3 Cleaning on page 2-9.

8 When replacement of the toner container and waste toner bottle is 
completed, set the toner ID (see Setting the Toner ID on page 
1-132). If you replaced the toner container when Replace toner 
Clean printer was not displayed, reset the remaining toner 
counter (see Resetting the Remaining Toner Counter on page 
1-113).

New Waste Toner 
Bottle
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2.3 Cleaning

To avoid print quality problems, the following printer parts must be 
cleaned with every toner container replacement. In addition, the charger 
wire and paper feed unit should be cleaned from time to time, or whenever 
print quality problems occur.

If the toner container was replaced when Replace toner Clean 
printer was displayed, Clean printer Press GO will appear after 
replacement. After cleaning the inside of the printer following the 
procedure shown below, press the GO key; the message will disappear 
and the printer will be ready for printing.

2.3.1 Cleaning the Charger Wire

The charger wire is a part in the drum unit that needs to be periodically 
cleaned. You can clean the charger wire by pulling the cleaning knob as 
instructed below.

1 Open the side cover on the left side of the printer.

2 Pull the cleaning knob (green colored) slowly in and out a few times. 
This cleans charger wire inside the printer. 

Note

Side Cover Charger Unit

Cleaning Knob 
(Green)
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2.3.2 Cleaning the Charger Grid

The charger grid is a part located at the bottom of the charger unit, which 
also needs to be cleaned. You should use a grid cleaner attaching it to the 
printer and pull out the charger unit as instructed below.

1 Take the grid cleaner from protective bag in the new toner kit, and 
remove the cap. 

The grid cleaner pad is supplied with water soaked. Perform the 
following procedure before the pad dries.

2 Attach the grid cleaner to the printer with the pad at the top, as 
shown in the figure. 

Protective Bag
Cap

Grid Cleaner

Note

Grid Cleaner
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3 Slowly pull out and then push back in the charger unit at least 5 
times. It is easier to pull out the charger unit for the first time if it is 
raised slightly, as shown in the figure.

This cleans grid part underneath the charger unit. 

4 Remove the grid cleaner from the printer and dispose of it. The grid 
cleaner is not re-usable. 

Charger Unit

(1)

(2)

(3)
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5 After cleaning the charger wire and grid, push the charger unit all 
the way in and close the side cover. 

2.3.3 Paper Feed Unit

To avoid print quality problems due to paper dust and debris, clean the 
paper feed unit in the following manner.

1 While pulling the paper feed unit release lever, pull out the paper 
feed unit. 

Paper Feed 
Unit

Paper Feed Unit Release Lever
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2 Wipe away the paper dust on the registration roller and the paper 
ramp using the wiper cloth included in the toner kit. 

Be careful not to touch the transfer roller (the black roller) during 
cleaning as this may adversely affect print quality.

Paper Ramp

Transfer Roller [Black]
See Note below.

Registration Roller [Metal]

Paper Feed Unit

Wiper Cloth

Note
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Chapter 3 Troubleshooting
3

This chapter explains how to handle printer problems that may occur. If a problem cannot be 
corrected, contact your Kyocera Mita dealer.

This chapter explains the following topics:

� General Guide
� Print Quality Problems
� Indicators and Messages
� Correcting a Paper Jam
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General Guide
3.1 General Guide

There are quite a few printer problems that you can deal with by yourself. This section explains how to 
correct these problems. Therefore, if some kind of problem should occur, check the following before 
concluding the printer is broken.

If you still cannot correct a printer problem even after checking the above, please contact your Kyocera 
Mita dealer.

Symptom Check Items Corrective Action

The printer will not 
print from the 
computer.

Check the READY   
indicator.

Off Look through the items below and check 
anything that seems appropriate.

Flashing An error has occurred. For details on error 
warnings and remedies, see 3.3.1 Indicators 
on page 3-6.

Lit See the appropriate item below.

Check the ATTENTION 
indicator.

Flashing See 3.3.1 Indicators on page 3-6

Lit

A maintenance message appears in the 
message display.

See 3.3.2 Maintenance Messages on page 
3-7

Print quality is not good. See 3.2 Print Quality Problems on page 3-3.

Paper is jammed. See 3.4 Correcting a Paper Jam on page 
3-12.

Nothing lights on the 
operator panel even 
when power is turned 
on and the fan makes 
no noise.

Check that the power cord is properly 
plugged into the power outlet.

Turn off the printer's power, plug in the power 
cord securely, and try turning on the printer's 
power again.

Check that the power switch is really in the ON ( ❘ ) position.

The printer prints a 
status page, but data 
from the computer is 
not being printed 
normally.

Check the interface cable. Connect both ends of the interface cable 
securely. Try replacing the printer cable. For 
details on the parallel interface for this 
printer, see Appendix C.

Check program files and application 
software.

Try printing another file or using another 
print command. If the problem occurs only 
with a specific file or application, check the 
printer settings for that application.
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Print Quality Problems
3.2 Print Quality Problems

As the following table shows, there are many possible causes of print quality problems, such as blank 
output as. The troubleshooting procedure for each type of problem is explained below. If you still can not 
solve the problem, contact your Kyocera Mita dealer.

Printed Results Corrective Action

Completely blank printout Check the developer unit.
Open the printer top cover and check that the developer 
unit is inserted correctly and check that the developer's 
connector is connected properly.

Check the toner container.
Open the printer top cover and check that the toner 
container is correctly installed in the printer. See 2.1 
Toner Container Replacement on page 2-2.

All-black printout Check the charger unit.
Open the printer side cover and check that the charger 
unit is correctly installed.

Dropouts, horizontal streaks, stray dots Clean the charger wire.
Open the printer side cover. Pull the cleaning knob 
(green colored) slowly in and out a few times. See 2.3 
Cleaning on page 2-9.

(Continued on next page)
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Black or white vertical streaks Check the operator panel.
If the Toner low TK-60 message is displayed and the 
ATTENTION indicator is flashing, install a new toner kit. 
See 2.1 Toner Container Replacement on page 2-2.

Clean the charger wire.
Open the printer side cover. Pull the cleaning knob 
(green colored) slowly in and out a few times. See 2.3 
Cleaning on page 2-9.

Faint or blurred printing Check the Ecoprint setting. 
When this setting is On, switch it to Off on the Operator 
Panel. (See Ecoprint on page 1-72)

Check the operator panel.
� If the Toner low TK-60 message is displayed and 

the  ATTENTION indicator is flashing, install a new 
toner kit. See 2.1 Toner Container Replacement 
on page 2-2.

� Set the print density from the operator panel to a 
higher level than the current setting. See 
Adjusting the Print Density on page 1-75.

� Make sure the paper type setting is correct. See 4.3 
Paper Type on page 4-11

Clean the charger wire.
Open the printer side cover. Pull the cleaning knob 
(green colored) slowly in and out a few times. See 2.3 
Cleaning on page 2-9

Grey background. Check the operator panel.
If the Toner low TK-60 message is displayed and the 
ATTENTION indicator is flashing, install a new toner kit. 
See 2.1 Toner Container Replacement on page 2-2.

Check the print density.
Display the print density menu from the operator panel 
and select a lighter density setting. See Adjusting the 
Print Density on page 1-75.

Clean the charger wire.
Open the printer's side cover. Pull the cleaning knob 
(green colored) slowly in and out a few times. See 2.1 
Toner Container Replacement on page 2-2.

Check the charger unit installation.
Open the printer side cover and check that the charger 
unit is correctly installed and seated as far as it will go. 
See 2.3 Cleaning on page 2-9.

(Continued on next page)

Printed Results Corrective Action
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Dirt on the top edge or back of the paper Check the paper chute and the ramp.
Pull out the paper feed unit and check for toner on the 
paper ramp. Clean the paper ramp using a soft, dry, lint-
free cloth. See 2.3 Cleaning on page 2-9.

Check the transfer roller.
If the transfer roller is dirty with toner, try printing 
several pages.

Characters out of position. Check the file or program.
Check whether the problem is being caused by a 
PRESCRIBE 2e command error. If the problem occurs 
only with a specific file or program, the most likely cause 
is an error in a parameter to a command or command 
syntax.

Printed Results Corrective Action
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Indicators and Messages
3.3 Indicators and Messages

The tables on the following pages indicate how to respond to problems 
indicated by the operator panel indicators and messages.

3.3.1 Indicators

Indicator Name Condition Description

Ready 
indicator

Flashing An error occurs that you can clear by yourself.

Lit The printer is on-line. The printer is ready to print.

Off
The printer is off-line. The printer stores but does not print received 
data. Also indicates when printing is automatically stopped due to 
occurrence of an error.

Data 
indicator

Flashing Data transfer is taking place.

Lit
Either data is being processed, or data is being written onto the 
option CompactFlash card or Microdrive.

Attention 
indicator

Flashing
The printer needs maintenance attention or the printer is warming 
up (Please wait). 

Lit
A problem or an error occurs that you can clear by yourself. (For 
example, a paper jam occurs.)

Off Operations are normal.

READY

DATA

ATTENTION
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3.3.2 Maintenance Messages

The following table lists maintenance messages that you can deal with by yourself. If Call service 
person appears, turn off the printer, disconnect the power cord, and contact your Kyocera Mita dealer. 

Message Corrective Action

Add paper (paper source) The paper has run out. Supply paper according to the paper source displayed (paper 
cassette, MP tray, or optional paper feeder).
Messages indicating the printer status (Ready, Please wait, Processing*, 
Waiting, and FormFeed Time Out*) are displayed alternately.
* These messages will not appear if the number of copies is set to 2 or more.

Call service
personAn:0123456

Fuser error (n=0, 1, 2, ...)-Call a service person. The printer does not operate when a 
code beginning with A is displayed. The total number of pages printed is also 
indicated.

Call service
personBn:0123456

Option paper feeder's error (n=0, 1, 2, ...)-Call a service person. The printer does not 
operate when a code beginning with B is displayed. The total number of pages printed 
is also indicated.

Call service
personCn:0123456

Communication error with the option unit (n=0, 1, 2, ...)-Call a service person. The 
printer does not operate when a message beginning with C is displayed. The total 
number of pages printed is also indicated.

Call service
personEn:0123456

Mechanical error (n=0, 1, 2, ...)-Call a service person. The printer does not operate 
when a code beginning with E is displayed. The total number of pages printed is also 
indicated.

Call service
person Fn

Controller error (n=0, 1, 2, ...)-Call a service person. The printer does not operate 
when a code beginning with F is displayed.

Check waste
toner bottle

The waste toner bottle is not installed. After installing the waste toner bottle, you 
should be able to print. Replace the old waste toner bottle with the new one which is 
included in the TK-60/TK-60E toner kit. The message will also be shown if the waste 
toner bottle has become full. The waste toner bottle should be replaced when the 
message display eventually shows Toner low TK-60. See 2.1 Toner Container 
Replacement on page 2-2.

Clean printer 
Press GO

Please clean the inside of the printer. See 2.3 Cleaning on page 2-9.
This message will be displayed when replacing the toner container after the message 
Replace toner TK-60 is displayed. After cleaning the inside of the printer, press 
the GO key and the printer will be ready for printing.
If Auto Continue is set to On, printing will be automatically resumed after a preset 
period of time.

Duplexer 
rear cover open

Open the option duplexer rear cover, then close tightly.

Face-down tray 
paper full

The face-down output tray has become full (approx. 250 pages). You must remove all 
printed pages from the face-down output tray. When the printer senses that the face-
down output tray is empty again, it will continues printing into the face-down output 
tray.

:Alarm buzzer sounds when an error occurs. Press the CANCEL key to stop the alarm buzzer.

(Continued on next page)

!"

!"
!"
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Load Cassette #
(paper size)/(paper type)*

*(paper size) and (paper 
type) are displayed flashing 
alternately.

There is data for printing that matches with a paper cassette setting (paper size, 
paper type), but there is no paper in the paper cassette.
Set paper into the paper source as displayed on the operator panel, and press the
GO key to restart printing. However, the paper source number (#) is only displayed 
when there is an option paper feeder installed.

Or, if you want to print from a different paper source press the  or  key to display 
Use alternative? and you can change the source for paper feeding.

After selecting a paper source and pressing the MENU key, Paper Handling > 
appears. By pressing the > key, the paper type settings menu appears. After setting 
the correct paper type, press the ENTER key and printing starts.

Load MP tray
(paper size)/(paper type)

*(paper size) and (paper 
type) are displayed flashing 
alternately.

There is no paper cassette set (paper size, paper type) that matches with the data for 
printing, so printing is done from the MP tray. Set paper into the MP tray that 
matches the paper size and type shown on the display and press the GO key to restart 
printing.

Or, if you want to print from a different paper source press the  or  key to display 
Use alternative? and you can change the source for paper feeding.

After selecting a paper source and pressing the MENU key, Paper Handling > 
appears. By pressing the > key, the paper type settings menu appears. After setting 
the correct paper type, press the ENTER key and printing starts.

Missing 
duplex drawer

The duplex drawer is either not installed or incorrectly inserted. Insert the duplex 
drawer securely.

Opt.Stacker unit 
rear cover open

Open the sorter rear cover, then close tightly.

Option interface 
Error

A failure has occurred with the option network interface card.
Check the option interface installed in the printer.

Option tray   ##
paper full

The sorter tray indicated by # is now full. Remove some of the paper from the sorter 
tray concerned.

Paper feed unit 
open

Open the paper feed unit, then close tightly.

Paper jam
###############

Open the top cover or the paper feed unit and correct the paper jam (or paper mis-
feeding in the paper cassette). The location of the paper jam is also indicated in place 
of the #'s. Online help messages which are useful for correcting the paper jam will be 
displayed by pressing the  key. (See 3.4 Correcting a Paper Jam on page 3-12)

Remove paper 
option tray   ##

There is still paper in the option sorter's tray indicated by # when the power was 
turned on or the sorter's mode was switched. Remove all the paper inside the sorter.

Replace toner 
Clean printer

Replace the toner container using a new toner kit. The printer does not operate when 
this message is displayed. See 2.1 Toner Container Replacement on page 2-2.

Side cover 
open

Open the side cover, then close tightly.

:Alarm buzzer sounds when an error occurs. Press the CANCEL key to stop the alarm buzzer.

(Continued on next page)

Message Corrective Action

!"

!"
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!"
3-8



Indicators and Messages
Toner low 
TK-60

Replace the toner container using a new toner kit. See 2.1 Toner Container 
Replacement on page 2-2.

Top cover 
open

Open the top cover, then close tightly.

Warning 
image adapt

Printing job cannot be done in current resolution because there is not enough 
internal memory. Try adding more memory or changing resolution. See Appendix B.

Warning 
Low memory

The printer's internal memory is running low due to the number of fonts and macros 
downloaded. Print a status page to see how much user memory is left, and try 
deleting unnecessary fonts and macros. See Appendix B.

Message Corrective Action
3-9



Indicators and Messages
3.3.3 Error Messages

The following table lists error messages that can be dealt with by the user. 

Message Corrective Action

File not found
Press GO

VMB: A VMB tray that was specified for output does not contain any jobs, or the VMB 
tray is not being used. Confirm the VMB tray.
If Auto Continue is set to On, printing will be automatically resumed after a preset 
period of time. See Auto Continue Setting on page 1-127.

Format error
Memory card

This message appears when the printer is in the ready state and the CompactFlash 
(memory) card is not formatted, and therefore cannot be read or written. Follow the 
procedure in Formatting on page 1-82 to format the card.

Format error
Hard disk

Initialization (formatting) of the Microdrive is required. Initialize the Microdrive. 
(See Operating the Microdrive (Hard Disk) on page 1-85.)

Hard disk err ##
Press GO

Look at the error code given in place of ## and refer to the corresponding description 
given below.
01: Microdrive format error. If this error recurs even if the power has been turned off 

and then on, reformat the Microdrive.
02: The disk system is not installed. Recheck the requirements for using the system 

and the devices.
04: There is no available Microdrive space. Delete unnecessary files, etc., in order to 

free up space.
05: The specified file does not exist in the Microdrive.
06: There is no memory available to the Microdrive system. Increase the available 

memory.
10: Formatting is not possible because host data is being spooled on the Microdrive.

Wait until the Microdrive is ready, and then format.
85: VMB; Alias error (the alias setting was lost, or the VMB tray corresponding to 

the alias does not exist). Set the alias again.
97: Code job; The number of permanent code job reached the limit value, and no 

more can be saved. Either delete some unnecessary jobs, etc., or increace the 
limit.

99: A print job for the specified ID does not exist in the Microdrive.

I/F occupied This message is displayed when you attempt to use the printer's operator panel to 
change the environmental settings on the interface from which data are presently 
being received.

ID error The ID entered for a private job, or a stored job is not correct. Check the ID that is set 
using the printer driver.

Insert the same
memory card

You have inserted the wrong CompactFlash (memory) card when the Insert again 
message was displayed. Remove the wrong CompactFlash card from the printer's 
CompactFlash card slot and insert the correct CompactFlash card. The printer again 
reads it from the beginning of the data.

KPDL error    ##
Press GO

Current print processing cannot continue. To print out an error report, display > 
Print KPDL errs from the mode select menu, and select On. Press the GO key to 
resume printing. You can abandon printing by the CANCEL key.
If Auto Continue is set to On, printing will be automatically resumed after a preset 
period of time. See Auto Continue Setting on page 1-127.

:Alarm buzzer sounds when an error occurs. Press the CANCEL key to stop the alarm buzzer.

(Continued on next page)
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Memory card err
Insert again

The CompactFlash card is accidentally removed from the printer's memory card slot 
during reading. If you continue reading the memory card, insert the same memory 
card into the slot again. The printer again reads it from the beginning of the data.
Note: We recommend that you follow the reading procedure from the 
beginning to ensure correct reading of the memory card.

Memory overflow
Press GO

The total amount of data received by the printer exceeds the printer's internal 
memory. Try adding more memory (expansion DIMM). Press the GO key to resume 
printing. You can abandon printing by the CANCEL key.
If Auto Continue is set to On, printing will be automatically resumed after a preset 
period of time. See Auto Continue Setting on page 1-127.

MemoryCard err##
Press GO

This message appears when an error occurs during access to the CompactFlash card 
using the PRESCRIBE 2e RWER command or from the printer's operator panel. 
Look at the error code given in place of ## and refer to the corresponding description 
given below.
01: The CompactFlash card does not meet specifications.  This CompactFlash card 

cannot be used by this printer.  Insert a CompactFlash card which can be used by 
this printer.  
(See CompactFlash Card on page D-20.)

02: The CompactFlash card is not installed. Recheck the requirements for using the 
CompactFlash card.

04: The capacity of the CompactFlash card is insufficient. Clean up files.
05: Specified file not on CompactFlash card.
06: No memory for use by CompactFlash card. Expand printer memory.

Paper path error There is no paper cassette in the feeder, or the cassette is not inserted properly. After 
reinserting the paper cassette, you should be able to print. When two or more option 
feeders are installed and the lowest one is selected, the same message will appear if 
any of the upper paper feeder and the printer cassette is improperly installed.

Print overrun
Press GO

The data transferred to the printer was too complex to print on a page. Press the
GO key to resume printing. (The page may break in some pages.) 
You can abandon printing by the CANCEL key.
Note: After this message is displayed, page protect mode will be On. To 
maintain optimum use of memory during printing, display >Page protect 
from the operator panel, and re-select Auto.
See Page Protect Mode on page 1-65.
If Auto Continue is set to On, printing will be automatically resumed after a preset 
period of time. See Auto Continue Setting on page 1-127.

RAM disk error ##
Press GO

Look at the error code given in place of ## and refer to the corresponding description 
given below.
01: Abnormal format. Try turning the power off and on again.
02: RAM disk mode is Off. Turn RAM disk mode On.
04: No disk space. Clean up files.
05: Specified file not on disk.
06: No memory for use by disk system. Expand printer memory.

Virtual mail box
full

The storage area for the VMB is full. Print out accumulated VMB data.

:Alarm buzzer sounds when an error occurs. Press the CANCEL key to stop the alarm buzzer.

Message Corrective Action
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Correcting a Paper Jam
3.4 Correcting a Paper Jam

The Paper jam message is displayed on the message display when paper 
becomes stuck in the paper transport system, the paper feed timing is 
incorrect, or paper fails to feed at all. The jam can be corrected by removing 
the paper.

The printer goes off-line when the Paper jam message is displayed.

When a paper jam occurs, a paper jam message and the paper jam location 
are indicated on the message display. Details of the messages and paper 
jam locations are as follows: 

Paper jam 
message

Paper jam 
location

Description
Reference 
page

Paper jam
Cassette 1 A Paper is jammed at the paper 

cassette or inside the printer. 3-14

Paper jam
Cassette 2 (to 4) B Paper is jammed at the option 

paper feeder's cassette.
3-14

Paper jam
Duplexer C

Paper is jammed inside the rear 
cover of the option duplexer or 
at the duplexer drawer.

3-16

Paper jam
Option Stacker D Paper is jammed at the option 

sorter.
3-18

Paper jam
MP Tray E Paper is jammed at the MP tray. 3-20

D

C

E

A

B
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When the jammed paper has been removed, open and close the printer's 
top cover or the paper feed unit. Then the printer automatically warms up, 
goes on-line, and continues printing. Depending on the point at which the 
jam occurred, the printer may or may not print the jammed page.

If paper jams occur frequently, try using a different type of paper, replace 
with paper from another ream, turn the stack of paper over, or turn the 
paper the other way around. Read the information in Chapter 4. Also, look 
for tiny pieces of paper that may have been torn off and overlooked when 
the jammed paper was removed.

If you cannot solve the problem by changing the paper, there may be a 
problem with the printer. Call a service person.

When pulling the paper, pull it gently so as not to tear it. Torn pieces of 
paper are difficult to remove and may be easily overlooked, deterring the 
jam recovery.

Online help messages
With the online help message function, this printer can display the 
procedure to correct a paper jam on the message display. When a paper jam 
message is displayed, press the  key. The display will show 
Please wait after the jammed paper has been removed.

Pressing the  key at the online help message display shows the next 
step; pressing the  key shows the previous step.

To exit the online help message display, press the  key. The previously 
shown paper jam message appears.

Online help messages that can be displayed when a paper jam occurs and 
their respective corrective actions are given below:

Note

?

?
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3.4.1 Jam at the Paper Cassette or Inside the Printer

Paper is jammed at the paper cassette or inside the printer. Remove the 
jammed paper using the procedure given below.

While the display alternates between the paper jam message and HELP 
START, press the  key. An online help message appears.

A paper jam which has occurred in the paper cassette of the option paper 
feeder (PF-60) installed on the printer can be removed in the same 
manner. Paper cassettes of option paper feeders are indicated as 
Cassette 2, Cassette 3, and Cassette 4.

1 Pull out the paper cassette and remove the jammed paper. 

2 Push the paper cassette back in. While pulling the paper feed unit 
release lever, pull out the paper feed unit. 

?

Paper jam
Cassette 1

-- HELP START --
Press  key?

?

Note

Open
cassette 1 and

pull out paper
feed unit

then remove
the paper jam.

Examples of online help 
messages

Paper Feed 
Unit

Paper Feed Unit Release Lever
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Correcting a Paper Jam
3 If paper is jammed before the registration roller, remove it as shown 
in A. If paper is jammed under the registration roller, remove it as 
shown in B. 

4 Open the rear cover and remove the jammed paper. 

5 Push the paper cassette and paper feed unit back in and close the 
rear cover.

Registration 
Roller Registration 

Roller

A B

Also, remove
the paper jam

from
rear cover.

Rear Cover

Close paper
feed unit.

- HELP END --
Press  Key?

?
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3.4.2 Paper Jam at the Option Duplexer 

Paper is jammed inside the rear cover of the option duplexer or at the 
duplexer drawer. Remove the jammed paper using the procedure given 
below.

While the display alternates between the paper jam message and HELP 
START, press the  key. An online help message appears.

1 Open the rear cover of the duplexer and remove the jammed paper.

2 Pull out the duplex drawer. 

?

Paper jam
Duplexer

-- HELP START --
Press  key?

?

Open duplexer
rear cover and

remove
the paper jam.

Examples of online help 
messages

Rear Cover

Pull out
duplex drawer,

Duplex Drawer
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3 Remove the jammed paper. 

4 Close the rear cover of the duplexer and the duplex drawer.

and remove
the paper jam.

Close
rear cover

and
duplex drawer.

- HELP END --
Press  Key?

?
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3.4.3 Paper Jam at the Option Sorter 

Paper is jammed at the option sorter. Remove the jammed paper using the 
procedure given below.

While the display alternates between the paper jam message and HELP 
START, press the  key. An online help message appears.

1 Open the rear cover of the option sorter. 

2 Remove the jammed paper. If both ends of the paper are inside the 
sorter, turn the paper feed gears in the direction of the arrows. The 
paper can then be removed easily. 

?

Paper jam
Option Stacker

-- HELP START --
Press  key?

?

Open
option stacker

rear cover
and

Examples of online help 
messages

Rear Cover

remove
the paper jam. Paper Feed Gears
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3 Close the rear cover of the option sorter.

Close
rear cover.

- HELP END --
Press  Key?

?
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3.4.4 Jam at the MP Tray

Paper is jammed at the MP tray. Remove the jammed paper using the 
procedure given below.

While the display alternates between the paper jam message and HELP 
START, press the  key. An online help message appears.

1 Remove the paper jammed at the MP tray. 

2 Open and close the top cover (the paper jam error will be reset). 

?

Paper jam
MP tray

-- HELP START --
Press  key?

?

Check the
MP tray and

remove
the paper jam.

Examples of online help 
messages

Open and close
top cover to

release paper
jam error.

- HELP END --
Press  Key?

?
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Chapter 4 Paper Selection
4

This chapter explains the following topics:

� General Guidelines
� Special Paper
� Paper Type
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General Guidelines
4.1 General Guidelines
The printer is designed to print on high-quality copier bond paper (the kind 
used in ordinary dry copier machines), but it can also accept a variety of 
other types of paper within the limits specified below.

The manufacturer assumes no liability for problems that occur when 
paper not satisfying these requirements is used.

Selection of the right paper is important. Using the wrong paper can result 
in paper jams, misfeeding, curling, poor print quality, and paper waste, and 
in extreme cases can damage the printer. The guidelines given below will 
increase the productivity of your office by ensuring efficient, trouble-free 
printing and reducing wear and tear on the printer.

4.1.1 Paper Availability
Most types of paper are compatible with a variety of machines. Paper 
intended for xerographic copiers can also be used with the printer.

There are three general grades of paper: economy, standard, and premium. 
The most significant difference between grades is the ease with which they 
pass through the printer. This is affected by the smoothness, size, and 
moisture content of the paper, and the way in which the paper is cut. The 
higher the grade of paper you use, the less risk there will be of paper jams 
and other problems, and the higher the level of quality your printed output 
will reflect.

Differences between paper from different suppliers can also affect the 
printer's performance. A high-quality printer cannot produce high-quality 
results when the wrong paper is used. Low-priced paper is not economical 
in the long run if it causes printing problems.

Paper in each grade is available in a range of basis weights (defined later). 
The traditional standard weights are 16, 20, and 28 pounds (60 to 105 g/m2).

4.1.2 Paper Specifications
The following table summarizes the basic paper specifications. Details are 
given on the following pages.

Note

Item Specification

Weight Cassette : 60 to 105 g/m2 (16 to 28 lb/ream)
MP tray : 60 to 200 g/m2 (16 to 53 lb/ream)

Thickness 0.086 to 0.110 mm (3.4 to 4.3 mils)

Dimensional accuracy ±0.7 mm (±0.0276 inches)

Squareness of corners 90° ±0.2°

Moisture content 4 to 6 %

Direction of grain Long grain

Pulp content 80 % or more
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4.1.3 Selecting the Right Paper

Laser printing is a process involving laser light, electrostatic discharge, 
toner, and heat. In addition, as the paper passes through the printer it 
undergoes considerable sliding, bending, and twisting motions. A high-
quality printing paper matching the printer's requirements withstands all 
these stresses, enabling the printer to turn out clean, crisp printed copies 
consistently.

Remember that all paper is not the same. Some of the factors to consider 
when selecting paper for the printer are as follows:

Condition of the Paper

Avoid using paper that is bent at the edges, curled, dirty, torn, embossed, or 
contaminated with lint, clay, or paper shreds.

Use of paper in these conditions can lead to illegible printing, misfeeding, 
and paper jams, and can shorten the life of the printer. In particular, avoid 
using paper with a surface coating or other surface treatment. The paper 
should have as smooth and even a surface as possible.

Composition

Do not use paper that has been coated or surface-treated and contains 
plastic or carbon. The heat of fusing can cause such paper to give off 
harmful fumes.

Bond paper should contain at least 80% pulp. Not more than 20% of the 
total paper content should consist of cotton or other fibers.
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General Guidelines
Paper Size

Cassettes and an MP tray are available for the paper sizes listed in the 
table below. The dimensional tolerances are ±0.7 mm (±0.0276 inches) for 
the length and width. The angle at the corners must be 90° ±0.2°.

Smoothness

The paper should have a smooth, uncoated surface. Paper with a rough or 
sandy surface can cause voids in the printed output. Paper that is too 
smooth, however, can cause multiple feeding and fogging problems. 
(Fogging is a gray background effect.)

Basis Weight

Basis weight is the weight of a standard quantity of paper. In the 
traditional system, the standard quantity is a ream consisting of 500 
sheets measuring 17 × 22 inches each. In the metric system the standard 
quantity is 1 square meter.

Paper that is too light or too heavy can cause misfeeding, jams, and 
premature wear of the printer. Uneven paper weight can cause multiple 
feeds, print defects, poor toner fusing, blurring, and other print quality 
problems. The proper weight is 60 to 105 g/m2 for the paper cassette, and 
60 to 200 g/m2 for the MP tray.

Multi-purpose tray Size Cassette or multi-
purpose tray

Size

Monarch 3-7/8 × 7-1/2 inches Legal 8-1/2 × 14 inches

Business 4-1/8 × 9-1/2 inches Letter 8-1/2 × 11 inches

International DL 11 × 22 cm ISO A4 210 × 297 mm

International C5 16.2 × 22.9 cm ISO A5 148 × 210 mm

International B5 17.6 × 25 cm JIS B5 182 × 257 mm

Executive 7-1/4 × 10-1/2 inches Custom 148 to 216 × 210 to 297 mm 
(5-13/16 to 8-1/2 × 8-1/4 to 
14 inches)

Commercial 9 3-7/8 × 8-7/8 inches Other sizes of paper can be fed manually. The minimum 
size paper for manual feed is 80 × 148 mm (3-1/8 × 5-13/
16 inches), fed lengthwise. The maximum size is 216 × 
356 mm (8-1/2 × 14 inches).

Commercial 6-3/4 3-5/8 × 6-1/2 inches

ISO A6 105 × 148 mm

JIS B6 128 × 182 mm

Hagaki 100 × 148 mm

Ofuku-Hagaki 148 × 200 mm
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General Guidelines
Thickness (Caliper)

Thick paper is referred to as high-caliper paper and thin paper as low-
caliper paper. The paper used with the printer should be neither extremely 
thick nor extremely thin. If you are having problems with paper jams, 
multiple feeds, and faint printing, the paper you are using may be too thin. 
If you are having problems with paper jams and blurred printing, the 
paper may be too thick. The proper thickness is 0.086 to 0.110 mm (3.4 to 
4.3 mils).

Moisture Content

Moisture content is defined as the percent ratio of moisture to the dry mass 
of the paper. Moisture can affect the paper's appearance, feedability, curl, 
electrostatic properties, and toner fusing characteristics.

The moisture content of the paper varies with the relative humidity in the 
room. When the relative humidity is high and the paper absorbs moisture, 
the paper edges expand, becoming wavy in appearance. When the relative 
humidity is low and the paper loses moisture, the edges shrink and 
tighten, and print contrast may suffer.

Wavy or tight edges can cause misfeeding and alignment anomalies. The 
moisture content of the paper should be 4 to 6%.

To ensure the proper moisture content, it is important to store the paper in 
a controlled environment. Some tips on moisture control are:

� Store paper in a cool, dry location.

� Keep the paper in its wrapping as long as possible. Rewrap paper that 
is not in use.

� Store paper in its original carton. Place a pallet, etc., under the carton 
to separate it from the floor. 

� After removing paper from storage, let it stand in the same room as the 
printer for 48 hours before use.

� Avoid leaving paper where it is exposed to heat, sunlight, or damp.

Paper Grain

When paper is manufactured, it is cut into sheets with the grain running 
parallel to the length (long grain) or parallel to the width (short grain). 
Short grain paper can cause feeding problems in the printer. All paper used 
in the printer should be long grain.
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General Guidelines
Other Paper Properties

Porosity: Refers to the density of the paper structure; that is, how openly 
or compactly the fibers are bonded.

Stiffness: Limp paper can buckle inside the printer, while paper that is too 
stiff may bind. Either way the result is a paper jam.

Curl: Most paper has a natural tendency to curl in one direction. The 
paper should be loaded so that the natural curl is downward, to counteract 
the upward curl imparted by the printer. Printed sheets will then come out 
flat. Most paper also has a top and bottom surface. Loading instructions 
are usually given on the paper package.

If the paper is considerably curled in one direction, e.g. when the paper 
was used to print on one side, try to roll the paper in the opposite 
direction to counteract the curl. Printed sheets will then come out flat.

Electrostatic properties: During the printing process, the paper is 
electrostatically charged to attract the toner. The paper must be able to 
release this charge so that printed sheets do not cling together in the 
output tray.

Whiteness: The contrast of the printed page depends on the whiteness of 
the paper. Whiter paper provides a sharper, brighter appearance.

Quality control: Uneven sheet size, corners that are not square, ragged 
edges, welded (uncut) sheets, and crushed edges and corners can cause the 
printer to malfunction in various ways. A quality paper supplier should 
take considerable care to ensure that these problems do not occur.

Packaging: Paper should be packed in a sturdy carton to protect it from 
damage during transport. Quality paper obtained from a reputable 
supplier is usually properly packaged.

Note
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Special Paper
4.2 Special Paper
This section explains printing on special paper.  The page printer can use 
the following types of special paper. In this case, set the media type 
according to the table below.

When using the above types of paper, be sure to use products that are 
specified for use with photocopiers and/or page printers. Feed paper other 
than colored paper or pre-printed paper from the MP (multi-purpose) tray.

Use paper that is sold specifically for use with copiers (heat-fusing type). 
Label paper and envelopes should not be placed in the cassette; they must 
be fed manually and delivered in the face up stack. 

Since the composition and quality of special paper vary considerably, 
special paper is more likely than white bond paper to give trouble during 
printing. No liability will be assumed if moisture, etc., given off in printing 
on special paper causes harm to the machine or operator.

Before purchasing any type of special paper, test a sample on the printer 
and check that print quality is satisfactory.

Specifications for each type of special paper are given below.

4.2.1 Transparency (Overhead Projection Film)

Transparency must be able to withstand the heat of fusing during the 
printing process. It should satisfy the conditions given in the table below. 

To avoid trouble, transparency must be delivered face-up.

If transparency jams frequently, pull the top of the sheet very gently as it 
leaves the printer.

Paper type Media type 

Colored paper Color

Preprinted paper Preprinted

Overhead projector transparencies Transparency

Postcards Cardstock

Envelopes Envelope

Label Labels

Note

Item Specification

Tolerance of heat Must tolerate at least 190°C (374°F)

Thickness 0.100 to 0.110 mm (3.9 to 4.3 mils)

Material Polyester

Dimensional accuracy ±0.7 mm (±0.0276 in.)

Squareness of corners 90° ± 0.2°
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Special Paper
4.2.2 Adhesive-Backed Labels

The basic rule for printing on adhesive labels is that the adhesive must 
never come into contact with any part of the printer. Adhesive paper 
sticking to the drum or rollers will damage the printer.

Label paper must be manually fed.

Label paper has a structure comprised of three layers, as shown in the 
figure below. The top sheet is printed on. The adhesive layer consists of 
pressure-sensitive adhesives. The carrier sheet (also called the linear or 
backing sheet) holds the labels until use. Due to the complexity of its 
composition, adhesive-backed label paper is particularly likely to give 
trouble in printing.

Adhesive label paper must be entirely covered by its top sheet, with no 
spaces between the individual labels. Labels with spaces in between are 
apt to peel off, causing serious paper jam problems.

Some label paper is manufactured with an extra margin of top sheet 
around the edge. Do not remove the extra top sheet from the carrier sheet 
until after printing is finished.

Top sheet (white bond paper)

Adhesive

Carrier sheet

Top sheet

UnacceptableAcceptable

Carrier sheet
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Special Paper
The table below lists the specifications for adhesive label paper.

Envelopes

The printer can print on envelopes using paper with a basis weight of 60 to 
79 g/m2 (16 to 21 lb/ream). Envelopes must be manually fed.

An envelope is a more complex object than a single sheet of paper. For this 
reason, it may not be possible to obtain consistent print quality over the 
entire envelope surface.

Many envelopes have a diagonal grain orientation (See Paper Grain on 
page 4-5). This orientation is more likely to wrinkle and crease on its way 
through the printer. Before purchasing envelopes for use with the printer, 
test a sample to verify the envelope's suitability.

Do not use envelopes that have an encapsulated liquid adhesive.

Avoid long printing runs consisting of envelopes only. Extensive envelope 
printing can cause premature printer wear.

To avoid jamming due to curled envelopes, do not leave more than 
approximately 10 printed envelopes stacked in the paper trays during 
multiple envelope printing.

Colored Paper

Colored paper should satisfy the same conditions as white bond paper, 
listed in 4.1.2 Paper Specifications on page 4-2. In addition, the 
pigments used in the paper must be able to withstand the heat of fusing 
during the printing process (up to 200 °C or 392 °F).

Preprinted Paper

Preprinted paper should have a bond paper base. The preprinted ink must 
be able to withstand the heat of fusing during the printing process, and 
must not be affected by silicone oil.

Do not use paper with any kind of surface treatment, such as the type of 
paper commonly used for calendars.

Item Specification

Weight of top sheet 44 to 74 g/m2 (12 to 20 lb/ream)

Composite weight 104 to 151 g/m2 (28 to 40 lb/ream)

Thickness of top sheet 0.086 to 0.107 mm (3.9 to 4.2 mils)

Composite thickness 0.115 to 0.145 mm (4.5 to 5.7 mils)

Moisture content 4 to 6% (composite)
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Special Paper
Recycled Paper

Select recycled paper that meets the same specifications as the white bond 
paper (see 4.1.2 Paper Specifications on page 4-2) except whiteness.

Before purchasing recycled paper, test a sample on the printer and 
check that the print quality is satisfactory.

Note
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Paper Type
4.3 Paper Type

The printer is capable of printing under the optimum setting for the type of 
paper being used.

Setting the paper type for the paper source from the printer's operator 
panel will cause the printer to automatically select the paper source and 
print in the mode best suited to that type of paper. 

A different paper type setting can be made for each paper source including 
the MP tray. Not only can preset paper types be selected, but it is also 
possible for you to define and select customized paper types. See 
Customizing Paper Type on page 1-107.

The following types of paper can be set. 

O: Can be stored     ×: Cannot be stored
* This is a paper type defined and registered by the user. Up to eight types of user settings may 

be defined. For details on Customizing Paper Type on page 1-107.

Paper source

Paper Type

MP 
tray

Paper 
Cassette

Paper 
Weight

Duplex path
(MP tray available 
only in Cassette 
mode)

Plain O O Normal O
Transparency O × Heavy (Thick) ×

Preprinted O O Normal O
Labels O × Normal ×

Bond O O Normal O
Recycled O O Normal O
Vellum O × Light (Thin) ×

Rough O O Normal O
Letterhead O O Normal O
Color O O Normal O
Prepunched O O Normal O
Envelope O × Normal ×

Cardstock O × Heavy ×

Custom 1 (to 8)* O O Normal O
4-11



Appendix A Fonts
A

This appendix explains the types of fonts you can use with the printer. A font is a set of 
characters of a particular design. The design is referred to as a typeface. Several 
characteristics identify a font. These include the code set (For details on the code sets, read 
the Programming Manual on the supplied CD-ROM), spacing, pitch, height, style, stroke 
weight, and typeface family.
A-1



List of Fonts

This section contains a full list of the printer's internal fonts. The printer 
has 80 PCL/PS compatible fonts and a bitmap font for a line printer. You 
can print the same font list from the printer by using the printer's operator 
panel key. To print a list of fonts, refer to Printing a List of Fonts on page 
1-59. 

Font may be downloaded to the printer's memory from a option Compact-
Flash card or Microdrive.

PCL (Scalable and Bitmap) Fonts

Font
number Font samples

0

1

2

3

4

5

6

7

8

9

10

11

12

13

14

15

16

17

18

19

20

21

22

23

24

25

26

27
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Font
number Font samples

28

29

30

31

32

33

34

35

36

37

38

39

40

41

42

43

44

45

46

47

48

49

50

51

52

53

54

55

56

57

58

59

60

61

62

63

64

65

66

67
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Font
number Font samples

68

69

70

71

72

73

74

75

76

77

78

79

80
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KPDL Fonts (1)
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KPDL Fonts (2)
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Appendix B Expansion Memory 
B

This appendix explains how to expand the printer's memory. Expanded printer memory 
enables you to print more complex pages, download more fonts, and define more macros.
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Expanding the Printer Memory
B.1 Expanding the Printer Memory

This section explains how to expand the printer's memory. Expanded 
printer memory enables you to print more complex pages, download more 
fonts, and define more macros.

This section first explains how to remove the main circuit board and then 
how to install a DIMM (Dual In-line Memory Module) on the main circuit 
board.

The FS-1800/FS-1800N comes supplied with 8 MB of memory installed, 
and the FS-3800/FS-3800N comes with 16 MB of memory installed. Two 
sockets are provided for expanding the printer memory to allow more 
complex printing jobs and increase the printing speed. By installing 
DIMMs into your printer, the memory in the FS-1800/FS-1800N can be 
increased to a maximum of 264 MB, and that in the FS-3800/FS-3800N can 
be increased to a maximum of 272 MB.

The expansion memory should be installed only by a Kyocera Mita 
authorized dealer or Kyocera Mita certified technician. Kyocera Mita shall 
not be liable for damage due to improper installation of the expansion 
memory.

The minimum memory requirements for the printer with various options 
installed are listed in the table below. Please refer to this table when 
expanding the printer's memory.

Note

Printing condition

Resolution

300 dpi 600 dpi
1200 dpi

Fast mode Fine mode

PCL6, duplex mode = None 8 MB 8 MB 8 MB 8 MB

PCL6, duplex mode = On 8 MB 8 MB 8 MB 16 MB

KPDL, duplex mode = None 8 MB 8 MB 8 MB 8 MB

KPDL, duplex mode = On 8 MB 8 MB 16 MB 16 MB

PCL6/KPDL resource 
protection,
duplex mode = None

� 16 MB 16 MB 16 MB

PCL6/KPDL, resource 
protection,
duplex mode = On

� 16 MB 16 MB 16 MB
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Expanding the Printer Memory
Removing the Main Circuit Board

The main circuit board of the printer is equipped with two sockets for 
memory expansion. Expansion memory is available in the form of DIMMs.

The following instructions are intended for the technician only.

Notes on Handling the Main Circuit Board and DIMM

Protect the electronics by taking these precautions:

� Before touching the main circuit board and DIMM, touch a water pipe 
or other large metal object to discharge yourself of static electricity. 
While doing the work, it is recommended that you wear an antistatic 
wrist strap.

� Touch the main circuit board and DIMM only at the edges.

Removing the Main Circuit Board from the Printer

Be sure to remove the CompactFlash Card (memory card) first if inserted 
in the printer's card slot.

Remove the main circuit board completely from the printer as follows:

1 Turn the printer off and unplug its power cord. Disconnect the 
printer from the host computer. 

Note

YESYESYESYES NONONONO

Note
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Expanding the Printer Memory
2 Remove the two screws from the printer's rear panel.

3 Pull the main circuit board all the way out of the printer.

Before pulling the main circuit board out, clear away the area, behind the 
printer. Foreign objects, accidentally sticking to the back of the main 
circuit board, can cause serious damage to the printer.

Install the DIMM as described on the following page.

Screws

DIMM Socket

Note
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Expanding the Printer Memory
DIMMs to be used

See your Kyocera Mita dealer for purchasing information of the DIMMs 
that are best suited for use with this printer.

16 MB, 32 MB, 64 MB, and 128 MB DIMMs can be used for memory 
expansion.

Installing and Removing the DIMM

Installing DIMMs

Insert the DIMM into the socket as shown below.

1 Remove the DIMM from its package.

2 Open the clips on both ends of the DIMM socket.

3 Insert the DIMM into the socket, so that the notches on the DIMM 
align with the corresponding protusions in the socket.

4 Close the clips of the DIMM socket to secure the DIMM.

5 When you finish installing the DIMM, reinsert the main circuit 
board into the printer by reversing the removal procedure.

DIMM

Clip

Clip

Socket
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Expanding the Printer Memory
Removing DIMM

To remove a DIMM, carefully pull the end clips outwards, then pull the 
DIMM out of the socket.

Return the main circuit board to the printer by reversing the procedure 
explained in  Removing the Main Circuit Board from the Printer.

Testing the Expansion Memory

After you finish installing DIMMs in the printer, test the printer to see if 
the installation was successful.

To test the expansion memory, proceed as follows:

1 Make sure printer is turned off. Plug the power cord into the printer 
and turn the printer on.

2 Press the MENU key on the operator panel.

3 Press the  or  key repeatedly until Print Status Page 
appears.

4 Press the ENTER key twice.

5 If the installation was successful, the amount of memory shown on 
the status page will correspond with the amount of expanded 
memory. (The factory installed memory size is 8 MB for the FS-1800/
FS-1800N and 16 MB for the FS-3800/FS-3800N.)
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Appendix C Host Computer 
Interface
C

This appendix explains the signals used in the printer's parallel and RS-232C interfaces. It 
also lists pin assignments, signal functions, timings, connector specifications, and voltage 
levels. The RS-232C protocols are also covered. Finally, it explains how to use the printer in 
a multi-computer environment.

This appendix explains the following topics:

� Parallel Interface
� Serial Interface
� RS-232C Protocol
� RS-232C Cable Connection
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Parallel Interface
C.1 Parallel Interface

C.1.1 Parallel Interface Communication Modes

The printer features fast data transmission with the parallel interface. The 
parallel interface mode can be activated from the operator panel. 
See Changing Parallel Interface Modes on page 1-40.

Use a parallel printer cable that complies with the IEEE1284 standard.

Nibble (high) [default]
High speed data communication is used in compliance with the IEEE1284 
standard. Ordinarily, you should leave this setting unchanged.

Auto
The printer automatically changes its communication mode to the one the 
host computer is currently using.

Normal
The printer uses the standard communication method prescribed for 
Centronics interfaces.

High-speed
This mode enables faster data transmission between the printer and the 
host computer.
(Select this mode if printing problems occur when the printer is connected 
to a workstation.)

C.1.2 Interface Signals

The pins of the parallel interface connector carry the signals listed in the 
table in Parallel Connector Pin Assignment on page C-3. Asterisks in 
the table indicate signals that are active low. The table also indicates 
whether each signal is incoming or outgoing with respect to the printer.

Note
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Parallel Interface
Parallel Connector Pin Assignment 

[ ]: Signal names in the Auto mode and Nibble (high) mode (IEEE1284). In the Auto mode and 
Nibble (high) mode, these signals are bi-directional.

Pin In/out Description

1 In Strobe* [nStrobe]

2 In/Out Data 0 [Data 1]

3 In/Out Data 1 [Data 2]

4 In/Out Data 2 [Data 3]

5 In/Out Data 3 [Data 4]

6 In/Out Data 4 [Data 5]

7 In/Out Data 5 [Data 6]

8 In/Out Data 6 [Data 7]

9 In/Out Data 7 [Data 8]

10 Out Acknowledge* [nAck]

11 Out Busy [Busy]

12 Out Paper Empty [PError], returns paper empty status if FRPO 
O2=2

13 Out Select (Online) [nSelect], returns off-line status if FRPO 
O2=2

14 In Auto-feed [nAutoFd]

15 - Not connected

16 - 0 V DC

17 - Chassis GND

18 - +5 V DC

19 - Ground

20 - Ground

21 - Ground

22 - Ground

23 - Ground

24 - Ground

25 - Ground

26 - Ground

27 - Ground

28 - Ground

29 - Ground

30 - Ground

31 In Ignored [nInit]

32 Out Error*, returns error status if FRPO O2=2 [nFault]

33 - Not connected

34 - Not connected

35 Out Power Ready

36 In Ignored In [nSelectIn]
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Parallel Interface
Detailed descriptions of the signals follow.

Strobe* [nStrobe] (Pin 1)
A negative-going Strobe* pulse causes the printer to read and latch the 
data on the Data 0 [1] to Data 7 [8] signal lines.

Data 0 [1] to Data 7 [8] (Pins 2 to 9)
These eight signals form the data byte sent from the host computer to the 
printer. Data 7 [8] is the most significant bit.

Acknowledge* [nAck] (Pin 10)
This negative-going pulse acknowledges the previous character received by 
the printer.

Busy [Busy] (Pin 11)
This signal is high when the printer is busy and low when it is able to 
accept more data.

Paper Empty [PError] (Pin 12)
This signal goes high when the printer has received a print job and run out 
of paper.

Select [Online] (Pin 13)
This signal is high when the printer is online and low when the printer is 
offline. It goes low when the GO key is pressed to set the printer offline.

+5 V DC (Pin 18)
This line is connected to the printer's +5 V DC line (+5 V ±0.5 V, maximum 
400 mA, fused).

Error* [nFault] (Pin 32)
When the high-speed parallel line control is on (FRPO O2=2), this line 
returns error status.

Power Ready (Pin 35)
This signal is high when the printer is turned on.

The Paper Empty, Online, and Error signals are not used unless enabled 
by the FRPO command (O2 parameter).

Note
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Serial Interface
C.2 Serial Interface

C.2.1 Interface Signals

The pins of the printer's RS-232C interface connector carry the signals 
listed in the table below. The table also indicates whether each signal is 
incoming or outgoing with respect to the printer.

RS-232C Signal Pin Assignment

Brief descriptions of the signals follow.

FG - Frame Ground - (Pin 1)
This pin is connected directly to the printer frame.

TXD - Transmit Data - (Pin 2)
This output carries asynchronous data sent by the printer to the computer. 
It is used mainly in handshaking protocols.

RXD - Receive Data - (Pin 3)
This input carries serial asynchronous data sent by the computer to the 
printer.

RTS - Request To Send - (Pin 4)
This output is always held high (above 3 volts).

CTS - Clear To Send - (Pin 5)
DSR - Data Set Ready - (Pin 6)
Unused.

SG - Signal Ground - (Pin 7)
All signals can transmit between the printer and the host computer to send 
each signal with a signal ground.

Pin In/out Signal Description

1 - FG Frame ground

2 Out TXD Transmit Data

3 In RXD Receive Data

4 Out RTS Request To Send

5 In CTS Clear To Send

6 In DSR Data Set Ready

7 - SG Signal Ground

20 Out DTR Data Terminal Ready
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Serial Interface
DTR - Data Terminal Ready - (Pin 20)
This output is used as a buffer nearly-full handshake line. It is held high 
(above 3 volts) when the buffer can accept more data.

RS-232C Interface Voltage Levels
The voltage levels of the interface signals conform to EIA RS-232C 
specifications. SPACE is from 3 volts to 15 volts. MARK is from �3 volts to 
�15 volts. Voltages between �3 volts and 3 volts are undefined.

SERIAL Connector
The connector marked IOIOI (RS-232C) on the rear panel is a DB-25S 
connector. Use a DB-25P connector (or equivalent) for the connector on the 
cable.
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RS-232C Protocol
C.3 RS-232C Protocol

A protocol is a set of rules the computer follows in sending data to the 
printer. They are indicated on the status page. Parameters can be changed 
from the operator panel. See Changing Serial Interface Modes on page 
1-42. The parameters and their identification codes are given below.

H1: Baud rate

The factory default setting is 9600 baud.

Some computers may not be compatible with a baud rate of 115200 bps. 
If you set the baud rate to 115200 and communication problems occur, 
lower the baud rate.

H2: Data bits
7 or 8; the factory default setting is 8.

H3: Stop bits
1 or 2; the factory default setting is 1.

H4: Parity

The factory default setting is None (0 on the status printout).

Parameter value Baud rate

12 1200

24 2400

48 4800

96 9600

19 19200

38 38400

57 57600

11 115200

Note

Parameter value Meaning

0 None

1 Odd

2 Even

3 Ignore
C-7



RS-232C Protocol
H5: Protocol logic

The factory default setting is 0.

H6: Buffer nearly-full threshold
This is a percentage from 0 to 99. The factory default setting is 90.

H7: Buffer nearly-empty threshold
This is a percentage from 0 to 99. The factory setting is 70.

The factory default settings of the buffer nearly-full and nearly-empty 
thresholds (H6 and H7) are subject to change without notification.

The gap between the nearly-full and nearly-empty thresholds allows the 
computer to send a fairly large amount of data in a continuous stream.

H8: Received-data buffer size
This is the size of the input buffer, specified in units of 10 Kbytes. The 
factory default setting is 6, meaning 60 Kbytes.

PRESCRIBE 2e FRPO D0 command

The PRESCRIBE 2e FRPO D0 command is provided to allow manipulating 
XON/XOFF when an error has occured on the serial interface. The 
following table summarizes the error status corresponding to different D0 
values. 

Parameter value Meaning

0 Combination of 1 and 3 below

1 DTR, positive logic

2 DTR, negative logic

3 XON/XOFF

4 ETX/ACK

5 XON/XOFF recognized only as protocol

Timing of XON transfer to host 
while Ready or Waiting

Serial interface error

Error not handled Error handled

XON sent every 3 to 5 seconds D0=0 (default) D0=1

XON not sent D0=10 D0=11
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RS-232C Cable Connection
C.4 RS-232C Cable Connection

C.4.1 Preparing an RS-232C Cable

After obtaining an RS-232C cable, check that it is wired correctly, referring 
to the table in RS-232C Signal Pin Assignment on page C-5. If you have 
an IBM communication adapter cable type 1502067, you will have to 
resolder the wiring at the printer end of the cable. The procedure is as 
follows.

1 Remove the plastic cover from the printer end of the cable.

2 Next to each of the wires inside the cable is a bare shield wire. Solder 
all these shield wires together into a single bundle.

3 Using a section of flat wire about 3 mm wide and 15 mm long, 
connect the bundle of shield wires to the metal facing of the 
connector. Check that the solder connections are secure.

4 Desolder wires 2 and 3, then resolder them in crossed configuration. 
Solder wire 2 to pin 3 and wire 3 to pin 2. Cover the solder joints with 
thermofit tube.

5 Cut wires 4, 5, 6, and 20.

6 Solder wires 5 and 6 together and connect them to pin 20. Cover the 
solder joints with thermofit tube. Leave wire 4 unconnected.

7 Tape all remaining loose ends, or seal them with thermofit tube.

8 Attach the plastic cover back on.

C.4.2 Connecting the RS-232C Cable

Check that the power of both the printer and the computer is switched off.

1 Discharge yourself of static electricity by touching a metal object 
such as a doorknob.

2 Plug the printer end of the RS-232C interface cable into the printer's 
RS-232C connector and attach it in place.

3 Plug the other end of the cable into the computer's RS-232C interface 
connector.

4 Turn on the printer.
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RS-232C Cable Connection
5 The printer RS-232C parameters are factory-set to the following 
values:

Baud rate=9600 bps, data bits (character length)=8 bits, stop bits=1, 
parity=none

The two RS-232C protocols are XON/XOFF and DTR. The printer 
performs both of them simultaneously, using positive logic for DTR.

If you are uncertain as to the printer's current parameter settings, 
you can reset them to the values listed above by following the 
procedure explained in Printer Resetting on page 1-123.

6 Set the computer to the same parameters as the printer. On many 
computers this can be done by setting DIP switches before the power 
is turned on. Another method is as follows:

C.4.3 Setting the RS-232C Parameters

Windows 95/98

1 Click on Start button in the Windows 95/98 task bar and align the 
cursor with Settings, then click on Control Panel from among the 
items displayed.

2 The control panel folder opens. Double click on System.

3 System Properties opens. Click on the Device Manager tab, then 
click on the COM port to be used. 

4 Click on Properties button.
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RS-232C Cable Connection
5 The Properties sheet is displayed for the selected COM port. Click on 
the Port Settings tab and set the port properties.

6 After setting the properties, click OK button.

DOS

1 Enter the following commands:

C:\>MODE COM1:96,N,8,1,P
C:\>MODE LPT1:=COM1

2 To test the interface, enter the following:

CTRL P
C:\>DIR
CTRL P

The software settings made using the above procedures are temporary. On 
most computers, permanent settings must be made with DIP switches.

If you want to use a different baud rate or change any of the other RS-232C 
parameters, this can be accomplished from the printer's operator panel. 
See Changing the Interface Parameters on page 1-40.
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Appendix D Option Units
D

This appendix explains how to install each option unit. Also refer to the manuals of the 
respective option units.

This appendix explains the following option units:

� PF-60 Paper Feeder
� DU-60 Duplexer
� SO-60 Sorter
� Face-up Output Tray
� Network Interface Card (Models FS-1800 and FS-3800)
� Microdrive
� CompactFlash Card
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Available Options
D.1 Available Options 

Order o
f 

Installatio
n

1

SO-60 Sorter

Equipped with five trays each with 200 sheets capacity. 
Performs sorting, collating, and mailbox functions. Attaches 
to the top of the printer.

2
Face-up Output Tray

This is a face-up tray. It attaches to the rear of the printer.

3

Network Interface Card

Enables printing from multiple computers via a network. The 
FS-1800N/FS-3800N have this card already installed at the 
factory.

4
DU-60 Duplexer

Performs duplex printing for short edge and long edge 
binding. Attaches to the bottom of the printer.

5

PF-60 Paper Feeder

Holds approximately 500 sheets of A5 to A4/Letter and Legal 
size paper. Up to three paper feeders can be attached to the 
bottom of the printer.

Other Options
� Microdrive (Hard Disk Unit)

Enables the electronic sorting and job retention functions. To 
be inserted into the slot designed for it on the main circuit 
board of the printer. See your dealer for purchasing 
information regarding the Microdrives that are best suited 
for use with this printer.

� CompactFlash Card
This is a microchip card that may contain option fonts, 
macros, and forms. Insert the card into the card slot located 
near the handle on the right of the printer. See your dealer for 
purchasing information regarding the CompactFlash Cards 
that are best suited for use with this printer.

� Paper Cassette (PC-60LG)
Holds A5 to A4/Letter and Legal size paper.

� Memory DIMM
See your dealer for purchasing information of the DIMM that 
are best suited for use with this printer. See Appendix B for 
the installation procedure.

SO-60
Sorter 1

Face-up 
Output Tray2

Network 
Interface Card 
(3.3 V DC)

3

DU-60
Duplexer4

PF-60
Paper Feeder5

Printer

Printer combined with options
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Installing Option Units
D.2 Installing Option Units

D.2.1 PF-60 Paper Feeder

Up to three option paper feeders can be installed below the printer. A paper 
feeder can hold approximately 500 sheets of paper at a time. By using 
option paper feeders in conjunction with the printer paper cassette, which 
can also hold approximately 500 sheets of paper, up to approximately 2,000 
sheets of paper can be fed continuously. The paper cassette of the paper 
feeder can feed Legal size paper.

When installing more than one paper feeder, first stack the paper feeders 
together. 

1 Turn off the printer and disconnect the power cord and printer cable.

2 Gently place the printer on top of the paper feeder(s). 

3 Pull the paper cassette all the way out of the paper feeder.

Note
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Installing Option Units
4 Push down the bottom plate until it locks. 

5 Set the paper size dial to the size of paper to be used. 

6 Adjust the paper guides and paper stopper to the size of paper to be 
used. 

B5 A4
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Installing Option Units
7 Load paper. 

� Do not load more paper than will fit under the load limits on the paper 
guides.

� The  paper cassette will hold approximately 500 sheets of paper with 
a 80 g/m² (21 lb) basis weight, or with a thickness of 0.11 mm. 

8 Set the stack of paper so that it is under the clips as shown in the 
figure. 

9 Insert the paper cassette back in.

Note

Load Limit Load Limit

Clip Clip
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Installing Option Units
D.2.2 DU-60 Duplexer

Install the option duplexer immediately below the printer. By combining 
the two binding modes (short edge bind and long edge bind) with the two 
printing orientations (portrait and landscape), duplex printing is possible 
in four different methods (see Setting Duplex Printing on page 1-101). 
Duplex printing can be specified from the application (printer driver).

1 Remove the nine tapes and the pad from the duplexer. 

2 While pushing the rear cover release lever inward, remove the 
duplexer rear cover. 

3 Turn off the printer and disconnect the power cord and printer cable.
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Installing Option Units
4 Gently place the printer on top of the duplexer. 

5 Connect the printer cable (parallel interface cable, serial interface 
cable or network interface cable) according to your operation 
environment. 

6 Connect the power cord to the printer. 
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Installing Option Units
7 Pass the connected cable and power cord through the opening in the 
duplexer. 

8 Install the duplexer rear cover. 
D-8



Installing Option Units
D.2.3 SO-60 Sorter

Install the option sorter on top of the printer. It is equipped with five sorter 
trays, with a capacity of 200 sheets each. There are three modes in which 
printouts can be received: the sorter mode, the collator mode, and the mail 
box mode (for details about the modes, refer to the Printer Drivers 
Guide).

The following installation procedure explains how to install the sorter 
when the option paper feeder (PF-60) and duplexer (DU-60) have already 
been installed.

1 Unpack the sorter and place it on its side. 

2 Remove the tapes from the sorter. 

3 Unfold the two attachment legs of the sorter. 

4 Turn off the printer and disconnect the power cord and printer cable.

Tape

Tape

Legs
D-9



Installing Option Units
5 If the duplexer is installed, remove the duplexer rear cover, power 
cord, and printer cable. 

6 Remove the sorter connection cover from the printer. Store the 
removed cover in a safe place. 

7 Install the sorter by inserting the four hooks on its attachment legs 
into the notches in the printer. 

Sorter Connection 
Cover

Hook
Hook

Hook

Notch

Notch Hook
Notch

Notch
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Installing Option Units
8 Push the sorter down. The levers of the attachment legs are in the 
lock position. 

9 Connect the sorter cable to the printer. 

When removing the sorter, unlock the attachment legs by releasing 
the levers as shown in the figure one by one, and then lift the sorter. 

Sorter Cable
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Installing Option Units
10 The sorter is equipped with two power cord sockets. The upper one is 
to be connected to a power outlet and the lower one is to be connected 
to the printer. 

11 Secure the connected sorter cable and power cord to an attachment 
leg on the sorter. 

When disconnecting the sorter cable, hold the grip on the connector as 
shown in the figure and then pull it out. 

Grip

To printer
Power Cord

To power supply
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Installing Option Units
12 If the duplexer is installed, secure the power cord to the duplexer. 

13 If the duplexer is installed, remove the two cut-out portions from the 
upper part of the duplexer rear cover removed in step 5. 

14 Reinstall the duplexer rear cover. 

Duplexer 
Rear Cover
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Installing Option Units
15 Install the five sorter trays to the sorter. 

16 Connect the power cord supplied with the printer to the sorter. 

Do not move or lift the printer with the sorter installed. 

Sorter Tray

Warning
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Installing Option Units
D.2.4 Face-up Output Tray

Use the face-up output tray when you wish paper to be stacked with the 
printed side facing up (reverse order), or when you are printing on 
envelopes, postcards, transparencies, or thick paper.

1 Install the paper stopper according to the size of paper to be used. 

2 Install the face-up output tray on the rear of the printer. 

Legal Size

A4 Size

Letter Size

Paper Stopper

Face-up Output 
Tray
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Installing Option Units
D.2.5 Network Interface Card (Models FS-1800 and FS-3800)

Insert the option network interface card into the option interface slot at the 
rear of the printer. The network interface card enables the printer to be 
used in a network. The FS-1800N/FS-3800N have network interface card 
already installed at the factory.

1 Turn off the printer and disconnect the power cord and printer cable.

2 Remove the two screws from the option interface slot cover. 

3 Insert the network interface card and secure it with the screws 
removed in step 2. 

Option Interface 
Slot Cover

Screws

Network Interface 
Card

Screws
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Installing Option Units
4 Connect the network cable. 

5 Set the network address from the printer operator panel (for details 
about the modes, see Changing Network Interface Parameters 
on page 1-45). 

Network Cable
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Installing Option Units
D.2.6 Microdrive

Insert the Microdrive into its slot on the main circuit board of the printer. If 
a Microdrive is installed in the printer, received data can be rasterized and 
stored on this Microdrive. This enables high-speed printing of multiple 
copies using an electric sort function. Also, you can use the e-MPS 
functions. For details, see e-MPS Printing on page 1-18.

For details of available Microdrives, see your dealer.

1 Turn off the printer and disconnect the power cord and printer cable.

2 Remove the two screws from the rear panel. 

3 Pull the main circuit board all the way out of the printer. 

Rear Panel

Screws

Main Circuit 
Board
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Installing Option Units
4 Install the Microdrive into its slot on the main circuit board. 

5 Return the main circuit board to the printer by reversing the 
procedure followed when removing it.

Microdrive

Microdrive Slot
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Installing Option Units
D.2.7 CompactFlash Card

Insert the CompactFlash card into the card slot located near the handle on 
the right of the printer. A CompactFlash card is a microchip card that may 
contain option fonts, macros, forms, etc. The printer reads the contents of 
the card into its internal memory when printer is turned on. The presence 
of this data in the printer memory can be confirmed on the status printout.

For details of available CompactFlash cards, see your dealer.

1 Turn off the printer.

Do not insert or remove a CompactFlash card while power is on. If the 
CompactFlash card is removed while the printer is on, damage could 
result in the printer's electronics or the CompactFlash card.

2 Insert the CompactFlash card in the slot. Insert it face up, connector 
end first. Push it in all the way. 

Note

CompactFlash 
Card
D-20



Appendix E Specifications
E

E-1



Specifications
Specifications

Item
Description

FS-1800/FS-1800N FS-3800/FS-3800N

Printing method Electrophotography, laser scan

Printing speed 16 pages/minute (A4 size) 
17 pages/minute (Letter size) 
when printing multiple copies of the 
same page

24 pages/minute (A4 size) 
25 pages/minute (Letter size)
when printing multiple copies of the 
same page

Resolution Fine 1200 mode
Fast 1200 mode with KIR [Kyocera Image Refinement]
600 dpi with KIR (Kyocera Image Refinement)
300 dpi with KIR (Kyocera Image Refinement)

First print Approx. 17.5 seconds or less (A4 or 
Letter size), depending on input data

Approx. 9 seconds or less (A4 or 
Letter size), depending on input data

Warm-up time Approx. 6.5 seconds or less 
   (from sleep mode)
Approx. 20 seconds or less 
   (from power on)
at 23 °C, 120 or 230 V

Approx. 35 seconds or less  
   (from power on/sleep mode)
at 23 °C, 120 or 230 V

Controller PowerPC 405 GF (200 MHz) RISC 
Processor

PowerPC 740 (200 MHz) RISC Processor

Main memory 8 MB, expandable up to 264 MB 16 MB, expandable up to 272 MB

Memory card slot One CompactFlash card

Self test Performed at power-up

Maximum duty cycle 65,000 pages/month 100,000 pages/month

Drum Amorphous silicon drum

Developer Mono-component dry developer

Main charger Positive scorotron charger

Transferring Negative charger roller

Separation Curvature separation

Drum cleaning Blade cleaner

Drum discharging Illumination by eraser LED array

Fuser Heat roller and pressure roller

Toner saving Ecoprint mode

Paper Plain paper (See Chapter 4)

Paper feed trays Cassette: A5 to A4/Letter universal cassette 148 to 210 mm (5-13/16 to 8-1/2") × 
216 to 297 mm (8-1/4 to 11-11/16 inches). Holds 500 sheets of thickness 
0.11 mm

MP tray: 70 to 216 mm (2-3/4 to 8-1/2") × 148 to 297 mm (8-1/2 to 11-11/16")  
(see page 4-4). Holds 100 sheets of thickness 0.11 mm

Capacity of output trays Face-down tray  250 sheets of thickness 0.11 mm
Face-up output tray (Option)  250 sheets of thickness 0.11 mm
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Specifications
Ambient conditions Temperature: 10 to 32.5 °C (50 to 90.5 °F)
Humidity: 20 to 80 % RH
Optimum conditions: 23 °C (73.4 °F), 60 % RH
Altitude: Max. 2,000 m (6500 feet)
Illumination: Max. 1,500 lux

Power requirements 120 V, 60 Hz, max. 7.2 A
(U.S.A./Canada)

220�240 V, 50 Hz/60 Hz, max. 3.6 A
(European countries)

Max. allowable voltage
fluctuation: ±10 %

Max. allowable frequency
fluctuation: ±2 %.

120 V, 60 Hz, max. 7.2 A
(U.S.A./Canada)

220�240 V, 50 Hz/60 Hz, max. 3.6 A
(European countries)

Max. allowable voltage
fluctuation: ±10 %

Max. allowable frequency
fluctuation: ±2 %.

Power consumption Max.: 961 W
During sleep mode: 14 W (FS-1800)

15 W (FS-1800N)

Max.: 972 W
During sleep mode: 14 W (FS-3800)

16 W (FS-3800N)

Operating noise (in 
accordance with ISO 7779 
[Bystander Position, sound 
pressure level at the front])

During printing: LpA = 53 dB (A)
During standby: LpA = 35 dB (A)
During sleep mode: Immeasurably 

low

During printing: LpA = 57 dB
During standby: LpA = 39 dB
During sleep mode: Immeasurably 

low

Dimensions 345 (13-9/16) wide × 300 (11-13/16) high × 390 mm (15-3/8") deep 

Weight 13 kg (28-5/8 lb), main unit only

Item
Description

FS-1800/FS-1800N FS-3800/FS-3800N
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Glossary
Cassette mode
This is an operation mode for the MP tray. When 
this mode is used, approximately 100 sheets of 
plain paper can be fed continuously, the same as 
for the cassette.

dpi (dots per inch)
This indicates the number of dots printed per 
inch, and is the unit of printer resolution.

Ecoprint
This is a printing mode that controls toner 
consumption. Pages printed in the Ecoprint mode 
are lighter than pages printed in the normal 
mode. The default setting is Off.

Emulation
This refers to emulation of manufacturers' 
printers. The printer emulates operation of the 
following printers: PCL, Line printer, IBM 
Proprinter, DIABLO 630, EPSON LQ-850, 
KPDL2.

Expansion memory
This option is used to increase printer memory. 
The printer has two expansion sockets, into both 
of which you can install a 16 MB, 32 MB, 64 MB, 
or 128 MB DIMM (Dual Inline Memory Module). 
See your Kyocera Mita dealer to purchase the 
DIMM that is best suited for use with this 
printer.

Face-up output tray
Tray installed at the rear of the printer. Select 
paper output to the face-up output tray when 
printing on postcards, envelopes, or labels.

First mode
This is an operation mode for the MP tray. 
Because the MP tray default setting is set to first 
mode (priority printing from the MP tray), if 
there is paper inserted in the MP tray, the first 
paper will always feed from there even if another 
paper source is selected. First mode is specified 
as the factory default, but you can change this 
setting from the printer's operator panel.

IEEE1284
This is a standard used when connecting a 
printer to a computer, and was established by the 
Institute of Electrical and Electronic Engineers 
in 1994.

KIR (Kyocera Image Refinement)
This is Kyocera Mita's original smoothing 
function. It uses software to enhance the 
printer's resolution and produce high-quality 
printing. The default setting is Off.

Kyocera Mita Digital Library
This is contained on the CD-ROM supplied with 
the printer. The contents of the CD-ROM include 
manuals, printer drivers, and various utilities.

Kyocera Mita PrintMonitor
This is a network management tool that can be 
used with the Kyocera Mita FS series. You can 
view information for printers connected to the 
network using SNMP commands. Kyocera Mita 
PrintMonitor is contained on the Kyocera Mita 
Digital Library CD-ROM supplied with the 
printer.

MB (mega byte)
This unit is used to express data quantities and 
memory capacities. 1 MB is equivalent to 
1024 kB, or 1,048,576 bytes.
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MP tray
This is an abbreviation for Multi-Purpose tray. 
The MP tray is used instead of the cassette when 
printing on envelopes, postcards, transparency 
sheets, and labels.

Offline
The printer can receive data, but cannot print. 
Turn the printer online if you want to print.

Online
The printer can output received data.

Operator panel
This is located on the top of the printer. The 
panel consists of the message display three 
indicators and eight keys. The message display 
shows the printer's status. Press the keys when 
you want to switch the printer between online 
and offline status, or to cancel printing.

Outline font
With outline fonts, characters outlines are 
represented by numerical expressions, and fonts 
can be enlarged, reduced, or painted in different 
ways by changing the numeric values of those 
expressions. Printing remains clear even if you 
enlarge fonts, since the letters are defined by an 
outline. You can specify font size in steps of 0.25 
points up to 999.75 points.

Parallel interface
With this interface, data transfer between the 
printer and the computer takes place on 8-bit 
chunks. The printer can perform IEEE1284 
compatible bi-directional communications.

Printer driver
The printer driver makes it possible for you to 
print data created using application software. 
The printer driver for either the printer is on the 
Kyocera Mita Digital Library CD-ROM supplied 
with the printer. Install the printer driver on the 
computer connected to the printer.

RAM disk
This is a virtual disk drive that uses part of the 
printer's memory. With RAM disk you can set 
any memory size arbitrarily, and use electronic 
sorting (to reduce print time).

Simple Network Management 
Protocol (SNMP)
This is a protocol for the management of 
networks that use TCP/IP (Transmission Control 
Protocol/Internet Protocol).

Sleep mode
This mode is activated after a specified amount 
of time elapses. The printer goes into economy 
mode and a minimum amount of power is 
consumed. You can change the amount of time 
before the printer goes into sleep mode from the 
printer's operator panel. The default setting is 15 
minutes.

Status page
This lists printer conditions, such as the printer's 
memory, the total number of copies printed, and 
paper source settings.  
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Preface
This guide contains information on how to install, configure, and use the 
printer drivers for the Kyocera Mita FS-1800-series and 3800-series 
printers. The printer drivers and other utility software are supplied on the 
Kyocera Mita Digital Library CD-ROM, other additional CD-ROM, and 
from the Internet. The driver CD-ROM's is included with the printer.

The CD-ROM's supports different printer drivers for the following 
operating systems:

• Microsoft Windows 3.x

• Microsoft Windows 95 and Windows 98

• Microsoft Windows NT 4.0

• Apple Macintosh OS 7 or greater

• IBM OS/2 Version 2.0 or greater

The manual focuses on using the printer driver on Windows95 and 
Windows98.

The latest Kyocera Mita printer drivers and utilities are readily available 
at the following web site:

http://www.kyocera.com/w2k.
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Chapter 1 Installing the Printer Driver

Kyocera Mita Digital Library CD-ROM will automatically starts to play its 
installation menu which guides you through the installation of the printer 
driver.

To make CD-ROMs play automatically when inserted in the CD-ROM 
drive, the Auto insert notification for the CD-ROM drive must be 
activated. This feature is activated by default for all Windows platforms. 
For details, refer to Windows Help.

To install, proceed as follows:

1 Insert Kyocera Mita Digital Library CD-ROM in your CD-ROM 
drive. After a while, the Kyocera Mita Digital Library splash screen 
appears.

2 Click Install Drivers. The Kyocera Mita Setup Wizard window 
begins.

3 Click Next.

4 In the Select a device model window, click FS-3800.

5 Click Next.

6 In the select a driver language window, click on the desired 
language.

7 Click Next.

8 In the Select a driver type window, click the appropriate driver type.

Note
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Kyocera Mita FS-3800 driver is the Microsoft's universal printer 
driver. The available printer features may be restricted. To take the 
full advantage of the printer features including e-MPS, use the XL 
printer driver. This driver provides compatibility with the latest level 
of the HP's command language, PCL6, including the support for the 
1200 dpi printing solution. To use the printer in PostScript 
compatible mode, use the KPDL (Kyocera Printer Description 
Language) printer driver.

9 Click Next.

10 Select the connection between Local and Network.

11 Click Next.

12 Continue to follow the rest of the wizard and complete the 
installation.
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Chapter 2 Setting the Defaults

This section explains how to set defaults on option units installed on the 
printer. Setting made in this way will become effective for all application 
software. To temporarily change the settings, make printer settings from 
the application. See Chapter 3, Printing through Application 
Software.

2.1 Adding Optional Devices (Setup)

The Setup tab enables you to setup optional devices such as paper feeders 
so that the printer can recognize them. Each printer has a unique set of 
options that are listed in the Available Options window. If you have 
attached one or more printer options, highlight that option and click the 
Add button one after another.

2.1.1 Installing the Paper Feeder (PF-60)

Check that the option paper feeder (PF-60) is installed on the printer 
correctly.

1 Browse through Windows Start > Settings > Printers.

2 Right click on the Kyocera Mita FS-1800 or Kyocera Mita FS-3800 
icon and then click Properties. 

The Properties dialog box is displayed.

3 Click the Setup tab. 

Paper Feeder
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4 Click Paper Feeder in the Available Options list box and then the 
Add button. Paper Feeder appears in the Installed Options list box. 
If two or more paper feeders are installed, an equal number of Paper 
Feeder indications should be displayed in the Installed Options list 
box. 

5 Click the OK button.

2.1.2 Installing the Duplexer (DU-60)

Check that the option duplexer (DU-60) is installed on the printer correctly.

1 Browse through Windows Start > Settings > Printers.

2 Right click on the Kyocera Mita FS-1800 or Kyocera Mita FS-3800 
icon and then click Properties. 

The Properties dialog box is displayed.

Duplexer
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3 Click the Setup tab. 

4 Click Duplex Unit in the Available Options list box and then the Add 
button. Duplex Unit appears in the Installed Options list box. 

5 Click the OK button.
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2.1.3 Installing the Sorter (SO-60)

Check that the option sorter (SO-60) is installed on the printer correctly.

1 Browse through Windows Start > Settings > Printers.

2 Right click on the Kyocera Mita FS-1800 or Kyocera Mita FS-3800 
icon and then click Properties. 

The Properties dialog box is displayed.

3 Click the Setup tab. 

4 Click Mailbox Sorter in the Available Options list box and then the 
Add button. Mailbox Sorter appears in the Installed Options list box. 

5 Click the OK button.

Sorter
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2.1.4 Installing the Microdrive

For details of available Microdrives, see your dealer. Check that the option 
Microdrive is installed in the printer correctly.

1 Browse through Windows Start > Settings > Printers.

2 Right click on the Kyocera Mita FS-1800 or Kyocera Mita FS-3800 
icon and then click Properties. 

The Properties dialog box is displayed.

3 Click the Setup tab. 

4 Click Option Hard Disk in the Available Options list box and then 
the Add button. Optional Hard Disk appears in the Installed Options 
list box. 

5 Click the OK button.
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Chapter 3 Printing through Application Software

This section uses a document created using Microsoft Word as an example 
of how to print from applications.

3.1 Setting the Paper Size

If there is paper on the MP tray, the printer always prints from the MP tray 
first. To print on the paper in the other paper sources, you must remove 
paper from the MP tray. 

Or, you can switch the MP tray to normal cassette mode by performing 
the following steps in MP Tray Mode on page 1-88 in the User's Manual.

1 Set paper of the size specified for the document in the application 
into the printer's paper cassette. (For details on how to set paper 
sizes, refer to the Installation Manual.)

Be sure that the document is correctly formatted with the paper size 
you intended to use. To do this, from the Word task bar, select File, 
Page Setup, Paper Size and check the paper size.

2 Browse File > Print. The Print dialog box will be displayed. 

3 Click on the Name pull-down list, all the printers installed under 
Windows are listed. Click the name of the printer you want to use.

4 Select the range of the pages you want to print in the document, All 
or Current page only in Page range. To print part of the document, 
enter page numbers separated by commas.

5 Specify the number of pages you want to print in the Number of 
copies combo box in Copies. 

Note

4

3

5
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6 Click the Properties button in the Print dialog box. The Properties 
dialog box is displayed.

7 Click the paper size icon in the Paper Size list box so that it is 
greyed, then click the OK button. A5 was selected for the following 
example.

When printing using non-standard size paper, see 3.1.1 Custom 
Size Settings on page 3-4.
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8 Once you finish making paper size settings, the Print dialog box is 
displayed again. Click the OK button to start printing.

 Settings made from applications are not saved when the application is 
closed. The default settings are restored when the application is opened 
the next time. To change the printer driver default settings, make printer 
settings from Windows.

Feeding from the MP tray

First mode (priority printing) is set in the MP tray default settings.

The MP tray default setting can be changed using the operator panel. 
Change it from first mode to cassette mode. See MP Tray Mode on page 
1-88 in the User's Manual.

Note
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3.1.1 Custom Size Settings

The printer can feed non-standard paper sizes. The paper cassette can 
accommodate sizes ranging from 148 to 216 mm in width and 216 to 297 
mm in length. The MP tray can accommodate sizes ranging from 80 to 216 
mm in width and 148 to 297 mm in length. The procedure for setting 
custom sizes from the printer driver is explained below.

1 Display the printer driver's Properties dialog box from the 
application software, then click Custom icon from the Paper Size list 
box so that it becomes greyed.

2 Click the Custom Size button to display the Custom Paper Size 
dialog box.

Paper Size list box

Custom icon

Custom Paper Size dialog box

Custom Size button
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3 Enter a name for your custom size and click the Add button.

4 Select the unit of measurement, Inches or Millimeters.

5 Enter the height and width of the custom size in Size.

6 Click the OK button. The Print dialog box is displayed again. Click 
the OK button to start printing.

3.2 Using the Duplexer (DU-60)

1 Browse File > Print. The Print dialog box will be displayed. 

2 Click on the Name pull-down list, all the printers installed under 
Windows are listed. Click the name of the printer you want to use.

3 Select the range of the pages you want to print in the document, All 
or Current page only in Page range. To print part of the document, 
enter page numbers separated by commas.

4 Specify the number of pages you want to print in the Number of 
copies combo box in Copies. 

5 Click the Properties button in the Print dialog box. The Properties 
dialog box is displayed. 

6 Click the Output tab.

Paper size

Units

Add button

Name settings

3

2

4
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7 In Duplex Mode, check the Long Edge Binding or Short Edge 
Binding radio button. Check None if you want to change to simplex 
printing. The graphic icon will change to illustrate your selection. 

8 Click the OK button.

To change the default setting to duplex printing, make this setting 
from Windows.

9 The Print dialog box is displayed again. Click the OK button to start 
printing.

Portrait, 
long-edge 
Binding

Landscape, 
long-edge 
Binding

Portrait, 
short-edge 
Binding

Landscape, 
short-edge 
Binding

7
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3.3 Using the Sorter (SO-60)

1 Browse File > Print. The Print dialog box will be displayed. 

2 Click on the Name pull-down list, all the printers installed under 
Windows are listed. Click the name of the printer you want to use.

3 Select the range of the pages you want to print in the document, All 
or Current page only in Page range. To print part of the document, 
enter page numbers separated by commas.

4 Specify the number of pages you want to print in the Number of 
copies combo box in Copies. 

5 Click the Properties button in the Print dialog box. The Properties 
dialog box is displayed. 

6 Click the Output tab.

7 Select the desired mode from the Output Bin pull-down menu, and 
click the OK button. To understand sorter modes, see page 3-8.

3

2

4

7
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Sorter modes 

8 Click the OK button in the Properties dialog box. The Print dialog 
box is displayed again. Click the OK button to start printing.

Sorter Mode Description

Sort mode The sort mode delivers the output pages by copy as 
shown in the example. This mode is useful when you 
need several independent copies of a document.

The maximum number of copies is 5. If a tray becomes 
full (approximately 200 pages), the printer pauses and 
indicates the Option tray # paper full 
message. Then, you will need to remove all the printed 
pages from the tray indicated by # in the message.

In the example, three copies of a document of 200 pages 
long are made, and each copy is stacked in trays 1, 2, 
and 3, respectively.

Group mode The group (collator) mode delivers the output pages by 
page as shown in the example. When multiple copies of 
a file are printed, all copies of a single page are 
delivered together to a single tray.

The maximum number of copies is 200. If a tray 
becomes full (200 pages), the printer pauses and 
indicates the Option tray # paper full 
message. Then, you will need to remove all the printed 
pages from the tray indicated by # in the message.

In the example, we make 200-copy stacks of each page 
of an 4-page long document.

Mail Box mode 1 to 5 The mail box mode simply stacks the printed pages into 
the sorter tray you desire without sorting the pages. 
When the sorter tray becomes full, the printer indicates 
the Option tray # paper full message and pauses 
until you remove all the pages in the sorter tray 
indicated by # in the message.

In the example, sorter tray 5 is specified to receive the 
printed pages.

Tray 1

Tray 2

Tray 3

Tray 4

Tray 5

Tray 1

Tray 2

Tray 3

Tray 4

Tray 5

200 Copies 
of page 1

200 Copies 
of page 4

Tray 1

Tray 2

Tray 3

Tray 4

Tray 5
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3.4 e-MPS

Job Retention

This function allows you to save print jobs to the option Microdrive and 
print them out as desired at the operator panel.

When printing, select a Job Retention mode at the printer driver. The 
following four modes are available:

• Quick Copy Printing ............................  See page 3-11

• Proof and Hold Printing ......................  See page 3-13

• Private Printing ...................................  See page 3-15

• Stored Job Printing (Job Storage) ......  See page 3-17

For how to make the settings, see the pages of the respective modes.

Four Job Retention modes have the following benefits:

• Quick Copy: When you need another copy of a finished print job, you 
can print it out at the printer operator panel. There is no need to print 
from the computer again.

• Proof and Hold: When printing multiple copies, this mode first prints 
only one copy for proofing, allowing you to decide whether to continue 
printing the remaining copies or cancel printing at the operator panel. 
In this way, you can reduce the waste of paper. 

• Private Print: Confidential print jobs can be printed out when you are 
at the printer. This mode saves print jobs in the printer without 
printing until you instruct the printer to do so at the operator panel. 
Printing using this mode requires the 4-digit PIN number you set using 
the printer driver.

• Stored Job (Job Storage): This mode allows you to store print jobs 
that are frequently needed, such as fax cover pages, checklists, and 
order forms, for printing later. Using the operator panel, you can then 
print them out as required at anytime and at any number of copies.
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Virtual Mail Box

Virtual mailbox is the ability to store print jobs in the virtual mailboxes on 
the Microdrive, enabling you to retrieve and print it later from the printer's 
operator panel or the option barcode reader (BC-1).

You can later print out only the jobs you desire using the operator panel on 
the printer.

When printing, make the settings at the printer driver. For how to make 
the settings, see 3.4.2 Virtual Mail Box Printing on page 3-20.

You can send a print job either to all the virtual mail box trays at the same 
time or to the desired trays only.

Since you perform printing by selecting the desired trays using the 
operator panel, you can print out only the jobs you desire. 

Job Storage

Job Storage reduces the time to print multiple copies and enables the use 
of option barcode reader to print jobs stored on the Microdrive.

When printing, select a type of code job at the printer driver. The following 
two types of code jobs are available:

• Permanent Code Job

• Temporary Code Job

For how to make the settings, see 3.4.3 Printing with Job Storage on 
page 3-23.

You can print out frequently needed print jobs, such as fax cover pages, 
checklists, and order forms, using the option barcode reader.

If you store a print job and print it out with a barcode ID attached, you can 
print that job any time later by simply reading the barcode ID. You can 
print a list of code jobs at the operator panel. There are two types of code 
jobs: permanent code job and temporary code job. When the storage 
memory becomes insufficient, temporary code jobs will be automatically 
deleted in order from the oldest and permanent code jobs will not.
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3.4.1 Using Job Retention

Quick Copy
This allows you to print as many additional copies as you want until the 
printer is turned off, it is useful in cases such as when there are sudden 
increases in the required number of copies during a meeting.

To print, proceed as follows.

1 Browse through Windows File > Print. The Print dialog box will 
displayed.

2 Click on the Name pull-down list, all the printers installed under 
Windows are listed. Click the name of the printer you want to use.

3 Select the range of the pages you want to print in the document, All 
or Current page only in Page range. To print part of the document, 
enter page numbers separated by commas.

4 Specify the number of pages you want to print in the Number of 
copies combo box in Copies.

3

2

4
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5 Click the Properties button. The Properties dialog box is displayed. 
Click the Options tab and then checkmark the Job Retention check 
box.

6 Click the Job tab. Click the Quick Copy radio button. Then 
checkmark the Custom Job Name and User Name check boxes 
below. Enter the desired names for Custom Job Name and User 
Name. The names entered here will appear on the printer operator 
panel when printing additional copies using the operator panel. 

If nothing is entered, NO JOB NAME and NO USER NAME will appear 
for Custom Job Name and User Name respectively.

7 Click the OK button. The Print dialog box is displayed again. Click 
the OK button to start printing. The print job will be saved to the 
Microdrive as it is printed.

If additional copies are required, print using the Quick Copy menu 
in the e-MPS menu at the printer operator panel. For details, see 
page 1-21 in the User's Manual.
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Proof and Hold Printing
You can check the first copy before printing the remaining copies, paper 
wastage can be avoided. The print jobs will be deleted when the printer is 
turned off.

To print, proceed as follows.

1 Browse through Windows File > Print. The Print dialog box will 
displayed.

2 Click on the Name pull-down list, all the printers installed under 
Windows are listed. Click the name of the printer you want to use.

3 Select the range of the pages you want to print in the document, All 
or Current page only in Page range. To print part of the document, 
enter page numbers separated by commas.

4 Specify the number of pages you want to print in the Number of 
copies combo box in Copies.

3

2

4
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5 Click the Properties button. The Properties dialog box is displayed. 
Click the Options tab and then checkmark the Job Retention check 
box.

6 Click the Job tab. Click the Proof and Hold radio button. Then 
checkmark the Custom Job Name and User Name check boxes 
below. Enter the desired names for Custom Job Name and User 
Name. The names entered here will appear on the printer operator 
panel when printing using the operator panel. 

If nothing is entered, NO JOB NAME and NO USER NAME will appear 
for Custom Job Name and User Name respectively.

7 Click the OK button. The Print dialog box is displayed again. Click 
the OK button to start printing. The print job will be stored to the 
Microdrive as it is printed.

The printer will first print only one copy if you set to print multiple 
number of copies, allowing you to check the printouts. If there is no 
problem, resume printing the remaining copies using the Quick 
Copy menu in the e-MPS menu at the printer operator panel. For 
details, see page 1-21 in the User's Manual.
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Private Printing
You need to enter a password at retrieving the job, confidentiality is 
assured even if you share the printer with others. Print jobs will be deleted 
when they are printed or when the printer is turned off.

To print, proceed as follows.

1 Browse through Windows File > Print. The Print dialog box will 
displayed.

2 Click on the Name pull-down list, all the printers installed under 
Windows are listed. Click the name of the printer you want to use.

3 Select the range of the pages you want to print in the document, All 
or Current page only in Page range. To print part of the document, 
enter page numbers separated by commas.

4 Specify the number of pages you want to print in the Number of 
copies combo box in Copies.

3

2

4
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5 Click the Properties button. The Properties dialog box is displayed. 
Click the Options tab and then checkmark the Job Retention check 
box.

6 Click the Job tab. Click the Private Print radio button and then 
checkmark the Custom Job Name and User Name check boxes 
below. Enter the desired names for Custom Job Name and User 
Name. The names entered here will appear on the printer operator 
panel when printing using the operator panel. 

If nothing is entered, NO JOB NAME and NO USER NAME will appear 
for Custom Job Name and User Name respectively. 

6

7
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7 Set the desired 4-digit number for PIN using any numbers between 0 
and 9. This number is synonymous to user ID which is required to 
enter at the printer operator panel when retrieving.

8 Click the OK button. The Print dialog box is displayed again. Click 
the OK button. The print job will be stored to the Microdrive without 
printing.

To print, use the Private/Stored menu in the e-MPS menu at the 
printer operator panel. For details, see page 1-25 in the User's 
Manual.

Stored Job Printing (Job Storage)
Select this if you want to store frequently needed print jobs, such as forms, 
to print them later as required. The print jobs will not be deleted when the 
printer is turned off.

To print, proceed as follows.

1 Browse through Windows File > Print. The Print dialog box will 
displayed.

2 Click on the Name pull-down list, all the printers installed under 
Windows are listed. Click the name of the printer you want to use.

3

2

4
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3 Select the range of the pages you want to print in the document, All 
or Current page only in Page range. To print part of the document, 
enter page numbers separated by commas.

4 Specify the number of pages you want to print in the Number of 
copies combo box in Copies.

5 Click the Properties button. The Properties dialog box is displayed. 
Click the Options tab and then checkmark the Job Retention check 
box.

6 Click the Job tab. Click the Job Storage radio button. Then 
checkmark the Custom Job Name and User Name check boxes 
below. Enter the desired names for Custom Job Name and User 
Name. The names entered here will appear on the printer operator 
panel when printing using the operator panel. 

If nothing is entered, NO JOB NAME and NO USER NAME will appear 
for Custom Job Name and User Name respectively.

6

7
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7 You can add security to the print job. To do so, checkmark the 
Required PIN to Print check box and enter the desired 4-digit 
number for PIN using any numbers between 0 and 9. You must enter 
this number at the printer operator panel when printing.

8 Click the OK button. The Print dialog box is displayed again. Click 
the OK button. The print job will be stored to the Microdrive without 
printing.

To print, use the Private/Stored menu in the e-MPS menu at the 
printer operator panel. For details, see page 1-25 in the User's 
Manual.
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3.4.2 Virtual Mail Box Printing

Virtual mailbox is the ability to store print jobs in the virtual mailboxes on 
the Microdrive, enabling you to retrieve and print it later from the printer's 
operator panel or the option barcode reader (BC-1). A maximum of 255 
virtual mail boxes can be set up, making it possible to allocate documents 
not just for individual departments or groups, but even for individual 
people. The print jobs will not be deleted when the printer is turned off.

To print, proceed as follows.

1 Browse through Windows File > Print. The Print dialog box will 
displayed.

2 Click on the Name pull-down list, all the printers installed under 
Windows are listed. Click the name of the printer you want to use.

3 Select the range of the pages you want to print in the document, All 
or Current page only in Page range. To print part of the document, 
enter page numbers separated by commas.

4 Specify the number of pages you want to print in the Number of 
copies combo box in Copies.

3

2

4
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5 Click the Properties button in the Print dialog box. The Properties 
dialog box is displayed. Click the Options tab and check that the Job 
Retention check box is not checkmarked.

6 Click the Job tab and then the Virtual Mail Box radio button. 
Checkmark the Job Date, Custom Job Name, and User Name check 
boxes on the right and enter the desired names for Custom Job 
Name and User Name.
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7 Give a name to your virtual mail box tray and click the Add button. 
The name of your virtual mail box tray will be entered in Mailbox 
Name List.

8 Specify the desired virtual mail box tray in Mailbox Bin Number or 
Range. Multiple virtual mail box tray numbers can be specified at a 
time using commas (,) and hyphens (-). In the following example, the 
print job will be sent to tray numbers 1, 10 to 20, 25, and 30.

9 Press the OK button. The Print dialog box appears. Click the OK 
button. The print job will be stored to the Microdrive without 
printing.

To print, use the Print VMB Data menu in the e-MPS menu at the 
printer operator panel and specify the virtual mail box numbers. You 
can also print the list of virtual mail box trays. For details, see page 
1-29 in the User's Manual.
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3.4.3 Printing with Job Storage

Using Job Storage, you can print multiple copies by sending the data for 
just one copy (electronic sorting), or print jobs stored on the Microdrive at 
any time as required using the option barcode reader.

Electronic Sorting
The electronic sorting function allows you to print multiple copies of a 
document while only requiring the data to be transferred to the printer 
once. This approach reduces the amount of time that it takes to print 
multiple copies. With a conventional page printer, the printer must repeat 
the rasterization process for each copy of a document, each time that it 
receives data from the host computer.

For example, when printing five copies of a five-page document, a 
conventional page printer has to complete the rasterization process for 
5 × 5 = 25 pages.

With the electronic sorting function, the host computer only sends the 
document data once, together with a copy count instruction (e.g. the five-
page document shown below).

The printer then stores the rasterized data on Microdrive and then uses 
this rasterized data to print the remaining four copies. As a result, the 
remaining four copies (20 pages in total in the example shown below) can 
be printed much more quickly.

Data generation Data transfer Data processing Printing

Data generation Data transfer Data processing PrintingMPS Electronic

sorting

Conventional

page printer

5 x 5 = 25 pages

generated

25 pages processed25 pages transferred

5 pages generated 5 pages processed Printed more quickly!5 pages transferred

Stored to printer's internal hard disk; the

stored data is used to print the second and

subsequent copies.
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Barcode Printing
A unique number and barcode is automatically assigned to each job as it is 
stored on the printer. The number appears when jobs are listed in utilities 
such as Printer Disk Manager or Kyocera Mita PrintMonitor. The number is 
also printed, together with its barcode, on the Job List. The Job List can be 
printed using the list of Code Job menu of the printer. Barcode 
printing jobs will be displayed as code jobs on the printer operator panel.

The barcode and number can also be printed on the original document that 
is printed when the job is stored on the Microdrive. This barcode can be 
printed on the first page as a code for the whole document, or on every 
page, so that each individual page of the document can be accessed with 
the barcode reader.

To print, proceed as follows.

1 Browse through Windows File > Print. The Print dialog box will 
displayed.

2 Click on the Name pull-down list, all the printers installed under 
Windows are listed. Click the name of the printer you want to use.

3 Select the range of the pages you want to print in the document, All 
or Current page only in Page range. To print part of the document, 
enter page numbers separated by commas.

3

2

4
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4 Specify the number of pages you want to print in the Number of 
copies combo box in Copies.

5 Click the Properties button. The Properties dialog box is displayed. 
Click the Options tab and check that the Job Retention check box is 
not checkmarked.

6 Click the Job tab and then the Temporary or Permanent radio 
button in Job Storage. When only making settings for the electronic 
sorting, proceed to step 9.

7 When using the option barcode reader, checkmark the Job Date, 
Custom Job Name, and User Name check boxes on the right and 
enter the desired names for Custom Job Name and User Name.

8

7
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8 Set whether or not to print the barcode on the printouts. The barcode 
can also be printed in various positions on the page, with or without 
its code number as shown here by selecting its position in the printer 
driver.

9 Click the OK button. The Print dialog box is displayed again. Click 
the OK button to start printing. The print job will be stored to the 
Microdrive as it is printed.

The option barcode reader can be used to reprint the document by 
reading the barcode from the Job List or from the original document.

1 2 3 4

5 6 7 8

Barcode Positions



2002.2EC


	Contents
	Introduction
	Features
	For More Information...
	Guide to the User's Manual

	Chapter 1 Using the Operator Panel
	1.1 Understanding the Operator Panel
	1.2 Using the Operator Panel
	1.2.1 Menu Selection System
	1.2.2 Using the Menu Selection System
	Printing the Menu Map
	Printing Status Page
	e-MPS Printing
	e-MPS Configuration
	Changing the Interface Parameters
	Changing the Emulation
	Setting the Default Font
	Using Page Set Menus
	Setting the Print Quality
	Operating a CompactFlash (Memory) Card 
	Operating the Microdrive (Hard Disk)
	Setting the RAM Disk
	Paper Handling
	Verifying the Total Printed Pages and Resetting the Toner Counter
	Other Modes



	Chapter 2 Maintenance
	2.1 Toner Container Replacement
	2.1.1 Toner Container Replacement Interval
	2.1.2 Replenishing Toner

	2.2 Waste Toner Bottle Replacement
	2.2.1 Replacing the Waste Toner Bottle

	2.3 Cleaning
	2.3.1 Cleaning the Charger Wire
	2.3.2 Cleaning the Charger Grid
	2.3.3 Paper Feed Unit


	Chapter 3 Troubleshooting
	3.1 General Guide
	3.2 Print Quality Problems
	3.3 Indicators and Messages
	3.3.1 Indicators
	3.3.2 Maintenance Messages
	3.3.3 Error Messages

	3.4 Correcting a Paper Jam
	3.4.1 Jam at the Paper Cassette or Inside the Printer
	3.4.2 Paper Jam at the Option Duplexer
	3.4.3 Paper Jam at the Option Sorter
	3.4.4 Jam at the MP Tray


	Chapter 4 Paper Selection
	4.1 General Guidelines
	4.1.1 Paper Availability
	4.1.2 Paper Specifications
	4.1.3 Selecting the Right Paper

	4.2 Special Paper
	4.2.1 Transparency (Overhead Projection Film)
	4.2.2 Adhesive-Backed Labels

	4.3 Paper Type

	Appendix A Fonts
	Appendix B Expansion Memory
	B.1 Expanding the Printer Memory

	Appendix C Host Computer Interface
	C.1 Parallel Interface
	C.1.1 Parallel Interface Communication Modes
	C.1.2 Interface Signals

	C.2 Serial Interface
	C.2.1 Interface Signals

	C.3 RS-232C Protocol
	C.4 RS-232C Cable Connection
	C.4.1 Preparing an RS-232C Cable
	C.4.2 Connecting the RS-232C Cable
	C.4.3 Setting the RS-232C Parameters


	Appendix D Option Units
	D.1 Available Options
	D.2 Installing Option Units
	D.2.1 PF-60 Paper Feeder
	D.2.2 DU-60 Duplexer
	D.2.3 SO-60 Sorter
	D.2.4 Face-up Output Tray
	D.2.5 Network Interface Card (Models FS-1800 and FS-3800)
	D.2.6 Microdrive
	D.2.7 CompactFlash Card


	Appendix E Specifications
	Glossary
	Index
	Contents
	Chapter 1 Installing the Printer Driver
	Chapter 2 Setting the Defaults
	2.1 Adding Optional Devices (Setup)
	2.1.1 Installing the Paper Feeder (PF-60)
	2.1.2 Installing the Duplexer (DU-60)
	2.1.3 Installing the Sorter (SO-60)
	2.1.4 Installing the Microdrive


	Chapter 3 Printing through Application Software
	3.1 Setting the Paper Size
	3.1.1 Custom Size Settings

	3.2 Using the Duplexer (DU-60)
	3.3 Using the Sorter (SO-60)
	3.4 e-MPS
	3.4.1 Using Job Retention
	Quick Copy
	Proof and Hold Printing
	Private Printing
	Stored Job Printing (Job Storage)

	3.4.2 Virtual Mail Box Printing
	3.4.3 Printing with Job Storage
	Electronic Sorting
	Barcode Printing




